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Introduction About This Guide

| ntroduction

Welcome  Welcometo IBM® Sterling Gentran:Server® for Microsoft Windows Forms Integration
subsystem, IBM’s Electronic Data Interchange (EDI) form-generation software for the
Microsoft Windows operating system. Sterling Gentran: Server provides you with thetools
that you need to design forms to facilitate the keying and printing of EDI documents.
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About This Guide

What' s in this manual

What’sin this manual

Overview

Related Manuals

Intended audience

Prerequisite
knowledge

Thismanual contains atutorial for Sterling Gentran:Server Forms I ntegration, using the
EDIFACT 92.1 standard. Thistutorial includes a print form example (purchase order) and
a screen entry form example (invoice). The purpose of thistutorial isto break the form
creation process into concise and understandabl e steps, using examples that enable you to
understand and master the tasks and processes required to create your own forms.

Complete the print form tutorial first. After you have mastered the stepsinvolved in
creating a print form, you can begin the tutorial for the screen entry form.

To access reference information, refer to the IBM® Serling Gentran: Server® for
Microsoft Windows Forms I ntegration online Help or IBM® Qerling Gentran: Server® for
Microsoft Windows Forms Integration User Guide. For additional information on the
various tasks described in this manual, refer to IBM® Serling Gentran: Server® for
Microsoft Windows Forms Integration User Guide.

This manual isintended for the following users.

» Technical users—users with a detailed knowledge of the Microsoft Windows
operating system, networking, databases, and communications.

» Novice-to-average experienced users—users who are new to Sterling Gentran: Server,
EDI, or both.

» EDI Coordinators—usersresponsiblefor creating and maintaining the transfer of EDI
data between Trading Partners.

The audience using this software should be familiar with:
» PCand Microsoft Windows functions

» EDI concepts

» EDI standard structure

» theinternal application format

» datamapping concepts

» Sterling Gentran:Server product

Forms Integration EDIFACT Tutorial Guide Sterling Gentran:Server — May 2011



Description of Contents About This Guide

Description of Contents

Overview  The Forms Integration EDIFACT Tutorial contains the tasks associated with using the
Forms Integration subsystem.

Organization of  Thetutoria guideis organized into the following chapters:

chapters » Chapter 1, Getting Started, explains the content, organization, conventions, and

system requirements. This chapter describes how to build forms and how to
customize global EDI date formats.

» Chapter 2, Creating a Print Form, explains the tasks necessary to create a print form
for an EDIFACT purchase order (ORDERS).

» Chapter 3, Creating a Screen Entry Form, explains the tasks necessary to create a
screen entry form for an EDIFACT invoice (INVOIC).

» TheGlossary contains definitions of Forms Integration and Sterling Gentran: Server
terms and concepts.

Sterling Gentran:Server — May 2011 Forms Integration EDIFACT Tutorial Guide



About This Guide Online Help

OnlineHelp

Overview  Themagjority of the IBM® Serling Gentran: Server® for Microsoft Windows Forms
Integration User Guide documentation is aso contained in the online Help system.

Forms Integration EDIFACT Tutorial Guide Sterling Gentran:Server — May 2011



Getting Support About This Guide

Getting Support

How to Get Help  IBM® Sterling Customer Center provides awealth of online resources that are available

around the clock to enrich your business experience with IBM® Sterling Gentran®. By
using Sterling Customer Center, you gain access to many self-support tools, including a
Knowledge-Base, Documentation, Education, and Case Management. Accessthis site at:
Sterling Customer Center. (http://customer.sterlingcommerce.com)

Once logged in, select Support Center from the top navigation menu, and then locate
Sterling Gentran product-specific support information from the left navigation menu.

Additionally, our Customer Support Reference Guide outlines our support hours, contact
information, and key information that will enhance your support experience with us. For
detailed information about Customer Support, please refer to the Customer Support
Reference Guide accessible from the login page. (http://customer.sterlingcommerce.com)
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CHAPTER

1

Getting Sarted

I ntroducing Forms I ntegration

Overview

What isaform?

What isaprint
transation object?

What isa screen
entry trandation
object?

The Sterling Gentran: Server Forms I ntegration subsystem enables you to design formsto
facilitate the keying (screen entry) and printing (print) of EDI documents that you receive
inbound or send outbound.

A formisaset of instructions you define in the Forms Integration subsystem that indicates
how the system should format data. When you compile the form, Sterling Gentran: Server
generates atranslation object. After you register the trandation object with Sterling
Gentran: Server and associate the translation object with a partner relationship, the system
uses the trangl ation object to format EDI documents. The Forms Integration subsystem
enables you to create print and screen entry trand ation objects.

Regardless of whether the trandation object is print or screen entry, Sterling
Gentran: Server generates the actual format of the translation object based on the EDI file
format (in the EDI File Format Pane), and displaysit in the Layout Pane.

A print translation object organizes and formats the printout of EDI documents that are
received from or sent to the trading partners for which you have established atrading
relationship (inbound or outbound) that utilizes that print translation object. The print
transl ation object enables you to view the EDI document in an easily readable format.

A screen entry trandation object provides a standardized format for keying an EDI
document into the Document Editor, for translation and transmission to your trading
partners, for which you have established an outbound trading relationship that utilizes that
screen entry translation object. The screen entry translation object ensures that your users
key all the data necessary to create the required EDI document.

Forms Integration EDIFACT Tutorial Guide Sterling Gentran:Server — May 2011



Navigation Getting Started

Navigation

Overview  The Sterling Gentran: Server Forms I ntegration Window allows you to access its
functionality in four different ways, as follows:

» Click the menu option from the Main Menu Bar.
» Click the appropriate button on the Main Tool bar.
» Click or double-click the appropriate part of the form.

» Click aform component (EDI File Format Pane or Layout Pane) with the right mouse
button to access a shortcut menu that contains all the functions that are currently
available for that form component. The shortcut menus enable you to quickly and
easily access available functionality. The content of the shortcut menus vary,
depending on the type and level of the selected form component.

Formslintegration  Thisdiagram illustrates the Forms Integration Window.
Window

Z Gentran Forms Integration - [pet_810s._stp]
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Getting Started Navigation

Forms|ntegration This table describes the parts of the Sterling Gentran: Server Forms I ntegration Window.
Window partsand
functions Part Function

Main Menu Bar The Main Menu Bar contains the menus.

Note
Detailed descriptions of each of the commands on these
menus are found in the online Help.

Main Toolbar The Main Toolbar gives you access to some of the
most common operations in Sterling Gentran: Server.

EDI File Format Pane The EDI File Format Pane contains the EDI file
format. When you click a segment or group in the EDI
file format, the corresponding frame is displayed in the
Layout Pane. When you click an element in the EDI
file format, the corresponding layout component is
highlighted in the Layout Pane.

Layout Pane The Layout Pane contains the actua format of the
trang ation object. Each group (with a maximum usage
greater than one) and repeating segment has a
corresponding frame in the Layout Pane. When you
click asegment or group in the EDI file format, the
corresponding frame is displayed in the Layout Pane.
When you click an element in the EDI file format, the
corresponding layout component is highlighted in the
Layout Pane.

Main Toolbar The Main Toolbar gives you access to some of the most common operationsin Sterling
Gentran:Server. Unavailable items are dimmed. The Main Toolbar is a dockable toolbar,
so you can affix it to any edge of the client window. This diagram illustrates Main Toolbar.

Tree Only
New Cut Constants Split Add Text Change
‘ Sa‘ve Pa|ste Code Lists ‘ Deactivate Un‘do ViTw
I 2= = T I e =Y =l s D | [ =2

Open Copy Syntax Activate Lock Labels Layout
) ~ Tokens Only
Compile Session Promote Generate Redo
Rules Layout
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EDI File Format Pane Getting Started

EDI File Format Pane

Overview  TheEDI File Format Pane (left side of the Forms Integration subsystem main window)
contains the EDI file format. The EDI file must contain all the information that you need
to includeto either create a document using the Document Editor (screen entry translation
object) or print documents (print translation object), so that your system can accurately
process the data.

Generating EDI Sterling Gentran: Server generates an EDI file for you, based on the standard (agency),
files  version, transaction set, and release (for the TRADACOM S standard only) you selected.
The system includes all the groups, segments, composites, and elements that are defined
by the standards agency for the version of the document you selected.

You typically need to customize the system-generated EDI file by modifying the
properties of the form components, and using specialized Sterling Gentran: Server
functions to manipulate the EDI file structure.

Reference

See Defining the Type of Form on page 2 - 21 (print) or Defining the Type of Formon
page 3 - 20 (screen entry) for moreinformation on generating an EDI file when you create
anew form.

Generating If you want to use a speciaized version an EDI standard that is not available in the IBM®
specialized EDI Sterling Gentran Standards Database for EDI, it may be appropriate for you to define the

standard versions  EDI file yourself.

Regardless of whether the system generates the EDI file or you defineit, the specific EDI
form components that you use depend on the type of form you are creating. Thisincludes
the standard, version, and transaction set (document) selected, and which groups,
segments, composites, and elements your company requires.

Recommendation
We recommend that you determine which form components you are using before
generating or defining an EDI file.
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Getting Started EDI File Format Pane

Form components  Thistable describes form components that Sterling Gentran:Server uses to define the EDI
file format.

Icon Description

J A group isalooping structure that contains related segments and/or
groups that repeat in sequence until either the group data ends or the
maximum number of times that the loop is allowed to repeat is
exhausted. Groups are defined by the EDI standards. A group that is
subordinate to another group is a sub-group (this correspondsto a
nested looping structure—aloop within aloop). The EDI fileisagroup
and therefore, it is visually represented the same way as other groups
and sub-groups in Sterling Gentran: Server.

A segment contains a group of related elements or composite data
elements that combine to communicate useful data. Segments are
defined by the EDI standards. A segment can occur once or can repeat
multiple times.

) A compositeis a data element that contains two or more component
data elements or sub-elements. Composites are defined by the EDI
standards that use them (EDIFACT, TRADACOMS, and certain ANSI
X12 standards).

- An element is the smallest piece of information defined by the EDI
standards. An individual element can have different meaning
depending on the context. Therefore, elements are normally not
considered to have useful meaning until they are combined into
segments.

When an element has an operation performed against it, ared
checkmark is displayed over the element icon.

When afield contains a standard rule a black asterisk appearsto the
right of the element icon.

Forms Integration EDIFACT Tutorial Guide Sterling Gentran:Server — May 2011



Layout Pane

L ayout Pane

Overview

List formats

Field formats

Frames

Displaying
infor mation

Getting Started

The Layout Pane (right side of the Forms Integration subsystem main window) contains
the actual format of the translation object. Sterling Gentran: Server uses frames to format
the EDI filefor the trandlation object. Each frame contains the groups, repeating segments,
and elements at that level (single segments are not represented on the frame).

For screen entry translation objects, groups (with a maximum usage greater than one) and
repeating segments are formatted as lists. Elements are formatted as edit boxes (fields) or
lists on the frame. Elements typically are formatted asfields, but are formatted asalist if
you apply astandard rule that allows a selection of multiple items. Each group and
repeating segment also has a corresponding frame that contains al the groups (with a
maximum usage greater than one), repeating segments, and elements at that level.

For print trandation objects, groups, repeating segments, and elements are always
formatted asfields.

Each group and repeating segment also has a corresponding frame that contains all the
groups (with amaximum usage greater than one), repeating segments, and elements at that
level.

When you click asegment or group in the EDI File Format Pane, the corresponding frame
isdisplayed in the Layout Pane. When you click an element in the EDI File Format Pane,
the corresponding layout component is highlighted in the Layout Pane.
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Getting Started Building a Form with Forms Integration

Building a Form with Forms I ntegration

Overview  This section defines how to proceed with building aform using the Sterling
Gentran: Server Forms Integration subsystem.

Sagesof building  Thistable describes the steps required to build a form using Forms I ntegration.
aform

Sage Description

1 Prepare and Analyze.

Obtain alayout of how you want the document displayed and determine
how it corresponds with the EDI standard you are using. Determine
which operations need to be performed to generate the required layout.

2 Set Global Defaults (first timeonly).

Thefirst time you use the Sterling Gentran: Server Forms Integration
subsystem, you should establish the default date format that the system
will use.

Reference

See Design and Create the Form on page 2 - 20 (print) or Design and
Create the Form on page 3 - 19 (screen entry) for more information about
setting the global date default.

3 Create, Save, and Name a New Form.

Reference

See Design and Create the Form on page 2 - 20 (print) or Design and
Create the Formon page 3 - 19 (screen entry) for moreinformation about
creating, saving, and naming aform.

4 Activatethe Appropriate EDI Groups, Segments, and Elements.

Reference

See Activating Groups, Segments, Composites, and Elements on
page 2 - 25 (print) or Activating Groups, Segments, Composites, and
Elements on page 3 - 24 (screen entry) for more information.

5 Promote, Split, and Change Segments and Groups.

Reference

See Modify Form Components on page 2 - 32 (print) or Modify Form
Components on page 3 - 30 (screen entry) for more information about
promoting, splitting, and changing segments and groups.
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Building a Form with Forms Integration Getting Started

(Contd)
Sage Description

6 Customizethe EDI Data.

Reference
See Customize the EDI Data on page 2 - 47 (print) or Customize the EDI
Data on page 3 - 47 (screen entry) for more information.

7 Definethe Layout of the Form.

Reference

See Format the Print Form on page 2 - 98 or Format the Screen Entry
Form on page 3 - 138 for more information about customizing your EDI
file, including verifying the EDI delimiters.

8 Compilethe Form.

Reference

See Compiling the Form on page 2 - 124 (print) or Compiling the Form
on page 3 - 165 (screen entry) for more information on compiling the
tranglation object and translation object naming conventions.

9 Print the Report.
Validate and review the form, and make modifications as needed.

Reference
See Printing the Report on page 2 - 126 (print) or Printing the Report on
page 3 - 168 (screen entry) for more information.

10 Test the Trandlation Object.

For a screen entry translation object, create anew document in Document
Editor, using that translation object. For a print translation object, print a
document. Verify that the output is correct.

Reference
See Testing the Trandlation Object on page 2 - 127 (print) or Testing the
Translation Object on page 3 - 169 (screen entry) for more information.
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Getting Started How to Launch Forms Integration

How to Launch Forms I ntegration

Overview  This section describes how to launch the Forms Integration subsystem by means of
Sterling Gentran:Server.

Procedure  Usethis procedure to launch the Forms I ntegration subsystem.

Sep Action
1 Select Programs from the Microsoft Windows Start menu.
2 Select Gentran Server Forms I ntegration from the Gentran Server
Programs group.

System Response
The system displays the Forms Integration subsystem.

Forms Integration EDIFACT Tutorial Guide Sterling Gentran:Server — May 2011



How to Install Sterling Standards Database for EDI Getting Started

How to Install Sterling Sandards Database for EDI

Overview  Note
You need to install Sterling Standards Database for EDI only if you installed Integration

Components during the Sterling Gentran: Server installation.

Reference
See the appropriate Sterling Standards Database for EDI card for information about
installing the Sterling Standards Database for EDI.

Sterling Gentran:Server — May 2011 Forms Integration EDIFACT Tutorial Guide



CHAPTER

2

Creatinga Print Form

Overview

| ntroduction

Inthischapter  Thischapter includes the following topics associated with creating a print form:
» Formanalysis
» Creating, saving, and setting up anew form
» Customizing the form, including the groups, segments, and elements
» Formatting the form, including fields and field labels
» Findizing theform

Purpose of this  Thistutorial explains how to customize and format a form beforeit is compiled into a
tutorial tranglation object. The form that you create is a sour ce form. After that source formis
compiled, the result is a compiled translation object. You must register the translation
object with Sterling Gentran:Server before you can use the trandation object to print
messages of that type.

Formcriteria  Sterling Gentran:Server generates a basic form based on the following information:
» Typeof form (print or screen entry)
» Standard agency (e.g., EDIFACT)
» Standard version (e.g., 92.1)
» Messagetype (e.g., ORDERS)

Mandatory  All mandatory groups, segments, composites, and elements for the standard, version, and
components  message you specify are available for use (activated) when Sterling Gentran: Server
creates aform. Only these mandatory form components (groups, segments, composites,
and elements) are activated automatically. You must activate additional form components

Forms Integration EDIFACT Tutorial Guide Sterling Gentran:Server — May 2011



Introduction Creating a Print Form

to accommodate the data you expect to receive from your trading partner and then
customize and format the form so that it is appropriate and useful for your company’s
needs.
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Creating a Print Form Introduction

Beforeyou begin  Before you begin to customize a print form, you should be familiar with the following
elements of form design:

» EDI Standards (how EDI standards work and how the information your users need is
tranglated to and from the standards)

» Your users (theindividuals who use the print translation objects to create printouts of
processed EDI data)

» Your trading partners (the organizations that send you or that you send the EDI datato
be processed and printed).

You can create adifferent print form for each combination of message, trading partner,
and standard version. You can create an unlimited number of print forms, and the number
of print forms you create is not affected by the number of screen entry forms you create.

Recommendation

We recommend that you mock up alayout of the print form the way you ultimately want it
to look. Asyou design the layout, make sure that the form will make sense to the people
who will useit. By analyzing your company’s needs before you actualy create the print
form, you reduce the amount of time spent later on redesigning or reformatting the form.
You should include the following design considerations in your form planning:

» Which fields should be printed, and which are necessary for the EDI data but do not
need to be displayed on the printout

» Wherefields should be located on the form
» What labelsyou will use to identify the fields on the form.
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Phases of Designing a Form

Phases of Designing a Form

Design phases  Thistablelists the phases of form design.

Creating a Print Form

Phase

Description

1

Analyzethe EDI File.

Design and create the form.

Modify form components.

Customize the EDI data.

Format the print form.

Finalize the form.

Sterling Gentran:Server — May 2011
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Creating a Print Form Getting started

Getting started

Overview  Thistutorial is meant to be completed in its entirety. We strongly recommend that you
complete each task sequentially. The purpose of completing each task in this tutorial in
sequential order, asif it were your own scenario, is hot only to teach you how to perform
the individual tasks, but also to teach you alogical approach and methods that should be
used when you create your own form.

In this tutorial, you will create a new print form based on a scenario we have defined for
you. This section includes the basics of creating the form, such as defining the scenario
and analyzing the purpose of the form, creating and saving the form, and setting up the
form. You can find techniques for customizing the segments, elements, and groupsin the
form, aswell as for formatting the organization and appearance of the form, later in this
chapter.

Print form For thistutorial, you will create a print form for the ORDERS message (purchase order)
scenario using the EDIFACT 92.1 standard. The steps are broken down into manageabl e pieces so
you can apply what you learn to your print forms.

In this scenario, your company is MWT Manufacturing Co., which manufactures awide
variety of pet suppliesfor pet stores. You will create aform that formats and arranges the
EDI datayou receive from one of your trading partners, Pet Zone (alarge pet supply
retailer), to produce a purchase order printout. You do not want to ater the integrity of the
EDI data. You do want to interpret some of the codes included in the EDI message into
more meaningful text.
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Analyzethe EDI File

Basic Tasks

Introduction

To analyze the EDI file, you must determine what data your trading partner will be
sending you. You and your partner must agree on which standard, version, and message
you will be using. In thistutorial, you are using an EDIFACT version 92.1 ORDERS
purchase order. It isimportant to know what type of information that your partner will
send you in the purchase order, and what type of datawill be contained in each element
used.

It isvery helpful to review the EDI standard that you will use before analyzing the EDI
file. We recommend that you obtain an EDI standards manual for the standard and version
that you will use. Standards manuals are available from EDI standards agencies.

After discussing with your partner what they will send, determining which segments and
elements your company requires, and reviewing the EDI standard, you can list the items
that you will need to use. You will then make the form components you need available for
use.

For an EDIFACT purchase order (ORDERS), the following groups, segments,
composites, and elements have been defined as mandatory by the standards committee.

This table describes the components that are activated automatically when you create a
new form.

Segment Composite Element Description
BGM Beginning of Message
DTM Date/Time/Period
C507
DTMO1 Date/Time/Period Qualifier
UNS Section Control
UNSO1 Section Identification
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Form analysis

Required
components

Basic Tasks

Thefirst step in creating aform isto analyze its requirements. If the analysis you perform
is complete, you will have all the information you need to create the form in an efficient
and logical manner. If you omit this critical step and proceed directly to creating the form,
it islikely that creating the form will be a much longer and arduous task, and the form may
not work the way you need it to, due to oversights and omissions.

Creating a print form for the EDIFACT ORDERS purchase order requires several steps.
Some steps are performed at the message leve (such as activating form components), and
others are iterative steps that are performed for each group, segment, or element in the
form. In this analysis phase, you must determine what type of EDI data Pet Zone will be
sending you, as well as what information you want to print for the purchase order. The
fields on the form must accommaodate all information that you want to print from the
purchase order your trading partner sends you.

Thistable lists the form components that are required (need to be activated) and are not
mandatory for the standard.

Note

When you activate aconditional group, segment, or composite, the mandatory subordinate
segments, composites, and elements are activated automatically. A conditional group,
segment, or composite isused only if thereis EDI data available for an element in it.

Data CodeValue/For mat
Element Description Type Length | toBeAssigned

Beginning of M essage (BGM Segment) (Already Activated)

BGMO05 Document/Message Number | String 35

BGMO06 M essage Function, Coded String 3

Date/Time/Period (DTM Segment)

DTMO1 Date/Time/Period Qualifier String 3

DTMO02 Date/Time/Period String 35 » 4 (Change)
» 13 (Request)

Free Text (FTX Segment)

FTX01 Text Subject Qualifier String 3
FTX06 Free Text String 70
Reference (RFF Group)
Reference (RFF Segment)
RFFO1 Reference Qualifier String 3
RFF02 Reference Number String 35
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(Contd) Data CodeValue/Format
Element Description Type Length | toBeAssigned

Name and Address (NAD Group)

Name and Address (NAD Segment)

NADO1 Party Qualifier String 3 » AA (Party
billed)
» BY (Buyer)
» ST (Shipto)
NAD10 Party Name String 35

NAD16 Street and Number/PO. Box | String 35

NAD17 Street and Number/PO. Box | String 35

NAD19 City Name String 35

NAD20 Country Sub-Entity String 9
Identification

NAD21 Postcode I dentification String 9

Payment Terms Basis (PAT Group)

Payment Terms Basis (PAT Segment)

PATO1 Payment Terms Type String 3 » 10 (Instant)
Qualifier » 18 (Previousy
Agreed Upon)
PAT02 Terms of Payment String 17
I dentification
PATO05 Terms of Payment String 35

Lineltem (LIN Group)

Lineltem (LIN Segment)

LINO1 Line ltem Number Number | 6

Additional Product ID (PIA Segment in LIN Group)

PIAO1 Product ID Function Qualifier | String 3

PIAQ2 Item Number String 35

Item Description (IMD:2 Segment in LIN Group)

IMD:206 | Item Description String 35
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(Contd) Data CodeValue/Format
Element Description Type Length | toBeAssigned
M easurements (MEA:3 Segment in LIN Group)
MEA:301 | Measurement Application String 3
Qualifier
MEA:305 | Measure Unit Qualifier String 3
MEA:306 | Measurement Value String 18 Format = RO
Quantity (QTY:3 Segment in LIN Group)
QTY:301 | Quantity Qualifier String 3
QTY:302 | Quantity Number | 15 Format = NO
Date/Time/Period (DTM:13 Segment in LIN Group)
DTM:130 | Date/Time/Period Qualifier String 3
1
DTM:130 | Date/Time/Period String 35
2
Monetary Amount (MOA:5 Segment in LIN Group)
MOA:501 | Monetary Amount Type String 3
Qualifier
MOA:502 | Monetary Amount Number | 18 Format = R2
Section Control (UNS Segment)
UNSO1 Section Identification String 1
Control Total (CNT Segment)
CNTO1 Control Qualifier String 3
CNTO2 Control Value Number | 18 Format = NO
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Segment analysis  For each mandatory or optional segment activated you must answer the following

questions:

» Isthe segment agroup?

»  Will the segment have a maximum use greater than one?

» What composites and elements need to be activated for the segment?

This table describes the segment components used in this tutorial.

Component

Description

Group

Contains related segments and/or groups that
repeat in sequence until either the group data ends
or the maximum number of times that the loop is
allowed to repeat is exhausted.

Repeating segment

Consists of elementsthat repeat in sequence until
either the data ends or the maximum number of
times the segment is allowed to repeat is exhausted.

Composite

Contains two or more component data elements or
subelements. Composites are defined by the EDI
standards that use them (EDIFACT,
TRADACOMS, and certain ANSI X12 standards).

Maximum use

Refers to the number of timesit can be used within
the structure in which it is defined. For example, if
a segment can be used only once within a group,
but the group can be used multiple times, the
segment still has a maximum use of one within
each occurrence of the group. The standard defines
the maximum number of times a segment can be
used, but you must determine which of these
segments will be used based on what your trading
partner will be sending you.

Elements

Each segment contains elements. Some elements
are mandatory and others are optiona to the
standard but necessary for your needs. You must
define al the elements that you will expect from
Pet Zone for each segment.
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Customization Sterling Gentran: Server generates aform based on the groups, segments, composites, and
tasks elementsyou activate. At this point, the form is compliant with the standard and it
contains all the necessary components based on the data Pet Zone will send you. However,
you need to customize the form components to produce a printed report the way your
company expectsit to look.

Thistable lists the customization tasks described in this tutorial.

Form
Component

Description

Customization Task

BGMO05
element

Document/Message
Number

You will set up the document name (which
enables you to differentiate between messages
in the document browsersin Sterling
Gentran:Server) in this element. In addition,
the standard allows this element to have a
maximum length of thirty-five characters, but
you expect a string no longer than ten
characters from your trading partner. You will
change both the maximum length of the
element and the display length of thefield to
ten. Also, you will change the field name to
Order Number, which better describes the data
in thisfield for your company.

BGMO06
element

Message Function,
Coded

The code from this element will be used to
look up the description in acodelist table, and
the description will be printed in another field
that you create. You will prevent the Message
Function, Coded field from being displayed on
the printout, because the more meaningful
description will be printed instead.

DTM
segment

Date/Time/Period

The standard allows this segment to be used up
to thirty-five timesin one purchase order, but
you and your trading partner have decided to
use this segment only once. Therefore, you
will change the maximum use of this segment
to one.

DTMO1
element

Date/Time/Period
Qualifier

Thiselement is required in the purchase order,
but is not meaningful for your purposes. You
will prevent thisfield from being displayed on
the printout.
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(Contd)
Form
Component | Description Customization Task

DTMO02 Date/Time/Period The standard allows a maximum length of
element thirty-five characters, but you expect a string
no longer than eight characters from your
partner. You will change the maximum length
of the element and the display length of the
field to eight. Also, you will change the field
name to Order Date, which better describesthe
datain thisfield for your company.

FTX segment | Free Text The standard allows this segment to be used up
to five timesin one purchase order, but you
and your trading partner have decided to use
this segment only once. Therefore, you will
change the maximum use of this segment to
one.

FTXO01 Text Subject This element is required in the purchase order,
element Qualifier but is not meaningful for your purposes.
Therefore, you will prevent thisfield from
being displayed on the printout.

FTX06 Free Text The standard allows a maximum length of
element seventy characters, but you expect a string no
longer than sixty characters from your partner.
You will change the maximum length of the
element and the display length of thefield to
sixty. Also, the datain this element will be
self-explanatory, so you will remove the |abel
from thisfield.

RFF group Reference The standard allows this group to be used up to
ten times in one purchase order, but you and
your trading partner have decided to use this
group only once. Therefore, you will change
the maximum use of this group. Also, you will
promote this group so that the fieldsin this
group are placed on the same frame as the
related header fields.

RFFO1 Reference Qualifier This element is required in the purchase order,
element but is not meaningful for your purposes. You
will prevent thisfield from being displayed on
the printout.
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(Contd)

Form

Component | Description Customization Task

RFF02 Reference Number The standard allows a maximum length of

element thirty-five characters, but you expect a string
no longer than twelve characters from your
partner. You will change the maximum length
of the element and the display length of the
field to twelve. Also, you will change the field
name to Contract No., which better describes
the datain this field for your company.

NADO1 Party Qualifier The qualifier from this element will be used to

element look up the description in a code list table, and
the description will be printed in another field
that you create. You will prevent the Party
Qualifier field from being displayed on the
printout, because the more meaningful
description will be printed instead.

NAD10 Party Name The datain this element will be explained by

element the qualifier in the Party Qualifier element, so
you will remove the label from thisfield.

NAD16 Street and Number/ The datain this element will be self-

element P.O. Box explanatory, so you will remove the label from
thisfield.

NAD17 Street and Number/ The datain this element will be self-

element P.O. Box explanatory, so you will remove the label from
thisfield.

NAD19 City Name The standard allows a maximum length of

element thirty-five characters, but you expect a string
no longer than thirty characters from your
partner. You will change the maximum length
of the element and the display length of the
field to thirty. Also, the datain this element
will be self-explanatory, so you will remove
the field label.

NAD20 Country Sub-Entity The standard allows a maximum length of nine

element Identification characters, but you expect a string no longer
than two characters from your partner. You
will change the maximum length of the
element and the display length of thefield to
two. Also, the datain this element will be self-
explanatory, so you will remove the field label.

NAD21 Postcode The datain this element will be self-

element I dentification explanatory, so you will remove thefield label.
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(Contd)
Form
Component | Description Customization Task

PAT group Payment Terms Basis | The standard allows this group to be used up to
ten times in one purchase order, but you and
your trading partner have decided to use this
group only once. Therefore, you will change
the maximum use of this group. Also, you will
promote this group so that the fieldsin this
group are placed on the same frame as the

related header fields.
PATO1 Payment Terms Type | The qualifier from this element will be used to
element Qualifier look up the description in acodelist table, and

the description will be printed in another field
that you create. You will prevent the Payment
Terms Type Qualifier field from being
displayed on the printout, because the more
meaningful description will be printed instead.

PATO2 Terms of Payment This element is required in the purchase order,
element Identification but is not meaningful for your purposes. You
will prevent thisfield from being displayed on
the printout.

PATO5 Terms of Payment The datain this element will be explained by
element the qualifier in the Terms of Payment
Identification element, so you will remove the
|abel from thisfield.

LIN group Lineltem After you customize and format the fieldsin
the LIN group, you will copy and paste the
LIN group at the same level in the EDI file.
The original LIN group will contain column
headings for the line item detail, but you will
prevent the column headings from being
printed for al lineitems after thefirst. You will
change the maximum use of the first LIN
group to one so that the column headings are
printed only once (for the first line item). You
will change the maximum use of the second
LIN group to 199,999. Up to two hundred
thousand line items (one from the first LIN
group and 199,999 from the second LIN
group) can be printed on the printout (without
printing the column headings for each line
item).
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(Contd)

Form

Component | Description Customization Task

LINO1 Line Item Number The standard allows a maximum length of six
element characters, but you expect a string no longer

than five characters from your partner. You
will change the maximum length of the
element and the display length of thefield to
five. Also, you will change the field nameto
Line, which briefly describes the datain this

field.
PIA segment | Additional Product The standard allows this segment to be used up
(inLIN ID to twenty-fivetimesfor each lineitem, but you
group) and your trading partner have decided to use

this segment only once. Therefore, you will
change the maximum use of this segment to

one.

PIAOL Product ID Function | Youwill change the field name to Code, which

element Qualifier more briefly describes the datain thisfield for
your company.

PIAO2 [tem Number The standard allows a maximum length of

element thirty-five characters, but you expect a string

no longer than six characters from your
partner. You will change the maximum length
of the element and the display length of the
field to six. Also, you will change the field
name to Prod ID, which briefly describesthe
datain thisfield.

IMD Item Description The standard allows this segment to be used up
segment (in to ten times for each line item, but you and
LIN group) your trading partner have decided to use this

segment only once. Therefore, you will change
the maximum use of this segment to one.

IMDO6 Item Description The datain this element will be self-

element explanatory, so you will remove the label from
thisfield.

MEA Measurements The standard allows this conditional segment

segment (in to be used up to five times for each line item,

LIN group) but you and your trading partner want to use

this segment only once. You will change the
maximum use of this segment to one. Also, to
make this segment mandatory, you will change
the minimum use of this segment to one.
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(Contd)
Form
Component

Description

Customization Task

MEAO1
element

M easurement
Application Qualifier

Thiselement is required in the purchase order,
but is not meaningful for your purposes. You
will prevent thisfield from being displayed on
the printout.

MEAO05
element

Measure Unit
Qualifier

Thiselement is required in the purchase order,
but is not meaningful for your purposes. You
will prevent thisfield from being displayed on
the printout.

MEAO06
element

Measurement Value

The standard allows a maximum length of
eighteen digits, but you expect a number no
longer than two digits from your partner. You
will change the maximum length of the
element and the display length of the field to
two. You will change the field name to Unit,
which better describes the datain thisfield for
your company. Also, the standard defines the
datain this element as being formatted with an
explicit decimal point and up to nine decimal
places. You will not use decimal placesfor the
datain thisfield, so you will format both the
EDI data and the printed data without decimal
places.

QTY
segment (in
LIN group)

Quantity

The standard allows this segment to be used up
to ten times for each line item, but you and
your trading partner want to use this segment
only once. You will change the maximum use
of this segment to one. Also, to make this
segment mandatory, you will change the
minimum use of this segment to one.

QTYO1
element

Quantity Qualifier

This element is required in the purchase order,
but is not meaningful for your purposes. You
will prevent thisfield from being displayed on
the printout.
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Form
Component

Description

Customization Task

QTYO02
element

Quantity

The standard allows a maximum length of
fifteen digits, but you expect a number no
longer than six digits from your partner. You
will change the maximum length of the
element and the display length of thefield to
six. You will change the field name to Qty,
which briefly describesthe datain thisfield.
Also, the standard defines the datain this
element as being formatted with an explicit
decimal point and up to nine decimal places.
You will not use decimal places for the datain
thisfield, so youwill format both the EDI data
and the printed data with an implicit decimal
point and no decimal places.

DTM
segment (in
LIN group)

Date/Time/Period

The standard allows the date/time/period to be
used up to thirty-five times for each line item.
You need two separate DTM segments: the
required shipment date, and the last delivery
date (in that order). You will promote this
segment to cause another iteration of this
segment to occur for each lineitem, and then
change the maximum use to one because you
need to use this segment only once per line
item. Also, you know what types of datesyou
will receive (and in what order), so you will
use the key field function to print the required
shipment date in one DTM segment and the
last delivery date in the other DTM segment.

DTMO01
element

Date/Time/Period
Qualifier

This element is required in the purchase order,
but is not meaningful for your purposes. You
will prevent thisfield from being displayed on
the printout.

DTMO02
element

Date/Time/Period

The standard allows a maximum length of
thirty-five characters, but you expect a string
no longer than eight characters from your
partner. You will change the maximum length
of the element and the display length of the
field to eight. Also, you will change the field
name to Requested (or Ship No for the DTM02
element in the second iteration of the DTM
segment), which briefly describesthe datain
thisfield.
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(Contd)
Form
Component

Description

Customization Task

MOA
segment (in
LIN group)

Monetary Amount

The standard allows this segment to be used up
to five times for each line item, but you and
your trading partner have decided to use this
segment only once. You will change the
maximum use of this segment to one.

MOAO01
element

Monetary Amount
Type Qualifier

Thiselement is required in the purchase order,
but is not meaningful for your purposes. You
will prevent thisfield from being displayed on
the printout.

MOAQ2
element

Monetary Amount

The standard allows a maximum length of
eighteen digits, but you expect a number no
longer than eight digits from your partner. You
will change the maximum length of the
element and the display length of the field to
eight. You will change the field nameto Price,
which better describes the datain thisfield for
your company. Also, the standard defines the
datain this element as being formatted with an
explicit decimal point and up to nine decimal
places. You need only two decimal places for
the datain thisfield, so you will format the
EDI dataand the printed datawith two decimal
places.

UNSO1
element

Section |dentification

This element isrequired in the purchase order,
but is not meaningful for your purposes. You
will prevent thisfield from being displayed on
the printout.

CNT
segment

Control Total
Segment

You want this segment to print the total
number of lineitems at the end of the printout.
However, if the form were generated now, the
total would be printed at the beginning of the
printout (because the fieldsin the CNT
segment would be displayed on the sameframe
asthe fieldsin the BGM segment). You will
change the arrangement of the form, while
maintaining the integrity of the EDI data, so
thetotal is printed at the end of the purchase
order.

CNTO1
element

Control Qualifier

This element is required in the purchase order,
but is not meaningful for your purposes. You
will prevent thisfield from being displayed on
the printout.
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Form
Component

Description

Customization Task

CNTO02
element

Control Value

The standard allows a maximum length of
eighteen digits, but you expect a number no
longer than six digits from your partner. You
will change the maximum length of the
element and the display length of thefield to
six. You will change the field name to Number
of Line Items, which better describes the data
in thisfield for your company. Also, the
standard defines the datain this element as
being formatted with an explicit decimal point
and up to nine decimal places. You will not use
decimal placesfor the datain thisfield, so you
will format both the EDI data and the printed
datawith an implicit decimal point and no
decimal places.
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Design and Create the Form

Verifying the Global EDI Date Formats

Introduction Sterling Gentran: Server Forms Integration enables you to customize the global EDI date
formats. You can specify the default EDI format of dates for both six-character dates and
eight-character dates. After you customize the global EDI date formats, the settings are
valid for al forms created in the current session. You can override the default date formats
for an individual element on the Field Properties dialog for that element.

You must verify that you are using the correct global date formats the first time you use
Forms Integration. You can change the default date formatsif they do not match the
formats you intend to use.

Procedure  Usethis procedure to verify the global EDI date formats.

Step

Action

1

Launch the Forms I ntegration subsystem.

Reference
See How to Launch Forms Integration on page 1 - 9 for instructions.

Select Preferences from the Options menu to display the Preferences
dialog.

Note
The Preferences dialog is a property sheet that enables you to set global
defaults for Sterling Gentran: Server Forms I ntegration

Verify that the Standard Formats tab displays the default date formats that
are used when elements are read from the standards database.

Verify that the Six-character dateslist contains Y YMMDD to define the
format of the six-character EDI datesin your forms.

Verify that the Eight character dateslist containsYYYYMMDD to
define the format of the eight-character EDI datesin your forms.

Click OK to accept the default date formats for 6- and 8-character date
fields and to exit the Preferences dialog.

Note

To change the order in which the date formats appear in the Six-char acter
dates and Eight character dates|lists or to add a new date format to the
lists, select Date For mats from the Options menu.
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Defining the Type of Form

Overview  Thefirst task in creating a new form isto define the type of form and EDI standard,
version, and message. In thistutorial, you are creating a print form so that you can print
the purchase ordersthat your partner sends you. Instead of defining the ORDERS message
to the system yourself, you want Sterling Gentran: Server to use the standards database on
your system to build the purchase order according to the EDIFACT standard.

Beforeyou begin  Before you begin this procedure, verify that you have installed the Sterling Standards
Database for EDI.

Reference

See How to Install Serling Sandards Database for EDI on page 1 - 10 for instructions.

Procedure  Usethis procedure to create the new print form.

Step

Action

Select New from the File menu to display the New Form Wizard.

From the What kind of form are you creating list, select Print to indicate
that the tranglation object you are creating is a print translation object.

In the What is the name of the form box, enter Print ORDERS Pet Zone.
This description provides a brief explanation of the compiled translation.

Example
Print ORDERS Pet Zone is the description of a print trandlation object for
an EDIFACT 92.1 purchase order (ORDERS) for partner Pet Zone.

Verify that the name that appearsin the What is your name box is
accurate.

Click Next to advance the wizard.

Select Delimited EDI as the data format syntax that you want to use.

Click Customize.

System Response
The system displays the New Delimited EDI Wizard.

Click Next to continue.

From the Data Source list, select Gentran Sandards ODBC data source
that you wish to use.

10

Click Next to continue.
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(Contd)
Sep

Action

11

From the Agency list in the Standards section, select [E] Edifact, whichis
the EDI standard you will use for this translation object.

12

From the Version list, select [092001] EDIFACT 1992 RELEASE 1,
which istheversion of the standard you will use for thistranslation object.
The versions that are available depend on which standard you selected.
The EDIFACT standard version 92.1 islisted as version 092001 in the
Sterling Gentran:Server standardsfiles.

13

From the Transaction list, select [ ORDERS] PURCHASE ORDER
MESSAGE, which is the message you will use for this translation object.
The messages that are available depend on which standard and version
you selected.

14

Click Next to continue.

15

Click Finish. This may take afew seconds.

System Response
The system displays the New Form Wizard dialog box.

16

Click Next to continue.

17

Click Finish to create the EDI file.

System Response
Theform is displayed.

& Gentran Forms Integration - [Print Orders Pet Zone]
% File Edt Functions View Display  Optiohs  Window  Help _|ﬁl|1|

b1 e ] s e = = ==

E10RDRSP - M - 1 PURCHASE ORDER RESPONSE M4 |
] BGM -t - 1 BEGINMING OF MESSAGE
DT - M - 35 DATE/TIME/PERIOD

i o

Faor Help. press F1

18

From the Edit menu, select Details.

System Response
The Translation Object Details dialog box is displayed.
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(Contd)
Sep

Action

19

Verify that Print is selected from the Tranglation Object Function list.

20

In the Major version box, enter 1 to designate the version number for this
translation object.

21

In the Minor version box, accept the default value O that designates the
release number for this translation object.

Recommendation

After you make amgjor change to this form, increase the version to the
next higher sequential number (e.g., 2.0). If you make a minor change to
the form, increase the release to the next higher sequential number (e.g.,
2.1).

22

The Input and Output boxes (Agency, Version, Transaction, Release, and
F Group) contain information only if the Input and/or Output sides of the
form are of EDI format. For thistutorial, do not change the information in
these boxes.

Note

The system alows you to change the information in the Input and Output
boxes, but modifying this information does not alter the content of the
form. An example of when you might want to ater these boxesis when
you want the form to reflect a standard version that is not loaded on your
system. You can change the version on this dialog, and then physically
ater the form to be compliant with that version.

23

Click OK to save your changes and to exit the Translation Object details
dialog box.

24

Select Save from the File menu.

Recommendation

We recommend that you save the form as often as possible, to mitigate the
possible loss of additions or modificationsin the event of a hardware or
system error.

Note

If you have performed any function that invalidates the current format of
the translation object, the Save function is unavailable until you
regenerate the layout (click Generate Layout on the Main Toolbar).

25

Verify that the Savein list reflects the drive\folder where Sterling
Gentran:Server isinstalled.

Default
The default drive\folder is GENSRVNT\Forms.

Forms Integration EDIFACT Tutorial Guide
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(Contd)
Sep Action

26 In the File name box, enter peteor dp.stp to replace the default file name.
The file name should be unique. In our example, the name indicates an
EDIFACT purchase order message (ORDERS) for partner Pet Zone.

Note
The default file extension for formsis .STP. The naming conventionsin
Sterling Gentran: Server — Forms Integration are as follows:

» Thesourceform (form created in Sterling Gentran: Server) should be
named using the file extension .STP (e.g., PETEORDPSTP).

» Thecompiled translation object (trand ation object that isthe result of
compiling the source form) should be named using the same file
name that was allocated to the source form, but with thefile extension
.TPL (e.g., PETEORDPTPL).

27 Click Save to save the form.
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Activating Groups, Segments, Composites, and Elements

Overview

Example

Groups, segments,
composites,
elementsused in
thistutorial

When Sterling Gentran: Server generates the form, the system includes all the groups,
segments, composites, and elements that are defined by the standard agency (EDIFACT)
for the version (92.1) of the message (ORDERS) you selected. The system activatesall the
groups, segments, composites, and elements that are defined as mandatory (must be
present) by the standard. The system does not enable you to deactivate the mandatory
groups, segments, composites, and elements.

In the example below, the BGM and DTM segments, C507 composite, and DTM01
element are mandatory for the purchase order. You do not need to activate these
components. The DTM02 and DTMO03 elements are not mandatory, so they are dimmed
on the form.

£F ORDERS M- PURCHASE ORDER MESSAGE
EGM -M- 1 BEGIMNING OF MESSAGE
DTM M- 35 DATE/TIME/PERIOD
£ CEO7 M-
E # (1 2005 M- Stiing 3 -Printed- DATE/TIME/PERIDD QUALIFIER

™
a

To view the segments, composites, and elementsin a group, segment, or composite on
your form, double-click the form component in the EDI File Format Window (left side of
the Forms main window). To activate an inactive form component, click Activate on the
Main Toolbar, then click the form component. The component is no longer dimmed.

You must activate the groups, segments, composites, and elements that are not defined as
mandatory by the standard, but that you have determined that you need to use in the form.

Thistable lists the groups, segments, composites and elements to be used in this tutorial.

Group Segment Composite Element
BGM BGMO05
(already activated)

BGMO06

DTM C507 DTMO02
(already activated) (already activated)
FTX C108

RFF RFF C506 RFFO2

(mandatory for RFF)
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Segment Composite Element
NAD NAD €080
C059 NAD17
NAD19
NAD20
NAD21
PAT PAT C110 PATO05
LIN LIN LINO1
PIA C212 PIAO2
(mandatory for PIA)
IMD:2 C273 IMD:206
MEA:3 C174 MEA:306
QTY:3
DTM:13 C507 DTM:1302
(mandatory for DTM:13)
MOA:5 C516 MOA:502
(mandatory for MOA:5)
CNT
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Activating Groups, Segments, Composites, and Elements

Procedure  Usethis procedure to activate the required groups, segments, composites, and elements.

CAUTION

YOU MUST ACTIVATE ALL REQUIRED GROUPS, SEGMENTS,
COMPOSITES, AND ELEMENTSLISTED ON THE FOLLOWING
TABLE. FAILURE TO DO SOWILL HINDER YOUR ABILITY TO

PERFORM

STEPSLATERIN THISTUTORIAL.

Step

Action

1

On the Petorp.stp form that you just created, double-click the groups,
segments, and composites listed in the previous table to open them.
Opening all the necessary groups, segments, and composites before you
start to activate enables you to scroll down the form and activate the
segments, composites, and elements sequentially.

Note

When you activate a conditional group, segment, or composite, the
mandatory subordinate segments, composites, and elements are activated
automatically.

Click the Activate button on the Main Toolbar.

Click each inactive group that you need to use. Thiswill activate the
groups.

Note

If you click a group, segment, composite, or element that you did not
mean to activate, click the component with the right mouse button to
access the shortcut menu then select Deactivate from the shortcut menu.

Click each inactive segment that you need to use. This activates the
segments.

Click each inactive composite that you need to use. This activates the
composites.

Click each inactive element that you need to use. This activates the
elements.

Note

When you activate an element in a print form, the tag Printed is displayed
before that element’s description to indicate that this field will be printed.
If you later prevent afield from being displayed on the printout, then the
tag Not Printed is displayed before that element’s description.

Click the Activate button on the Main Toolbar to turn activation mode off.

Note
To hide the groups, segments, and elements that you are not using, select
Show Active Only from the View menu.
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(Contd)
Sep Action
8 From the File menu, select Save to save your form.
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Verifying EDI Delimiters

Overview  You areusing an EDI standard that contains composite el ements or subelements, so you
must verify that Sterling Gentran: Server is specifying the correct delimiters. Delimiters
are flags that you define to the system as separating specific EDI components. Delimiters
are necessary for al variable field-length standards, because the data is compressed and
the leading zeroes and trailing blanks are removed. Thefieldsvary in length, so the system
needs aflag to determine where one element ends and another begins. For example, an
element delimiter marks the beginning of a new element.

EDI delimiters  Thistableliststhe valid EDI delimiters.

table
EDIFACT Default EDIFACT Default
Field Character Hex Value

Tag Delimiter + (plus sign)

Segment Delimiter * (apostrophe) 0x27
Element Delimiter + (plus sign) 0x2B
Sub Element Delimiter : (colon) Ox3A
Decimal Separator . (period) Ox2E
Release Character ? (question mark) O0x3F
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Procedure  Usethis procedure to verify EDI delimiters.

Sep Action
1 Click the ORDERS file icon with the right mouse button and select
Properties from the shortcut menu to display the File Format Properties
dialog.

System Response
The system displays the File Format Properties dialog box.

File Format Properties

Hame ] Delimiters] Loop Extended Hules]

Flease enter the name
|ORDERS

Pleaze enter a short description :
PURCHASE ORDER MESSAGE

Cancel Help
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Verifying EDI Delimiters

(Contd)
Sep

Action

2

Click the Delimiter s tab to access the Delimiters dialog box.

System Response
The system displays the Delimiters dialog box.

File Format Properties

Mame ~Delimiters l Loop Extended F!ules]

Tag Delimiter + Sub Element Delimiter |-
Segment Delimiter | Decimal Separatar ]
Element Delimiter [+ Releaze Character ?

QK | Cancel Help

Verify that the correct delimiters are being used for the EDIFACT
standard. If the delimiters differ from the default values listed in the

previoustable, you can enter either the character or the hexadecimal value
in the correct box.

Reference

See the EDI delimiters table on page 2 - 29 for alist of valid EDI
Delimiters.

Click OK to save the delimiters and exit the Delimiters dialog.
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Modify Form Components

Promoting and Changing Segments and Groups

Introduction

Changing the
minimum use

Changing the
maximum use

The Promote function extracts one iteration or instance of a group or repeating segment.
Promote is a specialized function that preserves the integrity of the EDI structure.

By default, the fields corresponding to each group and repeating segment are displayed on
a separate frame than the rest of the fields in the document. When you promote a group to
the parent frame, the fields corresponding to the group are displayed on the frameto which
the group is subordinate. If you do not promote a group to the parent frame, the fields
corresponding to the group are displayed on their own frame.

Changing the minimum use of a segment or group from zero to one changes the status of
the segment or group from conditional to mandatory. If EDI datais not present for a
segment or group that has a minimum use of one or greater, a compliance error occurs
during translation for that segment or group.

A segment or group with a maximum use greater than one repeats (loops) and is placed on
a separate frame than the segment or group to which it is subordinate. A segment or group
with a maximum use of one does not repeat and its fields are displayed on the same frame
as the group or segment to which they are subordinate.
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Modifyingthe DTM Segment

Overview  This section describes how to change the maximum use of the DTM segment.

How to changethe  The DTM segment contains Date/ Time/Period header information (in this tutorial, the
maximum use of order date) used in the EDI data. The standard allowsthe DTM segment to be used up to
the DTM segment 35 times in one purchase order. In thistutorial, you expect the DTM segment only once
from your trading partner, so you will change the maximum number of times this segment
can be used to one.

Use this procedure to change the maximum use of the DTM segment.

Sep Action

1 Click the DTM segment with the right mouse button and select
Properties from the shortcut menu.

System Response
The Segment Properties dialog is displayed.

EDI Segment Properties
Marme ]Speciall Key Field] Print ] Lnnping] Loop Extended Hulesl

Fleasze enter the name :
LT HA

Please enter a short deszcription
DATESTIME/PERIOD

QK. | Cancel Help

2 Select the L ooping tab.

3 In the Max Usage box, enter 1 to indicate that this segment can be used
only once.

4 Click OK to exit the Segment Properties dialog.
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Modifying the FT X Segment

Overview  The FTX segment contains Free Text header detailsin the EDI data. The standard allows
the FTX segment to be used up to five timesin one purchase order. In thistutorial, you
expect the FTX segment only once from your trading partner so you will change the
maximum number of times this segment can be used to one.

Procedure  Usethis procedure to change the maximum use of the FTX segment.

Sep Action

1 Click the FT X segment with the right mouse button and select Properties
from the shortcut menu.

System Response
The Segment Properties dialog is displayed.

2 Select the L ooping tab.
3 In the Max Usage box, enter 1.
4 Click OK to exit the Segment Properties dialog.
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Modifying the RFF Group

Overview If the form were generated now, the fields associated with the RFF group would be
displayed on a separate frame than the BGM header fields. The standard allows the RFF
group to be used up to 10 times in one purchase order. In this tutorial, you expect the RFF
group only once from your trading partner so you will change the maximum number of
times the RFF group can be used to one. Also, you need to set the Promote flag on the
group so that the RFF fields are placed on the same frame as the BGM fields. After you
generate the form later in this tutorial, the RFF fields are displayed on the same frame as
the BGM fields.

Procedure  Usethis procedure to change the maximum use of the RFF group and promote the RFF
group to the parent frame.

Sep Action

1 Click the RFF group with the right mouse button and select Properties
from the shortcut menu.

System Response
The Group Properties dialog is displayed.
Group Properties
N ame l Print ] Laoping ] Loop Extended Rules ]

Please enter the name :

Fleaze enter a zhort description

QK | Cancel Help

2 Select the L ooping tab.
3 In the Max Usage box, enter 1.
4 Select the Print tab.
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(Contd)
Sep Action

5 Select the Promote group to parent frame check box to display the
fields in the RFF group on the same frame as the fields in the parent

group.

Note

If you change the maximum use of this group, but do not select the
Promote group to parent frame check box, the fieldsin this group will not
be displayed on the same frame in the Layout Window asthe fieldsin the
parent group.

6 Click OK to promote the group and to exit the Group Properties dial og.
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Modifying the PAT Group

Overview  The standard alows the PAT group to be used up to 10 timesin one purchase order. You
expect the PAT group only once from your trading partner so you must change the
maximum number of times the PAT group can be used to one. Also, you heed to set the
Promote flag on the group so that the PAT fields are placed on the same frame asthe BGM
fields. When you generate the form later in this tutorial, the PAT fields will be displayed
on the same frame as the BGM fields.

Procedure  Usethis procedure to change the maximum use of the PAT group and promote the PAT
group to the parent frame.

Step

Action

1

Click the PAT group with the right mouse button and select Properties
from the shortcut menu.

System Response
The Group Properties dialog is displayed.

Select the L ooping tab.

In the Max Usage box, enter 1.

Select the Print tab.

Select the Promote group to parent frame check box to display the fields
in the PAT group on the same frame as the fields in the parent group.

Click OK to promote the group and exit the Group Properties dial og.
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Modifying the LIN Group

Overview  This section describes how to:
» change the maximum use of the PIA segment
» change the maximum use of the IMD:2 segment
» change the minimum and maximum use of the MEA:3 segment
» change the minimum and maximum use of the QTY:3 segment
» promote the DTM:13 segment
» makethe DTM:27 segment conditional
» change the maximum use of the DTM:13 segment
» change the maximum use of the MOA:5 segment

How to changethe  ThePIA segment in the LIN group contains Line Item details used in the EDI data. The
maximum use of standard allows the PIA segment to be used up to 25 times for each lineitem. In this
the PIA segment tutorial, you expect the PIA segment only once per line item from your trading partner so
you will change the maximum number of times this segment can be used for each line
item to one.

Use this procedure to change the PIA segment’s maximum use.

Sep Action

1 Click the PI A segment with the right mouse button and select Properties
from the shortcut menu.

System Response
The Segment Properties dialog is displayed.
EDI Segment Properties

Harne ]Special] Ky Field] Frint ] Looping] Loop Extended Hules]

Flease enter the name :
Pl

Pleaze enter a short description ;
ADDITIONAL PRODUCT ID

Ok | Cancel Help

2 Select the L ooping tab.
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How to changethe
maximum use of
the M D:2 segment

How to changethe
minimum and
maximum use of
the MEA:3
segment

Modifying the LIN Group

Action

3 In the Max Usage box, enter 1.

4 Click OK to exit the Segment Properties dialog.

The IMD:2 segment (in the LIN group) contains Item Description details used in the EDI
data. The standard allows the IMD:2 segment to be used up to 10 times for each line item.
You expect the IMD:2 segment only once per line item from your trading partner so you
must change the maximum number of times this segment can be used for each line item to
one.

Use this procedure to change the maximum use of the IMD:2 segment.

Sep Action

1 Click the M D: 2 segment with the right mouse button and select
Properties from the shortcut menu.

System Response
The Segment Properties dialog is displayed.

2 Select the L ooping tab.
3 In the Max Usage box, enter 1.
4 Click OK to exit the Segment Properties dialog.

The MEA:3 segment in the LIN group contains Measurements details used in the EDI
data. The standard allows the MEA:3 segment to be used up to five timesfor each line
item. In thistutorial, you expect the MEA:3 segment only once per line item from your
trading partner so you will change the maximum number of times this segment can be
used for each lineitem to one. The standard also allows this segment to be conditional.
You and your trading partner agree that the measurements contained in the MEA:3
segment are important to the purchase order, so you will change the minimum use of this
segment to one to make it mandatory.

Use this procedure to change the minimum use and maximum use of the MEA:3 segment.

Sep Action

1 Click the MEA: 3 segment with the right mouse button and select
Properties from the shortcut menu.

System Response
The Segment Properties dialog is displayed.

2 Select the L ooping tab.

3 In the Min Usage box, enter 1.
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How to changethe
minimum and
maximum use of
the QTY:3 segment

How to promote
theDTM:13
segment

Action

4 In the Max Usage box, enter 1.

5 Click OK to exit the Segment Properties dialog.

The QTY:3 segment (in the LIN group) contains Quantity details used in the EDI data.
The standard allows the QTY:3 segment to be used up to 10 times for each line item. In
this tutorial, you expect the QTY:3 segment only once per line item from your trading
partner so you will change the maximum number of times this segment can be used for
each lineitem to one. You and your trading partner agree that the quantities contained in
the QTY:3 segment are important to the purchase order so you will change the minimum
use of this segment to one.

Use this procedure to change the minimum use and maximum use of the QTY:3 segment.

Sep Action

1 Click the QTY:3 segment with the right mouse button and select
Properties from the shortcut menu.

System Response
The Segment Properties dialog is displayed.

2 Select the L ooping tab.

3 In the Min Usage box, enter 1.

4 In the Max Usage box, enter 1.

5 Click OK to exit the Segment Properties dialog.

If the form were generated now, the date in the DTM:13 segment in the LIN group for the
line item information would be printed on a separate frame than the rest of the lineitem
fields. You want the date to be placed on the same frame as the rest of the lineitem
information so you will promote the DTM:13 segment. Your trading partner sends you
two sets of dates: the required shipment date and the last delivery date (in that order). The
DTM:13 segment must occur twice in the form to accommodate both sets of dates from
your trading partner in the particular order in which you expect them. To customize the
DTM:13 segment while preserving the integrity of the EDI structure, you need to promote
the DTM:13 segment, then change the maximum use of the original DTM:13 segment to
one so that it is no longer a repeating segment.

Use this procedure to promote the DTM:13 segment.

Sep Action
1 Click the DTM :13 segment with the right mouse button.
2 Select Promote from the shortcut menu.
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Action

3 Click Yes at the prompt to extract one iteration of the DTM:13 segment
and place it directly above the DTM:13 segment that you selected to
promote.

System Response
The new iteration of the DTM:13 segment is named DTM:27.

How to makethe  Usethis procedure to make the DTM:27 segment conditional.
DTM:27 segment

conditional Note

When you promote a segment, the new segment is defined as mandatory (with aminimum
use of one). If you want to make the segment conditional, you must change the minimum

use to zero.
Sep Action

1 Click the DTM:27 segment with the right mouse button and select
Properties from the shortcut menu.
System Response
The Segment Properties dialog is displayed.

2 Select the L ooping tab.

3 In the Min Usage box, enter 0 to make this segment conditional .

4 Click OK to exit the Segment Properties dialog.

How to changethe  Usethis procedure to change the DTM:13 segment’s maximum use.
maximum use of
theDTM:13 Sep Action
segment

1 Click the DTM: 13 segment with the right mouse button and select
Properties from the shortcut menu.

System Response
The Segment Properties dialog is displayed.

2 Select the L ooping tab.
3 In the Max Usage box, enter 1.
4 Click OK to exit the Segment Properties dialog.
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How to changethe = The MOA:5 segment (in the LIN group) contains Monetary Amount details used in the
maximum use of EDI data. The standard allows the MOA:5 segment to be used up to five times for each
the MOA:5 lineitem. You expect the MOA:5 segment only once per line item from your trading
segment partner so you need to change the maximum number of times this segment can be used for
each line item to one.

Use this procedure to change the maximum use of the MOA:5 segment.

Sep Action

1 Click the M OA:5 segment with the right mouse button and select
Properties from the shortcut menu.

System Response
The Segment Properties dialog is displayed.

2 Select the L ooping tab.
3 In the Max Usage box, enter 1.
4 Click OK to exit the Segment Properties dialog.

How tocreatea  The CNT segment contains Control Total summary information for the purchase order.
CNT group  Thestandard allows the CNT segment to be used up to 10 timesin a purchase order. You

want to use CNT segment once per purchase order so you need to change the minimum
and maximum use of the CNT segment to one. If the form were generated after changing
the minimum and maximum use of the CNT segment, the total number of lineitemswould
be printed with the BGM fields at the beginning of the purchase order because thefieldsin
the CNT segment would be displayed on the same frame as the fields in the BGM
segment.

For the CNT segment to print the total number of line items at the end of the purchase
order and maintain the integrity of the purchase order, you must create a CNT group with
aminimum use and a maximum use of one, then cut the CNT segment and paste it asa
subordinate to the group you just created. After you move the CNT segment to the new
CNT group that you create, the total number of lineitemsis displayed on its own frame.

Use this procedure to create a CNT group.

Sep Action
1 Select the CNT segment.
2 Select I nsert from the Edit menu.
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(Contd)
Sep Action
3 Select Group from the submenu.
System Response
The Group Properties dialog is displayed.
Group Properties
Mame | Prirt I Looping I Loop Extended Rules I
Flease enter the name
Pleaze enter a short description :
Cancel | el | Help
4 In the Name box, enter CNT_Group as the loop identification code.
I mportant
Do not use spaces or hyphens ( - ) in the Name box. You can use the
underscore ( _ ) to separate words.
5 In the Description box, enter CNT Group to provide a brief explanation
of the loop.
6 Select the L ooping tab.
7 In the Min Usage box, enter 1 to make this group mandatory.
8 Click OK to create the group.

How to cut and Use this procedure to cut and paste the CNT segment.

pastethe CNT
segment Sep Action
1 Select the CNT segment.
2 Click the Cut icon on the Main Toolbar.
3 Click Yes at the prompt.
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Action
4 Select the CNT group, which isthe group to which you want to paste the
CNT segment as a subordinate.
5 Click the Paste button on the Main Toolbar to paste the CNT segment.
6 At the prompt, accept the default to paste the Clipboard contents as a child
(subordinate) of the group and click OK to exit the dialog.

How to changethe  Use this procedure to change the maximum use of the CNT segment to one.
maximum use of
the CNT segment Sep Action

1 Click the CNT segment with the right mouse button and select Properties
from the shortcut menu.

System Response
The Segment Properties dialog is displayed.

2 Select the L ooping tab.
3 In the Max Usage box, enter 1.
4 Click OK to exit the Segment Properties dialog.
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Generating the Form

Overview

Procedure

Forms Integration EDIFACT Tutorial Guide

Generating the Form

Generating aform is different from compiling aform. When you generate a form, the
fields of the form are displayed on a frame in the Layout Window (right side of Forms
main window) based on the groups, segments, and elements that are activated. When you
compile aform, the source form is tranglated into a compiled transl ation object.

Note

You should regenerate (or refresh) the form several times to ensure that you are viewing
the most recent changes to the Layout Window.

Use this procedure to generate the print form based on the groups, segments, and elements

you activated.
Sep Action
1 Select the ORDERS fileicon. Selecting the ORDERSfile icon before you
generate the layout enables you to view the beginning of the purchase
order layout in the Layout Window after the layout is generated. Thisis
not arequired prerequisite to generating the layout.
2 Click the Generate L ayout icon on the Main Toolbar.

System Response
Thelayout of the print form is displayed in the Layout Window.

Z Gentran Forms Integration - [petordp. stp]

Fil= Edit Functionz Yiew Dizplay Options  Window  Help

PleEle| ==5%E S5 [0 0] i
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E @ 01 2005 - M - Stiing 3 -Printed- [
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5
il
il

1 ikn - - 1 ITER DFSTRIPTION _ILI
<| i »

»

Date/Time/PeriDc’_

Payment Terms Tg,'_
Terms Of Payment
Terms Of Payment

SJection Identifi
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For Help, press F1

[
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After generating  After you generate the form, the right side of your screen (Layout Window) will have one
theform field for every activated element on the left side of your screen (EDI File Format
Window). You can click either thefield or its corresponding element to select it. To access
the Field Properties dialog for afield/element, either double-click the element, or use the
right mouse button to click the field or element, then select Properties from the shortcut
menu.

Note

When you first generate the form, each field in the Layout Window is labeled with the
same name as its corresponding element in the EDI File Format Window. Asyou
customize the form, you change and remove some of the labels so not all of the fields are
labeled the same as their corresponding elements. Though you change or remove some
field labels, each field still corresponds to one element.

When the print form is generated, each group and repeating segment has a corresponding
framein the Layout Window that contains al the groups, segments, and elements at that
level. Fieldsin segments that have a maximum use of only one are displayed on the frame
corresponding to the group to which the segments are subordinate.

In print forms, the frames are not titled in the Layout Window. To identify the frame that
currently isdisplayed, click one of the fields on the frame, then check the EDI File Format
Window to determine in which segment or group the field is contained.
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Customize the EDI Data

Overview

Introduction You can customize the form, including the properties of each group, segment, and
element.

Customizing the formis an iterative process. Thistutorial guides you through al the steps
involved in customizing the form, component by component. When you create print
forms, you usually activate the form components you need to use, compile the form, test
it, and print the EDI data using the compiled translation object. Asyou substantially
customize the form, you usually compile and print the form several timesto view your
changes.

This section explains how to customize the form components for each sequential
component.

How to set up the  We recommend that you set up a Document Name for each form. The document name
document name  makesthe identification of a message created by the form easier in Sterling
Gentran: Server. Setting up the document name enables you to differentiate between
messages in the document browsers. We strongly recommend that you select an element
that occurs only once in the message and has a data type of string. For an EDIFACT 92.1
purchase order, the document name usually is the Document/M essage Number.
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Creating a Print Form

Use this procedure to set up the document name.

Step

Action

Double-click the BGM 05 element.

Recommendation
We recommend that you select this element because it is a non-recurring,
mandatory element.

System Response
The Element Properties dialog is displayed.

Element Properties E3

Mame |\-"a|idation| Frint I Extended Hulel Standard Hulel Eonditinnsl

Flease enter the name :
1004

Pleaze enter a short description :
DOCUMENT /MESSAGE NUMBER

QK I Cancel S Help

Select the Sandard Rule tab.

Select Update from the Please select a standard rule to use list.

Click Yes at the prompt.

From the Select the table (or group) to update list, select Document
record to indicate that you are updating the document record.

Sterling Gentran:Server — May 2011
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(Contd)
Sep Action

6 From the Column (or field) to update list, select Document Name to
indicate that you are updating the Name field in the document browsers
with the contents of the BGMO05 element.

System Response
The dialog now should look like this:

Element Properties

Mame I Validationl Print I Extended Rule  Standard Rule | Cnnditionsl

Fleaze zelect the standard rule to use IUpdate j

Fleaze zelect the table [or group] o update
IDncument record j

Fleaze zelect the column [or field) o update

Document Mame

ak I Cancel Sl Help

7 Click OK to set up the document name.
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Customizing the BGM Segment

Overview  The BGM segment is the Beginning of Message segment for the purchase order. This
segment contains information that is pertinent to the entire purchase order.

How to customize  The BGMO05 element (Document/M essage Number) is defined by the standard to be a
theBGMO5  string of thirty-five alphanumeric characters. You know that your trading partner’s
dement purchase order number will be a 10-character string, so you will change the element and
field lengths to accommodate the shorter purchase order number. In addition, you will
renamethefield label.

Use this procedure to change the field and element Iengths and rename the field label for
the Document/M essage Number field.Customizing the BGM06 Element

Sep Action

1 Double-click the BGM 05 element.

System Response
The Element Properties dialog is displayed.

2 Select the Validation tab.

3 In the Max box, enter 10 for the maximum number of characters allowed
for this element.
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Customizing the BGM Segment

(Contd)
Sep

Action

4

Select the Print tab.

System Response
The system displays the Print dialog box.

Element Properties E3

Mame I Walidation  Frint |E>:tended Hulel Standard Hulel Eonditinnsl

W iCheck. here to include this field in the print

Please enter the label far thiz fisld :

ID ocument, M ezzage Number

Pleaze enter the marimum number of characters to be printed : |35

QK I Cancel | S | Help |

In the Label box, enter Order Number: to replace the existing text.

In the Maximum number of charactersto be printed box, enter 10 to
display a 10-character purchase order number on the printout.

Click OK to exit the dialog.

Customizingthe  The BGMO06 element (Message Function, Coded) contains the code from your partner’s

BGM 06 element EDI datarepresenting the type of purchase order (e.g., new order) for this message. You
want the meaningful description of the code to be printed on the printout instead of the
code itself. You need to prevent the Message Function, Coded field from being displayed
(hide it), but use the code from that element (BGM06) to look up the code description in
the Message Function, Coded code list table. You then need to print that description in
another field that you create. The description of the codeis displayed in the new field on
the printout.

Your trading partner has agreed to only send you two types of purchase orders:

» Reguest (Message Function Code 13)

» Change (Message Function Code 4)

Forms Integration EDIFACT Tutorial Guide
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How to copy the  The description of the EDI code in the BGM06 element isimportant, though you do not

BGM 06 element need to print the code itself. For example, the EDI code value 13 is not descriptive enough
for users reading a printout of the purchase order. The description of code 13 (Request) is
meaningful.

Before you can print the description of the EDI code value, you must create anew element
in the BGM segment to store and print the description. The new BGM element is the
element that displays the description of the Message Function, Coded. You use the Copy
and Paste functionsto move EDI information in the form. Copied form components retain
all the information of the original form components.

Use this procedure to copy and paste the BGM06 element.

Sep Action

1 Select the BGM 06 element.

2 Click the Copy button on the Main Toolbar.

3 Select the BGM 07 element, which is the last element in the BGM
segment. The BGMO7 element is the element after which you want the
BGMO06 element to be pasted.

4 Click the Paste button on the Main Toolbar to paste the BGM06 element.
A new element (BGMO08) is created. The BGM08 element is an exact
copy of the BGMO06 element.

How to changethe  The system names the new element created from copying the BGM06 element 1225:2.
BGM 08 element You need to rename the new element to identify its purpose, which isto print the
and field description of the code from the BGMO06 element.

properties e

If asegment or element occurs morethan oncein aform, itisidentified by its name <ID>.
The second and subsequent occurrences are identified by <ID>:n, where n is the number
of the occurrence in the form.

You will increase the element and field lengths of the BGM08 element to accommodate
thelonger description. Also, you will rename thefield label for the newly created BGMO08
element to reflect the contents of the field (the description of the Message Function,
Coded).

Use this procedure to change the element name and length, and change the field label and
field length for the Message Function, Coded field.

Sep Action

1 Double-click the BGM 08 element.

System Response
The Element Properties dialog is displayed.
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How to hidethe
BGMO06 field and
load a codelist
table from the
standard

Customizing the BGM Segment

Action

2 In the Name box, enter 1225 DESC.

3 Select the Validation tab.

4 In the Minimum box, enter O for the minimum number of characters
allowed for this element.

5 In the Maximum box, enter 30 for the maximum number of characters
allowed for this element.

6 Click the Print tab.

7 In the Label box, enter Order Type:.

8 In the Maximum number of characters to print box, enter 30.

9 Click OK to save the new label and to exit the dialog.

Now that you have created an exact copy of the BGMO06 element, you can hide the first
Message Function, Coded field.

When you use code list tables, you load a code list table from the standard to tell the
system which code list table to use in looking up EDI code values. You can load the
specific code values you expect to receive in the EDI data, or you can load the entire code
list table. For thistutorial, you know that your trading partner will send you only these two
types of purchase orders:

» Reqguest (Message Function Code 13)
» Change (Message Function Code 4)

You do not need to load the entire code list table, so you will load only codes 13 and 4
from the code list table.

Use this procedure to hide the Message Function, Coded field and load the code list table
from the standard.

Sep Action

1 Double-click the BGM 06 element, which is the element for which you
need to use a code list table.

System Response
The Element Properties dialog is displayed.

2 Select the Print tab.

3 Clear the Include thisfield in the print check box to turn the option off.
The Message Function, Coded field will not be displayed on the printout.
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(Contd)
Sep Action
4 Select the Sandard Ruletab.
5 Select Use Code from the Please select a standard rule to use list.
6 Click Yes at the prompt.
7 Click Edit to access the Edit Code List dialog.
System Response
The Edit Code List dialog is displayed.
Falit Timle | il
~Table Detair
Table|D 1225 Derc [MESSAGE FUNCTION, CODED
Alovsed Codes
Cade Yalua Daaciplion
Nes... |
Load.. |
The Table ID box contains 1225, the name of the element for which this
code list table is used. The Desc box contains MESSAGE FUNCTION,
CODED, the description of the element for which this code list table is
used.
8 Click L oad to accessthe Load Code List dialog. You are prompted to
select an ODBC data source name. Select the appropriate DSN and click
OK to accessthe Load Code List dialog. The Codes In Standard list
contains the entire code list.
I
it G ok Sipucer
Stendmd | [2] L]
Carsl |
Bekact Codes
Codare In Shadad Codae Selected
P
11 RESFINGE =
12 kDT PRACESEED
1 EOLEST d Al
14 AONCE MOTIFG
15 REMINDOER -
1E_ PROFOSAL [ ||| =l
«[ 1 [+ +[ 1 [+l
9 From the Codes In Standard list, highlight code 13.
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(Contd)
Sep Action

10 Click Add to move it to the Codes Selected list.

11 From the Codes In Standard list, highlight code 4.

12 Click Add to move it to the Codes Selected list.

13 Click OK to load the code list table and exit the Load Code List dialog.

14 Click Closeto exit the Edit Code List dialog.

15 From the Store Field list, select 1225 DESC MESSAGE FUNCTION,
CODED to store the description in the BGMO08 element you created.

The dialog should now should look like this:

Element Properties E

M ame I Validatinnl Fririt I Extended Rule  Standard Rule |E0nditinns|

Please zelact the standard rule bo uze IUse Code j

Please zelact the code list to uze

|'|225 MESSAGE FUNCTION, CODED ﬂ Edit... |

™ Raise a compliance enor if the code is not found in the list

If you would like the description of the code ta be stared in a field, please
zelect that field below :

SSAGE FUMCTION, CODED

QK. I Cancel Lpply Help

16 Click OK to exit the diaog.
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Creating a Print Form

(Contd)
Sep

Action

17

Click the Generate L ayout button on the Main Toolbar to refresh the
display of the print form.

System Response
The header frame now should look like this:

=

Lrder Huwiber: |

Date;/Eime/period fualifise

L]

Dete/b lme/period |

Text Subject Qumlifier

]

Fre= Text |

Peference [ualifler

]

Reference Numbher |

Payweznt Terwa Tspe Qualifier

Terno Of Payrent Identifipstiob

]
L

Terte Of Payment |

Seotipn Identification

Crdsr Type: [

]
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Customizingthe DTM Segment

Overview  The DTM segment (Date/Time/Period) is used to print the order date for the purchase
order. The standard allows the DTM segment to be used up to 35 timesin one purchase
order. In thistutorial, you will usethe DTM segment only once. You have already changed
the maximum use of the DTM segment to obtain just one instance of the DTM segment
and to place the order date on the same frame as the order number.

How to customize  The DTMO1 element (Date/Time/Period Qualifier) is a mandatory element for the
theDTMO01 EDIFACT 92.1 purchase order (ORDERS). You do not need to print the qualifier on the
element printout so you will hide the Date/Time/Period Qualifier field.

Use this procedure to hide the Date/Time/Period Qualifier field.

Sep Action

1 Double-click the DTM 01 €lement.

System Response
The Element Properties dialog is displayed.

2 Click the Print tab.
3 Clear the Include thisfield in the print check box to turn the option off.
4 Click OK to exit the dialog.

How to customize  The DTMO2 element (Date/Time/Period) contains the purchase order date. The standard
theDTMOQ2  alowsthisfield to contain up to a 35-character string, but your trading partner sends you
dement shorter dates. You need to change the element and field lengths to accommodate the
shorter dates, and then rename the field label.

Use this procedure to change the element and field lengths and rename the field label for
the Date/Time/Period field.

Sep Action

1 Double-click the DTM 02 €l ement.

System Response
The Element Properties dialog is displayed.

2 Select the Validation tab.

3 In the Maximum box, enter 8 to alow the entire date, including separators
(/), to be contained in this element.

4 Select the Print tab.
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(Contd)
Sep Action
5 In the Label box, enter Order Date: to replace the existing field |abel.
6 In the Maximum number of charactersto be printed box, enter 8.
7 Click OK to exit the diaog.
8 Click the Generate L ayout button on the Main Toolbar to refresh the

print form display.

System Response
The header frame now should look like this:

rdec Number: |

i+

Crdetr IRTE:

Taut Fubject ualifier

Tres Tadt

Raference gualltier

]

Rarerence Mumbar [

Pagtent Terme Tvpe fualltier

Tarmg O Fayment ISantiTiosclab

[]
L ]

Tarma Of Fayment |

#aprion [denclticacion |:|

order Tgpe: [

+]
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Customizing the FTX Segment

Customizing the FT X Segment

Overview

How to customize
the FTX01 element

How to customize
the FT X06 e ement

Your trading partner sends you messages or notes, so the FTX segment must be present to
receive them. The standard allows the FTX segment to be used up to fivetimesin one
purchase order. In thistutorial, you will use the FTX segment only once. You have already
changed the maximum use of the FTX segment to obtain just one instance of the FTX
segment and to place the note or message on the same frame as the purchase order number
and date.

The FTXO01 element (Text Subject Qualifier) isamandatory element for the FTX segment.
The FTX01 element contains the three-character qualifier from your partner’s EDI datato
indicate what type of free text follows (in thistutorial, AAI for General Information). The
system does not enable you to deactivate this element, because it is a mandatory element.
Because you expect only one qualifier (General Information) in this element, you do not
need to print the qualifier on the report. You will hide the Text Subject Qualifier field.

Use this procedure to hide the Text Subject Qualifier field.

Sep Action

1 Double-click the FT X01 element.

System Response
The Element Properties dialog is displayed.

2 Select the Print tab.
3 Clear the Include thisfield in the print check box.
4 Click OK to exit the diaog.

The FTX06 element (Free Text) is mandatory when the FTX segment is used. The EDI
datain the FTX06 element contains the exact message that should be printed. The
message is self-explanatory so you do not need to print the label for thisfield. You need to
remove thefield label from the form. You also know that your partner sends free text in 60
characters or fewer (70 is the maximum length allowed by the standard for this field) so
you need to change the element and field lengths for the Free Text field.

Use this procedure to remove the field label and change the element and field lengths for
the Free Text field.

Sep Action

1 Double-click the FT X 06 element.

System Response
The Element Properties dialog is displayed.
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(Contd)
Sep

Action

2

Select the Validation tab.

3

In the Maximum box, enter 60 to allow a 60-character string in this

element.

Select the Print tab.

In the Label box, delete the existing field label.

In the Maximum number of charactersto be printed box, enter 60.

Click OK to exit the dialog.

Click Generate Layout on the Main Toolbar to refresh the print form

display.

System Response

The header frame now should look like this;

I+

order Mumber: [

Crder Dace:

Peferenoce Qumlifi=c

[]

Emference Number |

Fayment Teome Type Cualifier

Term=s Of Payment Identification

[]
L ]

Term= Cf Fayment |

Bection Identificatbion I:l

Leder Lype: |

+]
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Customizing the RFF Group

Customizing the RFF Group

Overview

Customizing the
RFF segment

How to customize
the RFFO1 e ement

The RFF segment is a conditional group that specifies the Reference information for the
purchase order. The standard allows this group to be used up to 10 times in one purchase
order. You need to use this group only once in the header of the purchase order (for the
contract number) so you have already changed the maximum use of this group to one. At
the same time, you promoted this group to the parent frame so that the contract number is
displayed on the same frame as the purchase order number and date.

The RFF segment (Reference) contains reference information used in the EDI data. In this
tutorial, you know that the only reference number your partner will send you in the RFF
segment is a contract number that your trading partner uses for their records.

The RFFO1 element (Reference Qualifier) is a mandatory element for the RFF segment.
The RFFO1 element contains the three-character code from your partner’s EDI data to
indicate what type of reference follows. For thistutorial, you know that your trading
partner sends you only one type of reference—the contract number. The system does not
enable you to deactivate this element, because it is a mandatory element. Since you expect
only one qualifier in this element, you do not need to print the qualifier on the report. You
will hide the Reference Qualifier field.

Use this procedure to hide the Reference Qualifier field.

Sep Action

1 Double-click the RFF01 element.

System Response
The Element Properties dialog is displayed.

2 Select the Print tab.
3 Clear the Include thisfield in the print check box.
4 Click OK to exit the diaog.
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How to customize  The RFF02 element contains the Reference Number. This element is defined by the
the RFF02 element standard to be a string of 35 aphanumeric characters. In this tutorial, you know that your
trading partner’s reference number (the contract number) is a 12-character string so you
need to change the field and element |engths to accommodate the reference number that is
shorter than the standard expects. In addition, you need to rename the field |abel.

Use this procedure to change the element and field lengths and to rename the field label
for the Reference Number field.

Sep Action

1 Double-click the RFF02 element.

System Response
The Element Properties dialog is displayed.

2 Select the Validation tab.

3 In the Maximum box, enter 12 to allow a 12-character string in this
element.

4 Select the Print tab.

5 In the Label box, enter Contract No. (note the period in the label) to
replace the existing field |abel.

6 In the Maximum number of charactersto be printed box, enter 12.

7 Click OK to exit the dialog.
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Customizing the RFF Group

(Contd)
Sep

Action

8

Click Generate L ayout on the Main Toolbar.

System Response

The header frame now should look like this:

=

Order Nmwher: |

Crder Iate:

Conteact Moo |

Pasment Terms Type Cuallfice

Terma QL Payment IdentiTicablapn

]
L

Terma Of Payment |

Section Identlficntion |:|

Crder Tepe: [

]
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Customizing the NAD Group

Overview

Customizing the
NAD segment

Customizing the
NADO1 element

How to copy the
NADO1 element

The standard allowsthe NAD group (Name and Address) to be used up to 20 times. In the
NAD group, you have already activated the NAD segment to contain the name and
address of an entity or individual. Your trading partner uses the NAD group to send you
these three types of addresses:

» Party to bebilled (Party Qualifier AA)
» Buyer (Party Qualifier BY)
» Shipto (Party Qudifier ST)

The NAD segment identifies the Name and Address of an entity or individual. The
NADO1 element is a mandatory element in the NAD segment and contains the three-
character qualifier identifying the type of party in the NAD segment.

The NADOL element (Party Qualifier) identifies the type of party in the NAD segment.
For thistutorial, you know that your trading partner sends only these three types of names/
addresses. Party to be billed, Buyer, and Ship to. You want the meaningful description of
the qualifier on the printout instead of the qualifier itself.

To print the description of the EDI code value, you must copy the NADO1 element to

another element in the NAD segment, then use the new NAD element to print the
description of the Party Qualifier code.

Use this procedure to copy and paste the NADO1 element.

Sep Action
1 Select the NADO1 element.
2 Click Copy on the Main Toolbar.
3 Select the NAD22 element, which isthe last element in the NAD segment.
4 Click Paste on the Main Toolbar to paste the new element.
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How to changethe  The system names the new element created from copying the NADOL element 3035:3.
NAD23 element You need to rename the new element to identify its purpose, which isto print the
and field description of the qualifier from the NADO1 element. You need to remove the Mandatory
properties  Statusfrom the NAD23 element to makeit a conditional element (meaning that the
element will be used only if thereis EDI dataavailable for it) and increase the element and
field lengths to accommodate the qualifier’s description.

Use this procedure to change the element name and length, make the element conditional
instead of mandatory, and change the field label and field length for the Party Qualifier

field.

Step

Action

1

Double-click the NAD23 el ement.

System Response
The Element Properties dialog is displayed.

In the Name box, enter 3035 _DESC.

Select the Validation tab.

Clear the Mandatory check box to make the element conditional .

Note
You will not receive an NAD23 element from your trading partner. If you
leave the mandatory status checked, you will receive a compliance error.

Inthe Min box, enter O for the minimum number of characters alowed for
this element.

In the Max box, enter 18 for the maximum number of characters allowed
for this element.

Select the Print tab.

In the Label box, delete the existing field label.

In the Maximum number of charactersto be printed box, enter 18.

10

Click OK to exit the diaog.
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How to hidethe  Now that you have created an exact copy of the NADO1 element, you can hide the first
NADOL1 field and  Party Qualifier field.

loading the code
list tablefrom the  For thistutorial, you know that your trading partner will send you the following types of

standard names and addresses:
» Party tobe billed (Party Qualifier AA)
» Buyer (Party Qualifier BY)
» Shipto (Party Qualifier ST)

You do not need to load the entire code list table; you will load only codes AA, BY, and
ST from the code list table.

Use this procedure to hide the first Party Qualifier field and load the codes from the

standard.
Sep Action

1 Double-click the NADO1 element, which is the element for which you
need to use a code list table.
System Response
The Element Properties dialog is displayed.

2 Select the Print tab.

3 Clear the Includefieldsin the print check box.

4 Select the Standard Rule tab.

5 Select Use Code from the list.

6 Click Yes at the prompt.
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(Contd)
Sep Action
7 Click Edit to access the Edit Code List dialog.
~Tabe Detal
Table (D 2035 Deze [PAATY DUALIFIER
Alowed Codes :
Cade Yausa Craachplion
Newr... |
Laad.. |
Note
The Table ID box contains 3035, the name of the element for which this
code list table will be used. The Desc box contains PARTY QUALIFIER,
the description of the element for which this code list table will be used.
8 Click L oad to accessthe Load Code List dialog. You are prompted to
select an ODBC data source name. Select the appropriate DSN and click
OK to accessthe Load Code List dialog. The Codes In Standard list
contains the entire code list.
| wianl Conles | wvl
riekct Code S oo
Btardard | (2] e
Select Codex
Coder In Stardard Cindez: 5elbctad
Dol
e et s LA
AL PAINDIPAL [ [EEhiames
#] [+ +[ 1 [+]
9 From the Codes In Standard list, highlight code AA.
10 Click Add to move it to the Codes Selected list.
11 From the Codes In Standard list, highlight code BY.
12 Click Add to move it to the Codes Selected list.
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(Contd)
Sep Action

13 From the Codes In Standard list, highlight code ST.

Note

This code list table contains many codes. To access code ST quickly, press
the letter s; the first code that begins with the letter sis highlighted. You
need to scroll through only the list of codes beginning with s, instead of
the entire code list, to access code ST.

14 Click Add to move it to the Codes Selected list.

15 Click OK to load the code list table and exit the Load Code List dialog.

16 Click Closeto exit the Edit Code List dialog.

17 From the Store Field list, select 3035_DESC PARTY QUALIFIER to
store the description in the NAD23 element you created.

System Response
The dialog should now should look like this:

Element Properties

Mame I Validationl Print I Extended Rule  Standard Rule | Cnnditionsl

Fleasze select the standard rule to uge : IUse Code j

Flease select the code list bo uge :

[3025 PARTY QUALIFIER -] Ea |

[" Raize a compliance eror if the code is not found in the list

If pou would like the deszcription of the code to be stored in a field, please
zelact that field below :

Ok I Cancel Spply Help

18 Click OK to exit the dialog.
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How to customize  The NAD10 element (Party Name) contains the exact name that should be printed in the
the NAD1Q  purchase order. The nameis explained by the description of the Party Qualifier so you do
eement not need to print the label associated with the name. The only customizing that is
necessary for the NAD10 element isto remove the field label on the printout.

Use this procedure to hide the Party Name field label.

Sep Action

1 Double-click the NAD10 element.

System Response
The Element Properties dialog is displayed.

2 Select the Print tab.

3 In the Label box, delete the existing text. The party nameis explained by
the description in the Party Qualifier field (NAD23).

4 Click OK to exit the dialog.

How to customize  The NAD16 element contains the Street and Number/P.O. Box, which identifies the street
the NAD16  nameand number, suite number, or any other addressinformation that your trading partner
eement sends you. The NAD16 element contains the exact address information that should be
printed. The address information corresponds to the name that is printed from the NAD10
element. Thereis no need to print the label associated with the address so you need to
remove the field label for the NAD16 element.

Use this procedure to hide the field label for the first Street and Number/P.O. Box field.

Sep Action

1 Double-click the NAD16 element.

System Response
The Element Properties dialog is displayed.

2 Select the Print tab.
3 In the Label box, delete the existing text.
4 Click OK to exit the dialog.
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How to customize  The NAD17 element contains the second Street and Number/P.O. Box line, which (like
theNAD17  the NAD16 element) identifies the street name and number, suite number, or any other
eement address information that your trading partner sends you. The NAD17 element contains the
exact address information that should be printed. The address information corresponds to
the name that is printed from the NAD10 element. There is no need to print the label
associated with the address, so you need to remove the field label for the NAD17 element.

Use this procedure to remove the field Iabel for the second Street and Number/P.O. Box

field.
Sep Action

1 Double-click the NAD17 element.
System Response
The Element Properties dialog is displayed.

2 Select the Print tab.

3 In the Label box, delete the existing text.

4 Click OK to exit the dialog.

How to customize  The NAD19 element contains the City Name. There is no need to print the field label
the NAD19  associated with this element, because it will be evident on the printout that al the name
dement and address information are associated. Therefore, you will remove the field label for the
NAD19 element. Also, you must change the element and field lengths because you do not
need the City Name field to be longer than 30 characters.

Use this procedure to change the element and field lengths and remove the City Name

field label.
Sep Action

1 Double-click the NAD19 element.
System Response
The Element Properties dialog is displayed.

2 Select the Validation tab.

3 In the Maximum box, enter 30 to allow a 30-character string in this
element.

4 Select the Print tab.

5 In the Label box, delete the existing text.

6 In the Maximum number of characters to be printed box, enter 30 to
display a 30-character city name on the printout.

7 Click OK to exit the diaog.
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How to customize  The NAD20 element contains the Country Sub-Entity Identification. You do not need to
the NAD20  print thefield label associated with this element, because it is evident on the printout that
eement all the name and address information are associated. You must remove the field label for
the NAD20 element and change the element and field lengths because your partner sends
a Country Sub-Entity Identification that is abbreviated to no more than two characters.

Use this procedure to change the element and field lengths and remove the Country Sub-
Entity Identification field label.

Sep Action

1 Double-click the NAD20 element.
System Response
The Element Properties dialog is displayed.

2 Select the Validation tab.

3 In the Maximum box, enter 2 to allow atwo-character string in this
element.

4 Select the Print tab.

5 In the Label box, delete the existing text.

6 In the Maximum number of charactersto be printed box, enter 2.

7 Click OK to exit the dialog.

How to customize  The NAD21 element contains the Postcode I dentification. You do not need to print the
theNAD21  field label associated with this element, because it is evident on the printout that all the
dement name and address information are associated. You need to remove the field Iabel for the
NAD21 element.

Use this procedure to remove the Postcode |dentification field |abel.

Sep Action

1 Double-click the NAD21 el ement.

System Response
The Element Properties dialog is displayed.

2 Select the Print tab.
3 In the Label box, delete the existing text.
4 Click OK to exit the dialog.
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Action

5 Click Generate Layout on the Main Toolbar to refresh the print form
display.

System Response
The Name and Address (NAD) frame now should look like this:

Ll
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Customizing the PAT Group

Customizing the PAT Group

Overview

Customizing the
PAT segment

Customizing the
PATO1 element

How to copy the
PATO1 element

The PAT group is a conditional group that specifies the Payment Terms for the purchase
order. The standard allows this group to be used up to 10 timesin one purchase order. You
need to use this group only once in the header of the purchase order so you changed the
maximum use of this group to one. At the same time, you promoted this group to the
parent frame so that the payment terms are displayed on the same frame as the purchase
order number and date (the header frame).

The PAT segment is a conditional segment in the PAT group that specifies the Payment
Terms Basis for the purchase order.You have aready activated the PAT05 element for the
Terms of Payment. The mandatory elements PATO1 (Payment Terms Type Qualifier) and
PATO2 (Terms of Payment Identification) also are activated.

The PATOL element is a mandatory element that contains the Payment Terms Type
Quialifier, athree-character code that identifies the terms under which this purchase order
isvalid. You need to hide the PATO1 element and print the more meaningful description of
the code in a new element that you create.

You know that your trading partner only sends you purchase orders with these terms:
» Previously Agreed Upon (Payment Terms Type Qualifier 18)
» Instant (Payment Terms Type Qualifier 10)

To print the description of an EDI code value, you must copy the PATO1 element to a new

element in the PAT segment, then use the new PAT element to print the description of the
Payment Terms Type Qualifier.

Use this procedure to copy and paste the PATO1 el ement.

Sep Action
1 Select the PAT 01 element.
2 Click Copy on the Main Toolbar.
3 Select the PAT 06 element, which isthe last element in the C110

compositein the PAT segment.

4 Click Paste on the Main Tool bar to paste the new element. A new element
(PATQ7) is created, which is an exact copy of the PATO1 element.
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How to changethe
PATO7 element
and field
properties

How to hidethe
PATO1 field and
load the code list
table from the
standard

The system names the new element created from copying the PATO7 element 4279:2. You
need to rename the new element to identify its purpose, which isto print the description of
the code from the PATO1 element. Also, you need to increase the element and field lengths
to accommaodate the longer description.

Use this procedure to change the element name and length and to change the field label
and length for the Payment Terms Type Qualifier field.

Sep Action

1 Double-click the PAT 07 element.

System Response
The Element Properties dialog is displayed.

2 In the Name box, enter 4279 DESC to give the name a more descriptive
identifier than its current name.

3 Select the Validation tab.

4 Clear the Mandatory check box to make the element conditional .
5 In the Minimum box, enter O.

6 In the Maximum box, enter 30.

7 Select the Print tab.

8 In the Label box, delete the existing text.

9 In the Maximum number of charactersto be printed box, enter 30.

10 Click OK to exit the dialog.

Now that you have created an exact copy of the PATO1 element, you can hide the first
Payment Terms Type Qualifier field.

You know that your trading partner only sends purchase orders with these two term types:
» Previously agreed upon (Payment Terms Type Qualifier 18)
» Instant (Payment Terms Type Qualifier 10)

You do not need to load the entire code list table so load only codes 18 and 10 from the
codelist table.
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Use this procedure to hide the first Terms Type Code field and |oad the codes from the

standard.

Step

Action

1

Double-click the PATO01 element, which is the element for which you

need to use acode list table.

System Response

The Element Properties dialog is displayed.

Select the Print tab.

Clear the Include thisfield in the print check box.

Select Sandard Ruletab.

Select Use Code option.

Click Yes at the prompt.

Click Edit to access the Edit Code List dialog.

System Response
The Edit Code List dialog is displayed.

rTable Detal
Tablke 1D |42T9 [ere IPA‘('HENT TERMS TYRE QUALIFER
Alowed Codes |
CaodeWaus Drazchplion
New... |

Note

The Table ID box contains 4279, the name of the element for which this
code list table is used. The Desc box contains PAYMENT TERMS TY PE
QUALIFIER, the description of the element for which this code list table

is used.
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(Contd)
Sep Action
8 Click L oad to accessthe Load Code List dialog.
System Response
You are prompted to select an ODBC data source name. Select the
appropriate DSN and click OK to accessthe Load Code List dialog. The
Codes In Standard list contains the entire code list.
| o]l Conales | asl
rSekct Code Sourcer —
Btadard [2] v |
Sekect Codex
Cadex I Standand Codes Seected
N
I
15 WOTYET DEAMED[S] | t=Famene
# [+ <[ 1 [+]
9 From the Codes In Standard list, highlight code 10.
10 Click Add to moveit to the Codes Selected list.
11 From the Codes In Standard list, highlight code 18.
12 Click Add to move it to the Codes Selected list.
13 Click OK to load the code list table and exit the Load Code List dialog.
14 Click Closeto exit the Edit Code List dialog.
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(Contd)
Sep

Action

15

Fromthe Store Field list, select 4279 DESC PAYMENT TERMSTYPE
QUALIFIER to store the code in the PATO7 element you created.

System Response
The dialog should now should look like this:

Element Properties E3

Mame I Validatinnl Frint I Extended Rule  Standard Rule |E0nditinns|

Please select the standard rule to uze IUse Code j

Please select the code list to uze

|42?9 FPayMENT TERMS TYPE QUALIFIER j Edit... |

[™ Raize a compliance erar if the code is not found in the list

I pou wwould like the description of the code to be stored in a field, please
zelect that field below :

AYMENT TERMS TvPE QUALIFIER

QK I Cancel S Help

16

Click OK to exit the dialog.

How to customize  The PAT02 element (Terms of Payment | dentification) isamandatory element for the PAT
the PAT02 element segment. You do not need to print the identification on the printout so you will hide the
Terms of Payment Identification field.

Use this procedure to hide the Terms of Payment Identification field.

Step

Action

1

Double-click the PAT02 element.

System Response
The Element Properties dialog is displayed.

Select the Print tab.

Clear the Includefieldsin the print check box.

Click OK to exit the dialog.
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How to customize  The PAT05 element contains the exact terms of payment for the purchase order. The terms
the PAT05 e ement are explained by the description of the Payment Terms Type Qualifier so thereis no need
to print the label associated with the terms of payment. You need remove thefield label for

the PAT05 element on the printout.

Use this procedure to remove the Terms of Payment field label.

Sep Action

1 Double-click the PAT 05 element.

System Response
The Element Properties dialog is displayed.

2 Select the Print tab.

3 In the Label box, delete the existing field label.

4 Click OK to exit the diaog.

5 (Cj:_lic:< Generate Layout on the Main Toolbar to refresh the print form
isplay.

System Response
The header frame now should look like this:

=

Lrder Hwiber: |

Crder Date:

Contract Ho.

Section Identification |:|

Crder Type: [

]
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Customizing the LIN Group

Customizing the LIN Group

Overview

Before and after
examples

The standard allows the LIN group to be used up to 200,000 times, containing up to
200,000 lineitemsin one purchase order. You have already activated these segmentsin the
LIN group: LIN, PIA, IMD:2, MEA:3, QTY:3, DTM:13, and MOA:5. Also, you have
already promoted the DTM:13 segment in the LIN group to create the DTM:27 segment.

These examples describe how your form looks before and after the customization process.

Example 1: Before Customization
Before you customize the segments and elements in the LIN group, the fields in the form
are arranged with onefield on aline, like the following:

+
Liwe LCtem Muner I:l 1

Produst Id Foretion Cumlifier |:|

Item Wunbher |

Item Deacrcipklon |

Hepmursvant Applioatics Qusllfise l:l

Aepsures TInit Qualifier l:l

Mepaurement Falus | |

CuerElty Cuslltise |:|

L —

Dabed/timedper Lad Dualifler |:|

akedtimefper Lad [

Pabe/timesperlod Dualifler |:|

DAL/t imer per Lad [

Monetary Amount Type duslifier |:|

Monebal ¥ AOUDt [ |

1

If the frame were not customized and formatted differently, each set of fields would be
repeated for each item ordered. A more efficient and traditional way of listing itemson a
purchase order isto arrange the related information in columns so all the related
information for oneitem islisted on one or two lines. The column headings are printed
only once.

Example 2: After Customization
The following figure shows how you ultimately want the fieldsin the LIN group to be
arranged (after customizing and then formatting the fields).

line= Code [l 34 Proice Pequested Zhip HNo =
No. Frod IT Traem dred Unit Emch Ship D=kte La=rc |
I | L1 1 O | | | |

]
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Customizingthe  TheLIN segment (in the LIN group) containsthe Line Item details for the items on the
LIN segment purchase order. Information in the LIN segment pertains to each line item on the purchase
order and not to the entire purchase order.

How to customize  The LINO1 element contains the Line Item Number for one item on the purchase order.
the LINO1 element You need to rename the field label to reflect the new label that you and your trading
partner have agreed to use. You and your trading partner have agreed that the line items
per purchase order will not exceed 99,999. Since each line item is numbered sequentially,
starting with one, you need a maximum length of only five digitsfor thisfield. Therefore,
you need to change the maximum length for thisfield.

Use this procedure to change the element and field lengths and rename the field label for
the Line Item Number field.

Step

Action

1

Double-click the LINO1 element.

System Response
The Element Properties dialog is displayed.

Select the Validation tab.

In the Maximum box, enter 5.

Select the Print tab.

In the Label box, enter Lineto replace the existing field label.

Note

Thelabel for the Line Item Number field ultimately will form the column
heading Line No. To make the width of the column heading as narrow as
possible, you will place Line on one line and No. below. The Label field
does not enable you to enter alabel on more than one line, so you will
enter Linein the Label box, then add No. by adding static text later in this
tutorial. (Static text istext that is always printed or displayed when the
form isused, and that is not defined in the field properties of the element.)

In the Maximum number of charactersto be printed box, enter 5.

Click OK to exit the dialog.
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Customizingthe  ThePIA segment in the LIN group contains the Additional Product ID details for the
PIA segment items on the purchase order. Information in the PIA segment pertains to each line item on
the purchase order and not to the entire purchase order. The standard allows the PIA
segment to be used up to 25 times for each line item, but you need the PIA segment to be
used only once for each line item. You have already changed the maximum use of the PIA
segment to one.

How to customize  The PIAOL element is a mandatory element that contains the Product ID Function
the PIAO1 e ement Qualifier for each item on the purchase order. For brevity on the printout, you will rename
the field label.

Use this procedure to rename the field label for the Product ID Function Qualifier field.

Sep Action

1 Double-click the PIA0O1 element.

System Response
The Element Properties dialog is displayed.

2 Select the Print tab.
3 In the Label box, enter Code to replace the existing field |abel.
Note

Thelabel for the Product ID Function Qualifier field ultimately will form
the column heading Code Type. To make the width of the column heading
as harrow as possible, you will place Code on one line and Type below.
The Label field does not enable you to enter alabel on more than oneline,
so you will enter Codein the Label box, then add Type by adding static
text later in this tutorial.

4 Click OK to exit the dialog.

How to customize  The PIAO2 element contains the Item Number for one item on the purchase order. You
the PIAQ2 element need to rename the field label to more accurately identify thisfield for you and your
trading partner. The standard allows up to a 35-character string in thisfield. Your trading
partner uses product identification numbers that are no longer than 10 characters so you
need to change the maximum length for thisfield to ten.

Use this procedure to change the element and field lengths and rename the field label for
the Item Number field.

Sep Action

1 Double-click the PIA02 el ement.

System Response
The Element Properties dialog is displayed.

2 Select the Validation tab.
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Action

3 In the Maximum box, enter 10 to allow a 10-character string for the
product identification number in this element.

4 Select the Print tab.

5 In the Label box, enter Prod I D to replace the existing field label.
6 In the Maximum number of characters to be printed box, enter 10.
7 Click OK to exit the dialog.

Customizingthe  ThelMD:2 segment (in the LIN group) contains the Item Description for the items on the
IMD:2 segment purchase order. Information in the IMD:2 segment pertains to each line item on the
purchase order and not to the entire purchase order. The standard allows the IMD:2
segment to be used up to 10 times for each line item, but you need the IMD:2 segment to
be used only once for each line item. You have already changed the maximum use of the
IMD:2 segment to one.

How to customize  TheIMD:206 element contains the Item Description for the purchase order item. The
the IMD:206 description is self-explanatory so there is no need to print the field label associated with
dement the description.

Use this procedure to remove the Item Description field label.

Sep Action

1 Double-click the IMD:206 element.

System Response
The Element Properties dialog is displayed.

2 Select the Print tab.
3 In the Label box, delete the existing field label.
4 Click OK to exit the dialog.
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Customizing the
MEA:3 segment

How to customize
the MEA:301
element

How to customize
the MEA:305
element

Customizing the LIN Group

The MEA:3 segment (in the LIN group) contains the Measurements for the items on the
purchase order. Information in the MEA:3 segment pertainsto each line item on the
purchase order and not to the entire purchase order. The standard allows the MEA:3
segment to be used up to five timesfor each line item, but you need the MEA:3 segment to
be used only once for each line item. You have already changed the maximum use of the
MEA:3 segment to one.

The MEA:301 element isamandatory element that contains the M easurement Application
Qualifier for each item on the purchase order. This element must be present in the
purchase order, but you do not need this qualifier to be printed.

Use this procedure to hide the Measurement Application Qualifier field.

Sep Action

1 Double-click the M EA:301 element.

System Response
The Element Properties dialog is displayed.

2 Select the Print tab.
3 Clear the Includefield in the print check box.
4 Click OK to exit the dialog.

The MEA:305 element is a mandatory element that contains the Measure Unit Qualifier
for each item on the purchase order. This element must be present in the purchase order.
You do not need this qualifier to be printed on the printout so you need to prevent thisfield
from being displayed on the printout.

Use this procedure to hide the Measure Unit Qualifier field.

Sep Action

1 Double-click the M EA:305 element.

System Response
The Element Properties dialog is displayed.

2 Select the Print tab.
3 Clear the Includefield in the print check box.
4 Click OK to exit the Display Properties dialog.
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How to customize  The MEA:306 element contains the M easurement Value for each item on the purchase
the MEA:306  order. For brevity, you will rename the field label. The standard allows up to an 18-digit
eement number in thisfield. You expect a number no longer than two digits from your trading

partner so you need to change the maximum length for this field accordingly. Also, the
screen format and EDI format of the data currently use the number format R9, which
indicates a number with an explicit decimal point and up to nine decimal places. You do
not expect any decimal places from your partner’s data, so you need to change the screen
format and EDI format to RO, which indicates anumber with an explicit decimal point and
no decimal places.

Use this procedure to rename the field label, change the screen and EDI formats, and
change the element and field lengths for the Measurement Value field.

Sep Action

1 Double-click the M EA:306 element.

System Response
The Element Properties dialog is displayed.

2 Select the Validation tab.
3 In the Maximum box, enter 2 to allow atwo-digit number in this element.
4 From the Format of the datain the form list, select RO to allow a number

with an explicit decimal point and no decimal places to be displayed on
the printout.

5 Click Yes at the prompt.

6 From the Format of the data of thefilelist, select RO to indicate that you
expect anumber with an explicit decimal point and no decimal places.

7 Click Yes at the prompt.

8 Select the Print tab.

9 In the Label box, enter Unit to replace the existing field label.

10 In the Maximum number of charactersto be printed box, enter 2.

11 Click OK to exit the dialog.
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Customizingthe  The QTY:3 segment in the LIN group contains the Quantity details for the items on the
QTY:3 segment purchase order. Information in the QTY:3 segment pertains to each line item on the
purchase order and not to the entire purchase order. The standard allows the QTY:3
segment to be used up to 10 times for each line item but you need the QTY:3 segment to
be used only once for each line item. You have aready changed the maximum use of the
QTY:3 segment to one.

How to customize  The QTY:301 element is a mandatory element that contains the Quantity Qualifier for
theQTY:301  eachitem on the purchase order. This element must be present in the purchase order, but
dement  You do not need this qualifier to be printed so you need to prevent this field from being
displayed on the printout.

Use this procedure to hide the Quantity Qualifier field.

Sep Action

1 Double-click the QTY:301 element.

System Response
The Element Properties dialog is displayed.

2 Select the Print tab.
3 Clear the Includefieldsin the the print check box.
4 Click OK to exit the dialog.

How to customize  The QTY:302 element contains the Quantity for one item on the purchase order. You need
theQTY:302  toabbreviatethefield label onthe printout. The standard allows up to a 15-digit number in
dement thisfield. You know that your trading partner will order no more than 99,999 (afive-digit
number) of any one item so you need to change the maximum length to six for thisfield
(to accommaodate a five-digit number and a place separator) and change the value in the
Screen Format and EDI Format lists to NO, which indicates a number with an implied
decimal point and no decimal places.

Use this procedure to change the element and field lengths, rename the field label, and
change the screen and EDI formats for the Quantity field.

Sep Action

1 Double-click the QTY:302 element.

System Response
The Element Properties dialog is displayed.

2 Select the Validation tab.

3 In the Maximum box, enter 6 to allow afive-digit number with a place
separator in this element.
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Action

4 From the Format of the datain the form list, select NO to allow a number
with an implicit decimal point and no decimal places to be displayed on
the printout.

5 From the Format of the data of thefilelist, select NO to indicate that you
expect anumber with an implicit decimal point and no decimal places.

6 Select the Print tab.

7 In the Label box, enter Qty.

8 In the Maximum number of charactersto be printed box, enter 6.

9 Click OK to exit the diaog.

Customizingthe  The DTM:27 segment (in the LIN group) is used to print the required shipment date. To
DTM:27 segment ensure that Sterling Gentran: Server prints the correct date in the Date/Time/Period field,
you must usethe key field function. The key field function enables you to specify asecond
qualification in selecting a segment (the segment name is the first qualification). Data
must be provided in the order designated through the use of key fields. For example, for
thistutorial, you expect the required shipment date (DTM:27) first, and then the last
delivery date (DTM:13).

Note

The dates printed in the DTM:27 and DTM:13 segments can be set up using key fields
because you expect the dates in a particular order. If the dates were sent in a different
order, only one date would be printed. If you were not sure of the order in which your
partner will send the dates, you could not use key fields. You would need to use three
DTM segments (using the promote function), and two of those DTM segments would
need to be identical.

When the Date/Time/Period Qualifier field contains the value 10 (required shipment date),
the date is printed in the Date/Time/Period field of the DTM:27 segment. If the Date/
Time/Period Qualifier field contains the value 128 (last delivery date), then the date is
printed in the Date/Time/Period field of the DTM:13 segment.
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How to use a key Use this procedure to use akey field for the DTM:27 segment.

field for the

DTM:27 segment
Sep

Action

Click the DTM:27 segment with the right mouse button and select
Properties from the shortcut menu.

System Response
The Segment Properties dialog is displayed.

EDI Segment Properties
Mame |S|:|ecia|| Ky FieIdI Prirt I Loopingl

Flease enter the name

Please enter a short description :
DATESTIME/PERIOD

ak I Cancel Sl Help

Select the Key Field tab.

From the Field list, select 2005:3 DATE/TIME/PERIOD QUALIFIER.

Click Edit to access the Map Constants dial og.

System Response
The Map Constants dialog is displayed.

Click New to display the Edit Constant dialog.

System Response
The Edit Constant dialog is displayed.

Edit Constant

I} Tupe

| | [

Walue Cancel
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(Contd)
Sep Action
6 Inthe 1D box, enter Shipment date/time, req to identify the uniqueliteral
constant.
7 From the Typelist, select String.
8 In the Value box, enter 10 to identify the actual value of the constant.
9 Click OK to exit the Edit Constant dialog.

10 Click Closeto exit the Map Constants dialog.

11 From the Use constant list, select 10 to indicate to the system that this date
isthe required shipment date.

12 Click OK to exit the dialog.

How to customize  The DTM:2701 element (in the DTM:27 segment) contains the Date/Time/Period
theDTM:2701  Quadlifier for the date in the DTM:2702 element. Your trading partner sends two types of
dement dates: the required shipment date and the last delivery date (in that order). You used the
key field function for the DTM:27 segment to indicate to Sterling Gentran: Server that only
the required shipment date are printed in the Date/Time/Period field (DTM:2702) so you
can prevent the quaifier (DTM:2701) from being printed. The last delivery date is printed
in the Date/Time/Period field for the DTM:13 segment.

Use this procedure to hide the Date/Time/Period Qualifier field.

Sep Action

1 Double-click the DTM:2701 element.

System Response
The Element Properties dialog is displayed.

2 Select the Print tab.
3 Clear the Includefield in the print check box.
4 Click OK to exit the dialog.
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How to customize  The DTM:2702 element contains the Date/Time/Period corresponding to the date qualifier
theDTM:2702  inthe DTM:2701 element. The DTM:2702 element is used to designate when the
dement shipment is required.

In this section of the tutorial, you need to rename the label for thisfield (the new labdl is
named Requested). You need to add the words Ship Date using static text. Static text is
text that is always printed when the formis used. It is not defined in the field properties of
the element so that Ship Date is displayed on the line below Requested. Thefull field label
is Requested Ship Date.

Use this procedure to change the element and field lengths and rename the field label for
the first Date/Time/Period field.

Sep

Action

1

Double-click the DTM:2702 el ement.

System Response
The Element Properties dialog is displayed.

Select the Validation tab.

In the Maximum box, enter 8 to allow the entire date, including separators
(/), in this element.

Select the Print tab.

In the Label box, enter Requested to replace the existing field label.

Note
You will enter Ship Date on a separate line later in this tutorial.

In the Maximum number of characters to be printed box, enter 8.

Click OK to exit the dialog.
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Customizingthe  The DTM:13 segment (in the LIN group) is used to print the last delivery date (the latest
DTM: 13 segment date the order may be delivered). To ensure that Sterling Gentran: Server prints the correct
date in the Date/Time/Period field, you must use the key field function. The key field
function enables you to specify a second qualification in selecting a segment. The segment
nameisthe first qualification. Data must be provided in the order designated through the
use of key fields. For example, for thistutorial, you expect the required shipment date
(DTM:27) first, and then the last delivery date (DTM:13).

For thistutoria, if the Date/Time/Period Qualifier field contains the value 10 (required
shipment date), then the date is printed in the Date/Time/Period field of the DTM:27
segment. If the Date/Time/Period Qualifier field contains the value 128 (last delivery
date), then the dateis printed in the Date/Time/Period field of the DTM:13 segment.

How touseaKey  Usethisprocedureto use akey field for the DTM:13 segment.
Field for the
DTM:13 segment

Sep Action

1 Click the DTM: 13 segment with the right mouse button and select
Properties from the shortcut menu.

System Response
The Segment Properties dialog is displayed.

2 Select the Key Field tab.

3 From the Field list, select 2005 DATE/TIME/PERIOD QUALIFIER.
4 Verify that the Use constant option is selected.

5 Click Edit to display the Map Constants dialog.

System Response
The Map Constants Properties dialog is displayed.

6 Click New to display the Edit Constant dialog.

7 In the ID box, enter Delivery date/time, last.

8 From the Typelist, select Sring.

9 In the Value box, enter 128 to identify the actual value of the constant.

10 Click OK to exit the Edit Constant diaog.

11 Click Close to exit the Map Constants dial og.

12 From the Use constant list, select 128 to indicate to the system that this
dateisthelast delivery date.

13 Click OK to exit the Key Field dialog.
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How to customize  The DTM:1301 element (in the DTM:13 segment) contains the Date/Time/Period
theDTM:1301  Quadlifier for the date in the DTM:1302 element. Your trading partner sends you two types
eement of dates: the required shipment date and the last delivery date (in that order). You used the
key field function for the DTM:13 segment to indicate to Sterling Gentran: Server that the
last delivery date is printed in the Date/Time/Period field (DTM:1302). The DTM:1301
element must be present, but you can prevent thisfield from being displayed, since the
meaningful information for a printout is the date itself.

Use this procedure to hide the second Date/Time/Period Qualifier field.

Sep Action

1 Double-click the DTM:1301 e ement.

System Response
The Element Properties dialog is displayed.

2 Select the Print tab.
3 Clear the Includefieldsin the print check box.
4 Click OK to exit the diaog.

How to customize  The DTM:1302 element contains the Date/Time/Period corresponding to the date qualifier
theDTM:1302 inthe DTM:1301 element.The DTM:1302 element is used to designate the last delivery
dement date that shipments can be shipped.

You need to rename the label for this field (the new label will be named Ship No). You
need to add Later further in this tutorial using static text so that Later is displayed on the
line below Ship No. The full field Iabel will be Ship No Later.

Use this procedure to change the field and element lengths and rename the field label for
the second Date/Time/Period field.

Sep Action

1 Double-click the DT M :1302 e ement.

System Response
The Element Properties dialog is displayed.

2 Select the Validation tab.

3 In the Maximum box, enter 8 to alow the entire date, including separators
(), in this element.

4 Select the Print tab.
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Customizing the
MOA:5 segment

How to customize
the M OA:501
element

Action

5 In the Label box, enter Ship No to replace the existing field label.

Note
You will enter Ship No on a separate line later in this tutorial.

6 In the Maximum number of characters to be printed box, enter 8.

7 Click OK to exit the dialog.

The MOA:5 segment contains the Monetary Amount for the items on the purchase order.
Information in the MOA:5 segment pertains to each line item on the purchase order, and
not to the entire purchase order. The standard allows the MOA:5 segment to be used up to
five timesfor each line item but you need the MOA:5 segment to be used only once for
each lineitem. You have aready changed the maximum use of the MOA:5 segment to
one.

The MOA:501 element is a mandatory element that contains the Monetary Amount Type
Quialifier for the purchase order. This element must be present in the purchase order when
the MOA:5 segment is activated. You do not need this qualifier to be printed on the
printout. You must prevent this field from being displayed on the printout.

Use this procedure to hide the Monetary Amount Type Qualifier field.

Sep Action

1 Double-click the M OA:501 element.

System Response
The Element Properties dialog is displayed.

2 Select the Print tab.
3 Clear the Includefieldsin the print check box.
4 Click OK to exit the dialog.
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How to customize  The MOA:502 element contains the Monetary Amount for the purchase order. You need to
the MOA:502 renamethefieldlabel on the printout. The standard allows up to 18 digitsin thisfield. You
dement know that your trading partner orders items totaling no more than $999,999 (a six-digit
number), so you need to change the maximum length to eight for thisfield (to
accommodate a six-digit number, a place separator, and a plus or minus sign) and change
the valuein the Screen Format and EDI Format lists to R2, which indicates a number with
an explicit decimal point and two decimal places.

Use this procedure to change the element and field lengths, rename the field label, and
change the screen and EDI formats for the Monetary Amount field.

Sep Action

1 Double-click the M OA:502 element.
System Response
The Element Properties dialog is displayed.

2 Select the Validation tab.

3 In the Maximum box, enter 8.

4 From the Format of the datain the form list, select R2.

5 From the Format of the datain thefilelist, select R2 to indicate that you
expect anumber with an explicit decimal point and up to two decimal
places.

6 Select the Print tab.

7 In the Label box, enter Price.

8 In the Maximum number of characters to be printed box, enter 8.

9 Click OK to exit the dialog.
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Creating a Print Form

(Contd)
Sep

Action

10

Click Generate Layout on the Main Toolbar to refresh the print form

display.

System Response

The Line Item (LIN) frame now should look like this:

e - i
caae |:|
Trod LD [

|
Rl [
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Irloc |
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Customizing the UNS Segment

Overview  The UNS segment is a mandatory segment that contains the Section Control summary
information for the purchase order. This segment identifies summary information that is
pertinent to the entire purchase order.

How to customize  The UNSO1 element is a mandatory element that contains the Section I dentification for
the UNSO1 dement the purchase order. This element must be present in the purchase order, but you do not
need thisfield to be printed on the printout.

Use this procedure to hide the Section Identification field.

Sep Action

1 Double-click the UNSO1 element.

System Response
The Element Properties dialog is displayed.

2 Select the Print tab.

3 Clear the Includefieldsin the print check box.
4 Click OK to exit the dialog.

5 Click Generate Layout on the Main Toolbar.

System Response
The header frame now should look like this;

=

Crder Numher: |

Order Omta:

Contrmct Mo.

order Tpe: [

*]
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Customizing the CNT Segment

Overview  The CNT segment (in the CNT group) contains the Control Total summary information
for the purchase order. This segment identifies summary information that is pertinent to
the entire purchase order. You expect to use this segment only once, so you have aready
changed the maximum use of the CNT segment to one.

How to customize  The CNTO1 element is a mandatory element that contains the Control Qualifier for the
the CNTO1 purchase order. This element must be present in the purchase order when the CNT
dement segment is used.You do not need this qualifier to be printed so you need to prevent this
field from being displayed on the printout.

Use this procedure to hide the Control Qualifier field.

Sep Action

1 Double-click the CNTO1 element.

System Response
The Element Properties dialog is displayed.

2 Select the Print tab.
3 Clear the Include thisfield in the print check box.
4 Click OK to exit the dialog.

How to customize  The CNTO02 element contains the Control Value (the total number of line items) for the
theCNT02  purchase order. You need to rename the field label on the printout to more clearly identify
dement the contents of the field. The standard allows up to an 18-digit number in thisfield. You
know that your trading partner will order no more than 99,999 (afive-digit number) items
so you will change the maximum length to six for thisfield. You also need to change the
valuein the Screen Format and EDI Format lists to NO, which indicates a number with an
implicit decimal point and no decimal places.

Use this procedure to change the element and field lengths, rename the field label, and
change the screen and EDI formats for the Control Value field.

Sep Action

1 Double-click the CNT02 element.

System Response
The Element Properties dialog is displayed.

2 Select the Validation tab.
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(Contd)
Sep Action
3 In the Maximum box, enter 6 for the maximum number of digits allowed
for this element.
4 From the Format of the datain the form list, select NO.
5 From the Format of the datain the filelist, select NO.
6 Select the Print tab.
7 In the Labd box, enter Number of Line ltems.
8 In the Maximum number of charactersto be printed box, enter 6 to allow
five digits and a place separator on the printout.
9 Click OK to exit the dialog.
10 Click Generate L ayout on the Main Toolbar.
System Response
The Control Total (CNT) frame now should look like this:
[¢]
furber of Line Jtem= B
11 Click Save from the File menu to save the form.

Now you are ready to format the fields and their labels to make the fields on the purchase
order more consistent and visualy attractive.
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Format the Print Form

Overview

Introduction In the previous section of thistutorial, you customized the print form for an EDIFACT
92.1 purchase order (ORDERS) that you will use to print the data you receive from Pet
Zone. After successfully customizing the fields and elements of the print form, you are
ready to format the layout of the form.

One form can consist of severa frames. Each group and repeating segment has a
corresponding frame that contains all the groups, segments, and elements at that level.
When the form is printed, the frames are printed consecutively, in the order in which they
occur in the form. Each frame is not printed on a separate page.

This section explains how to format the form, field by field.
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Resizing the Header Frame

Resizing the Header Frame

Overview  When aprintout is produced based on the customized print form, the information is
arranged according to how the frames and the fields contained on them were arranged
when the form was compiled. You should eliminate unnecessary space as you arrange the
fields on each frame.

Procedure  Usethisprocedureto resize the header frame (containing fields from the BGM, DTM, and
FTX segments, and the RFF and PAT groups).

Step

Action

1

Click the BGM segment to display the Beginning of Message (header)
framein the Layout Window.

To display more of the form on your screen, click and drag the center bar
between the EDI File Format Window and the Layout Window to the left
until the Layout Window iswide enough to display as much of theform as
you want to view.

Note

You should be able to view the entire width of the frame. If theright side
of the header frame and the vertical scroll bar for the frame are not visible
in the Layout Window, move the center bar between the EDI File Format
Window and the Layout Window farther to the left so the entire frameis
displayed. Alternatively, you can use the horizontal scroll bar at the
bottom of the Forms main window to bring the right side of the header
frame into view.

To resize the header frame, click and drag the right side of the frame
approximately to the 20 cm. mark on the horizontal ruler (aform with a
width of 20 cm. can be printed on an 8 1/2 x 11 sheet of paper).

Note

Use the horizonta ruler at the top of the frame to help you resize the
frame. The instructionsin thistutorial are given in centimeters. You can
toggle from inches to centimeters by double-clicking the yellow square
where the vertical and horizontal rulers meet.

Forms Integration EDIFACT Tutorial Guide
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Creating a Print Form

AddingaTitletothe Form

Overview  Youwant the form to have atitle designating the standard agency (EDIFACT), the version
(92.1), the type of message (purchase order), and the trading partner (Pet Zone) for which
thisform is used. You need to add atitle to the print form by adding static text.

Procedure  Usethis procedure to add and position thetitle for the form.

Step

Action

1

Select all thefields and field |abels on the frame.

Note

To select more than onefield or field label, click and drag the mouse
diagonally across all the fields and field labels you want to select. When
you release the mouse button, all the fields and field labels completely
included within the dragged-across area have handles, indicating that they
were selected.

Click and drag your selection approximately two or three centimeters
lower on the frame to make room at the top of the frame for the title.

Click Add Text on the Main Toolbar.

System Response
A text box is added to the current frame, displayed in the upper left corner
of the frame.

Note

If the template islarger than the frame (thereis a scroll bar on the right
side of the frame), the static text is displayed in the upper left corner of the
part of the template that is displayed, not at the top of the template.

In the new text box, enter EDIFACT 92.1 Purchase Order.

Click OK.

Click Add Text on the Main Toolbar.

In the new text box, enter Pet Zone.

The static text you added is displayed in the upper |eft corner of the frame.
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Centering the Text

Overview This section describes how to center text on aform.

Procedure  Usethis procedure to center the static text at the top of the purchase order form.

Sep Action

1 Click and drag the first line of static text (EDIFACT 92.1 Purchase
Order) so that the text is centered on the first line of the frame.

2 Click and drag the second line of static text (Pet Zone) so that thetext is
centered on the second line of the frame.

System Response
The header frame now should look like this:

EDIFACT 92,1 Purchase Ordzt
Pet Zone

LI+

oedar Nmdet |

Ordar Date:

CORTESCT No.

Ordee Type: |

+]
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Arranging the Header Fields

Overview By default, each field and its associated label are printed on their own line. It is common
for purchase orders and forms to arrange some fields in columns of information. The first
fields you rearrange are the header fields, which are the fields associated with the BGM,
DTM, and FTX segments, and the RFF and PAT groups.

By removing the field label in the Label field of the Display Properties dialog, you
prevented some of the field labels from being printed. The fields are displayed on your
print form but their associated labels are not printed.

Note

If you forget which unlabeled field contains what data, you can click the field. Its
associated element is highlighted in the EDI File Format Window, providing you with a
description of thefield.
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Resizing the Header Fields

Overview  When you customized the element properties in the previous section of this chapter, you
changed the display lengths (on the Display Properties dialog) for some of the fields on
the header frame. The fields that are displayed in the Layout Window currently reflect the
default display lengths for the fields. To reflect the new sizes of the fields in the Layout
Window, you must select the fields for which you changed the display lengths, then resize

thefields.

Note

If afield and its corresponding field label move together, the Lock Labelsto Fields option
isturned on. Click the Lock Labels button on the Main Toolbar to turn off the Lock Labels

option.

Procedure  Usethis procedure to resize the fields on the header frame.

Step

Action

1

Select al the fields on the header frame (Order Number, Order Date, Free
Text, Contract No., Terms of Payment, Order Type, and Payment Terms
Type Qualifier).

Note

To select agroup of fields, click and drag the mouse diagonally across all
the fields you want to select.

Select Sizeto Length from the Display menu. All selected fields are
resized to the lengths specified in the Maximum number of charactersto
be printed field of the Display Properties dialog for each field.

Note
If you format aform component in away you did not intend, select Undo
from the Display menu to undo your last formatting action.

Forms Integration EDIFACT Tutorial Guide
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Moving and Aligning the Header Fieldsand Field Labels

Overview  This section describes how to move and aign header fields and field labels.

Procedure  Usethis procedure to move and align the fields and field labels on the header frame.

Note

If afield isnot in the part of the frame that currently is displayed, use the scroll bar to
scroll down the frame until you locate the hidden field(s).

Sep

Action

1

Select each field individually and drag it closer to itsrespective field label.

CAUTION
DO NOT MOVE FIELDSTHAT ARE NOT LABELED.

Select the Order Date label and field and drag them to the right of the
Order Number label and field (at approximately 11.5 cm. on the horizontal
ruler).

Select the Order Type label and field and drag them below the Order
Number label and field.

Select the Contract No. label and field and drag them below the Order
Date label and field.

Select the Free Text field and drag it below the Order Type label and
field.

Select the Payment Terms Type Qualifier field and drag it below the
Free Text field.

Select the Terms of Payment field and drag it to the right of the Payment
Terms Type Qualifier field.

Select the following items:

»  Order Number field label

» Order Typefield label

» FreeTextfield

» Payment Terms Type Qualifier field.
Note

To select more than one item on aframe, click the first item, then press
CTRL and click the second item.
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(Contd)
Sep Action
9 Select Align Controls from the Display menu, then select Left from the

Align Controls submenu.

System Response
The left margins of the selected labels and fields are aligned.

10 Select the Order Type and Order Number fields (in that order).

11 Select Align Controls from the Display menu, then select L eft from the
Align Controls submenu. The left margins of the Order Type and Order
Number fields are aligned.

12 Select the Order Date and Contract No. field labels.

13 Select Align Controls from the Display menu, then select L eft from the
Align Controls submenu.

System Response
The left margins of the Contract No. and Order Date field labels are
aligned.

14 Select the Order Date and Contract No. fields (in that order).

15 Select Align Controls from the Display menu, then select L eft from the
Align Controls submenu. .

System Response
The left margins of the Contract No. and Order Date fields are aligned.

16 Select the Order Number and Order Date labels and fields.

17 Select Align Controls from the Display menu, then select Top from the
Align Controls submenu. The tops of the selected fields and field labels
are aligned.

18 Select the Order Type and Contract No. labels and fields.

19 Select Align Controls from the Display menu, then select Top from the
Align Controls submenu.

System Response
The tops of the selected fields and field |abels are aligned.

20 Select the Payment Terms Type Qualifier and Ter ms of Payment fields.

21 Select Align Controls from the Display menu, then select Top from the
Align Controls submenu.

System Response
The tops of the selected fields are aligned.
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(Contd)
Sep Action
22 To resize the frame, click and drag the bottom of the frame to just below

the Payment Terms Type Qualifier and Terms of Payment fields.

System Response
The header frame now should look like this:

EDIFACT B2.1 PUEChASE Qrder
Fat Iome

[ ]+

Nl — o —
Ocdec Type: Contract Ho. |:|

]
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Arranging the Name and Address (NAD) Fields

Overview

How toresizethe
name and address
(NAD) frame

How toresizethe
name and address
fields

Forms Integration EDIFACT Tutorial Guide

Thefieldsthat contain information about the names and addresses (NAD group) for the
purchase order are contained on a separate frame than the rest of the header information.
When you print the purchase order form, the fields on the Name and Address frame will
be printed after the fields on the header frame (the fields in the BGM, DTM, and FTX
segments, and the RFF and PAT groups).

You prevented all the labels for the name and address fields from being printed, so you
will see the fields in your print form, but not their associated labels.

In arranging the Name and Address (NAD) frame, first you will resize the frameto give it
the same width as the header frame, then you will move and resize the fields.

Use this procedure to resize the Name and Address (NAD) frame.

Sep Action
1 Click the NAD group to display the Name and Address framein the
Layout Window.
2 Click and drag the right side of the frame to the 20 cm. mark on the

horizontal ruler (aform with awidth of 20 cm. can be printed on an
8 1/2 x 11 piece of paper).

Use this procedure to resize the fields on the Name and Address (NAD) frame.

Sep Action
1 Select all the fields on the Name and Address frame (Party Qualifier field,
Party Name field, both Street and Number/P.O. Box fields, City Name
field, Country Sub-Entity Identification field, and Postcode | dentification
field).
2 Select Sizeto Length from the Display menu. All selected fields will be

resized to the lengths specified in the Maximum number of charactersto
be printed box of the Display Properties dialog for each field.
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How toarrange  Usethis procedure to arrange the fields on the Name and Address frame.

the name and

addressfields
Sep

Action

Select the Party Qualifier field (3035 _DESC) and drag it to the upper left
corner on the frame.

Select the Party Namefield and drag it to theright of the Party Qualifier
field (on the same line).

Select both Street and Number/P.O. Box fields and drag them below the
Party Name field.

Select the City Name field and drag it below the second Street and
Number/P.O. Box field.

Select the Country Sub-Entity Identification field and drag it to the
right of the City Name field (on the same line).

Select the Postcode | dentification field and drag it to the right of the
Country Sub-Entity Identification field (on the sameline).

Select the Party Qualifier and Party Name fields.

Select Align Controls from the Display menu, then select Top from the
Align Controls submenu. The tops of the selected fields will be aligned.

Select the City Name, Country Sub-Entity Identification, and Postcode
I dentification fields.

10

Select Align Controls from the Display menu, then select Top from the
Align Controls submenu. The tops of the selected fields will be aligned.

11

Select the following fields:

» Party Name
»  Street and Number/P.O. Box (both fields)
» City Name

12

Select Align Controls from the Display menu, then select L eft from the
Align Controls submenu. The left margins of the selected fields are
aligned.
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(Contd)
Sep

Action

13

To resize the frame, click and drag the bottom of the frame to just below
the City Name, Country Sub-Entity Identification, and Postcode
Identification fields.

System Response
The Name and Address (NAD) frame now should look like this:

[ ]+

I

]

Arrangingtheline  Thefieldsthat contain information about each line item for the purchase order are
item (LIN) fields  contained on a separate frame. To access this frame, select the LIN group.

You prevented some of the field labels from being displayed, so you see the fieldsin the
layout of your print form, but not their associated labels. In case you have forgotten which
unlabeled field contains what data, you can click the field. The name of the element will
be highlighted in the EDI File Format Window.

Before you arrange the line item fields and their frame, you need to resize the frame to
give it the same width as the other frames. Then move and resize the fields and field
labels, aswell as add static text to the form.

How toresizethe  Usethisprocedureto resize the Line Item (LIN) frame.

Action

Click the LIN group to display the Line Item frame in the Layout
Window.

lineitem (LIN)
frame Step
1
2

Click and drag the right side of the frame to the 20 cm. mark on the
horizontal ruler (aform with awidth of 20 cm. can be printed on an 8 1/2
x 11 piece of paper).
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How toresizethe  Usethis procedure to resize the line item fields.

lineitem fields

Sep

Action

1

Select the following fields:

Line

Prod ID
Unit

Qty
Requested
Ship No
Price

Select Sizeto Length from the Display menu. All selected fields are
resized to the lengths specified in the Maximum number of charactersto
be printed box of the Display Properties dialog for each field.

Adding column  You can add column headings (using static text) to the frame to change the way the field
headings labels are displayed in the form. Currently, each field label in thisform consists of oneline

of text.

You need all the horizontal space that is available in order to arrange the line item fields
horizontally. By adding a second line of text to some of the longer field labels (these field
labels will be identified in the steps that follow), more horizontal space will be available

on the frame.

You will add the following lines of static text to the form:

Satic Text

Placement on Form

No.

Below the Line field |abel

Type

Below the Code field label

Ord

Below the Qty field label

Each

Below the Price field |abel

Ship Date

Below the Requested field label

Later

Below the Ship No field label
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You need to add al of the static text (column headings and separating lines), then move
each line of static text into its proper location, later in this section.

When you finish adding the static text and moving each line of static text to its proper
location, the Line Item (LIN) frame should look like this:

Line Code d&w Prcice Beque=sted Ship Ho =
No. Prod ID Trae Ozl Unit Emch Zhip Dak= Lacer W
L1 | | 1 L1 O | | ||

]

Howtoadd  Usethis procedureto add and position static text.

column headings

Step

Action

Select all thefields and field |abels on the frame.

Click and drag them to the bottom portion of the frame. You are arranging
the fields at the top of the frame so moving the fields and field labels out
of the way initially gives you room at the top of the frame.

Click the Add Text button on the Main Toolbar.

System Response
A text box is added to the current frame in the upper left corner.

Select the new text box and enter No. (hote the period included in the
text). The Text Properties dialog is displayed as you are typing. Click OK
to add the text.

Click the Add Text button on the Main Toolbar.

Select the new text box and enter Type. The Text Propertiesdialog is
displayed as you are typing. Click OK to add the text.

Click the Add Text button on the Main Toolbar.

Select the new text box and enter Ord. The Text Propertiesdialog is
displayed as you are typing. Click OK to add the text.

Click the Add Text button on the Main Toolbar.

10

Select the new text box and enter Each. The Text Propertiesdialog is
displayed as you are typing. Click OK to add the text.

11

Click the Add Text button on the Main Toolbar.

12

Select the new text box and enter Ship Date. The Text Propertiesdialogis
displayed as you are typing. Click OK to add the text.

13

Click the Add Text button on the Main Tool bar.
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(Contd)
Sep

Action

14

Select the new text box and enter L ater. The Text Propertiesdialogis
displayed as you are typing. Click OK to add the text.

Note

The column headings (static text) you added are displayed in the upper

|eft corner of the frame.

15

Select al the static text you added and drag it to the bottom of the frame.

Addinglines  Inthisprint form, rectangular boxes are used to designate fields. The boxes make it easy
separating column  todistinguish fields from field labels and static text. On the printout, there are no
headingsand fields  rectangular boxes surrounding the datain the fields. The printed field data and the field
labels tend to look the same on the printout (same typeface, same size text, no boldface or
italic type). You can make the field labels and static text stand out from the fields
containing the actual data by adding lines separating the labels from the fields. You need
to add static text to the form to add the separating lines.7

Add the following lines of static text (hyphens) to the form.

Number of
Satic Text Hyphens Placement on Form
------ Six Below the No. static text
............ Twelve Below the Prod ID field label
Four Below the Type static text
-------- Eight Below the Ord static text
Four Below the Unit field label
----------- Eleven Below the Each static text
.......... Ten Below the Ship Date static text
---------- Ten Below the Later static text

When you finish adding the static text and moving each line of static text to its proper
location, the Line Item (LIN) frame should look like this:

Line

Code k-

Vo Prod ID Troe  dzd

| 1 ]

Toit

[]

[

Price Bequesbed Ship Ho
Emch Zhip Dak= Lacer

]

Add all of the static text, then move each static text to its proper location.
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How to add lines  Use this procedure to add and position separating lines (------ ) in the form.

separ ating column

headings and fields
Sep

Action

Click Add Text on the Main Toolbar.

Select the new text box and enter ------ (six hyphens). This series of
hyphens forms a separating line between the words Line No. and the field
below. The Text Properties dialog is displayed as you are typing. Click
OK to add the text.

Click Add Text on the Main Toolbar and a new text box is added to the
current frame in the upper |eft corner.

Select the new text box and enter ------------ (12 hyphens). This series of
hyphens forms a separating line between the words Prod 1D and the field
below. The Text Properties dialog is displayed as you are typing. Click
OK to add the text.

Click Add Text on the Main Toolbar and a new text box is added to the
current frame in the upper left corner.

Select the new text box and enter ---- (four hyphens). This series of
hyphens forms a separating line between the words Code Type and the
field below. The Text Properties dialog is displayed as you are typing.
Click OK to add the text.

Click Add Text on the Main Toolbar and a new text box added to the
current frame in the upper left corner.

Select the new text box and enter -------- (eight hyphens). This series of
hyphens forms a separating line between the words Qty Ord and the field
below. The Text Properties dialog is displayed as you are typing. Click
OK to add the text.

Click Add Text on the Main Toolbar and a new text box is added to the
current frame in the upper |eft corner.

10

Select the new text box and enter ---- (four hyphens). This series of
hyphens forms a separating line between the word Unit and the field
below. The Text Properties dialog is displayed as you are typing. Click
OK to add the text.

11

Click Add Text on the Main Toolbar and a new text box is added to the
current frame in the upper left corner.

12

Select the new text box and enter ----------- (11 hyphens). This series of
hyphens forms a separating line between the words Price Each and the
field below. The Text Properties dialog is displayed as you are typing.
Click OK to add the text.
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(Contd)
Sep

Action

13

Click Add Text on the Main Toolbar and a new text box is added to the
current frame in the upper left corner.

14

Select the new text box and enter ---------- (10 hyphens). This series of
hyphens forms a separating line between the words Requested Ship Date
and the field below. The Text Properties dialog is displayed as you are
typing. Click OK to add the text.

15

Click Add Text on the Main Toolbar and a new text box is added to the
current frame in the upper |eft corner.

16

Select the new text box and enter ---------- (ten hyphens). This series of
hyphens forms a separating line between the words Ship No Later and the
field below. The Text Properties dialog is displayed as you are typing.
Click OK to add the text.

Note
The separating lines you added are displayed in the upper left corner of
the frame.

17

Select al the static text you added and drag it to the bottom of the frame.
Moving the static text out of the way will give you more room at the top of
the frame.

How tomovethe  TheLineltem (LIN) frame now containsall of the fields, column headings, and separating
lineitem fields, lines that will be arranged on the form to create columns of information. You are ready to

column headings, move the fields, labels, and static text (column headings, and separating lines) to their
and separating ~ Proper locations on the frame.

lines

Use this procedure to arrange the Line Item (LIN) frame.

Step

Action

1

Select the Linefield label and drag it to the upper left corner on the frame.

Select the No. static text and drag it below the Line field label.

Select the first separating line you added (six hyphens) and drag it below
the No. static text.

Select the Linefield and drag it below the separating line you just moved.

Select the Prod I D field label and drag it to the right of the No. static text.

Select the second separating line you added (12 hyphens) and drag it
below the Prod ID field label.
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(Contd)
Sep

Action

7

Select the Prod ID field and drag it below the separating line you just
moved.

Select the Codefield label and drag it to the right of the Prod ID field
label (but in the same row asthe Line field label).

Select the Type static text and drag it below the Code field label.

10

Select the third separating line you added (four hyphens) and drag it
below the Code field label.

11

Select the Codefield and drag it bel ow the separating line you just moved.

12

Select the Qty field label and drag it to the right of the Codefield label.

13

Select the Ord static text and drag it below the Qty field label.

14

Select the fourth separating line you added (eight hyphens) and drag it
below the Ord static text.

15

Select the Qty field and drag it bel ow the separating line you just moved.

16

Select the Unit field label and drag it to the right of the Ord static text.

17

Select the fifth separating line you added (four hyphens) and drag it below
the Unit field label.

18

Select the Unit field and drag it bel ow the separating line you just moved.

19

Select the Price field label and drag it to the right of the Unit field label
(but in the same row asthe Qty field label).

20

Select the Each static text and drag it below the Price field label.

21

Select the sixth separating line you added (11 hyphens) and drag it below
the Each static text.

22

Select the Pricefield and drag it below the separating line you just moved.

23

Select the Requested field label and drag it to the right of the Price field
label.

24

Select the Ship Date static text and drag it below the Requested field
label.

25

Select the seventh separating line you added (ten hyphens) and drag it
below the Ship Date static text.

26

Select the Requested field and drag it below the separating line you just
moved.
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(Contd)
Sep

Action

27

Select the Ship Nofield label and drag it to the right of the Requested
field label.

28

Select the Later static text and drag it below the Ship No field label.

29

Select the eighth separating line you added (ten hyphens) and drag it
below the Later static text.

30

Select the Ship No field and drag it below the separating line you just
moved.

31

The Item Description field will not be placed in a column. Rather, this
field will be placed below the other fields on the Line Item (LIN) frame.

32

To move the Item Description field, click and drag it below the row of
fields.

33

You should resize the Line Item (LIN) frame to eliminate unnecessary
space resulting from arranging the fields on the frame. To resize the
frame, click and drag the bottom of the frame to just below the Item
Description field.

System Response
The Line Item (LIN) frame now should look similar to this:

[

Line Code= Oy Frice Reque=ated Ship Ho
Wa. Peed ID Type ard Unit Emch dhip late Later

How toalignrows  One of the remaining tasks in formatting the Line Item frame isto align the fields, field
labels, and static text. You will first align the itemsin rowsto give the form a consistent
appearance. You will align the itemsin columns later in this tutorial.

Use this procedure to align the fields, field labels, and static text by row (horizontally).

Step

Action

1

Select the following field labels and static text:

» Line

» Code

» OQty

» Price

» Requested
» ShipNo
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(Contd)
Sep

Action

2

Select Align Controls from the Display menu. Select Top from the Align
Controls submenu. The tops of all selected field labels and static text are
aligned in arow.

Select the following field labels and static text:

» No.

» ProdID

» Type

» Ord

» Unit

» Each

» ShipDate
» Later

Select Align Controls from the Display menu. Select Top from the Align
Controls submenu.

Select al the separating lines between column headings and fields.

Select Align Controls from the Display menu. Select Top from the Align
Controls submenu.

Select the following fields:

» LineNo.
» ProdID

» Code

» Type

» QtyOrd
» Unit

» PriceEach
» Regquested Ship Date
» Ship No Later

Select Align Controlsfrom the Display menu. Select Top from the Align
Controls submenu.
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How to align You need to align the fields, field labels, and static text in columnsto help give theform a
columns  consistent appearance.

Use this procedure to align the fields, field labels, and static text in columns.

Step

Action

1

Select the Line No. column heading, its separating line, the Line No. field,
and the Item Description field.

Select Align Controls from the Display menu, then select Left from the
Align Controls submenu. The selected items are left-aligned in a column.

Select the Prod 1D column heading, its separating line, and the Prod 1D
field.

Select Align Controls from the Display menu, then select L eft from the
Align Controls submenu.

Select the Code Type column heading, its separating line, and the Code
Typefield.

Select Align Controls from the Display menu, then select L eft from the
Align Controls submenu.

Select the Qty Ord column heading, its separating line, and the Qty Ord
field.

Select Align Controls from the Display menu, then select L eft from the
Align Controls submenu.

Select the Unit column heading, its separating line, and the Unit field.

10

Select Align Controls from the Display menu, then select L eft from the
Align Controls submenu.

11

Select the Price Each column heading, its separating line, and the Price
Each field.

12

Select Align Controls from the Display menu, then select L eft from the
Align Controls submenu.

13

Select the Requested Ship Date column heading, its separ ating line, and
the Requested Ship Date field.

14

Select Align Controls from the Display menu, then select L eft from the
Align Controls submenu.

15

Select the Ship No Later column heading, its separating line, and the
Ship No L ater field.
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(Contd)
Sep Action

16 Select Align Controls from the Display menu, then select L eft from the
Align Controls submenu.

System Response
The Line Item (LIN) frame now should look like this:

[

Line Code Gty Price Regu=ated  Ship Ho
No. Pood LD Typ=  Ozd Unit  Emch Ship Date  Later

C 110110 | | |

You have completed formatting the Line Item (LIN) frame so that the line item
information isdisplayed in columns and rows. If you wereto register the translation object
now and run EDI data through the translation object, then you would see that the column
headings are repeated for every line item.

The column headings need to be printed on the printout only once so you need to copy and
paste the LIN group to create a second LIN group (named LIN:2). The formatting in the
LIN group isretained in the LIN:2 group. Change the maximum use of thefirst LIN group
to one so that the column headings are printed only once. You need to remove the column
headings in the LIN:2 group from the area that will be printed, leaving only the fields for
printing the information on the printout.

You need change the maximum use of the LIN:2 group to 199999. Your partner can send
you up t0200,000 line items, so the total maximum use of both LIN groups does not need
to exceed 200000. The LIN group retains its maximum use of one, and the maximum use
of the LIN:2 group changes to 199999.

Use this procedure to copy and paste the LIN group:

Sep Action
1 Select the LIN group.
2 Click Copy on the Main Toolbar.
3 Select Paste on the Main Toolbar to paste the LIN group after the existing

LIN group. Sterling Gentran: Server prompts you to specify whether you
want the contents of the clipboard pasted as a child (subordinate) of the
selected group, or at the same level as the group.

4 Click the Paste after selected item (at the same level) option to paste the
Clipboard contents after the original LIN group.

5 Click OK to exit the dialog. The pasted group is named LIN:2.
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maximum use of
the LIN group
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maximum use of
the LIN:2 group
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LIN:2 column
headings below the
print area

Creating a Print Form

Use this procedure to change the maximum use of the LIN group.

Sep Action

1 Click the original LIN group with the right mouse button and select
Properties from the shortcut menu.
System Response
The Group Properties dialog is displayed.

2 Select the L ooping tab.

3 In the Max Usage box, enter 1.

4 Click OK to exit the Group Properties dialog.

Use this procedure to change the maximum use of the LIN:2 group.

Sep Action

1 Click the LIN:2 group with the right mouse button and select Properties
from the shortcut menu.
System Response
The Group Properties dialog is displayed.

2 Select the L ooping tab.

3 In the Max Usage box, enter 199999 to indicate that this group can be
used up to 199,999 times in each purchase order.

4 Click OK to exit the Group Properties dial og.

Use this procedure to move the column headings on the second Line Item (LIN:2) frame
below the print area so the headings do not print.

Sep Action

1 Click Generate L ayout on the Main Toolbar to refresh the print form
display.

2 Select the LIN:2 group. Its corresponding frame is displayed in the
Layout Window.

3 Select al of the column headings and separating lines on the frame and
drag them below the bottom of the frame so they are not displayed.

4 Select al of the fields on the frame and drag them to the top of the frame.
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Action

5 To resize the frame, click and drag the bottom of the frame to just below
the Item Description field.

System Response
The second Line Item (LIN:2) frame now should look like this:

L1 [ | 1O | | |

| | 3

]

Arrangingthe  The Number of Line Itemsfield (CNT group) for the purchase order is contained on a
control total separate frame than the rest of the purchase order information because this field contains
(CNT) field summary information that you want to be printed at the bottom of the trandlation object.

You need to resize the Control Total (CNT) frameto give it the same width as the Header,
Name and Address, and Line Item frames.

How toresizethe  Usethisprocedure to resize the Control Total (CNT) frame.
control total

(CNT) frame Sep Action
1 Click the CNT group to display the Control Total frame in the Layout
Window.
2 Click and drag the right side of the frame to the 20 cm. mark on the
horizontal ruler (aform with awidth of 20 cm. can be printed on an
8 1/2 x 11 piece of paper).

How toresize and Use this procedure to resize and move the Number of Line Itemsfield on the Control Total
move the control (CNT) frame.
total (CNT) field

Sep Action
1 Select the Number of Line Itemsfield.
2 Select Sizeto Length from the Display menu. The Number of Line Items

field is resized to the length specified in the Maximum number of
characters to be printed box of the Display Properties diaog.

3 Select the Number of Lineltemsfield label and drag it to the upper left
corner on the frame.

4 Select the Number of Lineltemsfield and drag it to the right of itsfield
label.

5 Toresize the Control Total (CNT) frame, click and drag the bottom of

the frame to just below the Number of Line Items label and field.
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Action

6 Select Save from the File menu to save the form.

System Response
The Control Total (CNT) frame now should look like this:

*
Murier of Lige Items
H{

You have completed your Purchase Order from and are ready to compile the form.
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Finalize the Form

Overview

Introduction Now that you have created and customized the print form, you are ready to compile the
form to generate the translation object (*.TPL) that Sterling Gentran:Server uses before
you print the report and test the compiled translation object.
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Compiling the Form

Overview  The Compile function generates atrand ation object. The form that you created is a source
map. When that source form is compiled the result is a compiled translation object.

Note

After you save the tranglation object, you must register it with Sterling Gentran: Server
before you can useit.

Procedure  Use this procedure to compile the form.

Sep Action
1 Select Compile from the File menu to display the Run-Time Trandlation
Object Name dialog.
CAUTION

DO NOT TO OVERLAY THE SOURCE FORM WITH THE
COMPILED TRANSLATION OBJECT. USE THE .TPL
FILE EXTENSION TO DISTINGUISH THE COMPILED
TRANSLATION OBJECT.

Run-Time Translation Object Hame

Save i Ia Tranz0bj

File hame: IF'eteon:I.TF'L

Save as wpe: ITransIatinn Objectz (. TPL] j Cancel |

Sterling Gentran:Server — May 2011 Forms Integration EDIFACT Tutorial Guide



Creating a Print Form

Compiling the Form

(Contd)
Sep

Action

2

Click Save to accept the translation object name (peteordp.tpl) in the File
name box.

Note

This name for the compiled translation object (.TPL file) isthe samefile
name as the source form (.STP file). Preserving the same file name (with
different file extensions) ensures that the relationship between the source
form and the compiled translation object remains evident.

System Response
The system compiles the form and generate an error report. The error
report is displayed in the Compile Errors dialog.

Lompile Errorz  petcordp_zkp

Coraiing lap OHDERS

Comrpiing koap 0200_MNeD

Compiing leap 2500_LIM

Comrpiing koap 2500_LIM:2

Conrpifing loop CHT_Grioup

Compikaion complete, 0 enors, 0 wernings.

Click OK to exit the Compile Errors dial og.

Note

If the Compile Errors dialog contains errors, you must fix the problem(s)
by redoing the appropriate section of the tutorial. Recompile the form
after you correct the error(s) and save the form.

Select Save from the File menu to save the form.

Select Detailsfrom the Edit menu to access the Translation Object Details
dialog. The date on which you compiled the form isloaded automatically
into the Compiled on box.

Click Cancel to exit the dia og.
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Overview  The Sterling Gentran: Server report enables you to validate and review the translation
object, and make modifications as needed. If you review the report and determine that the
tranglation object isincorrect, you should reiterate the form creation process as many
times as necessary (make the modifications, save the form, recompile the form, and print
the report again).

Procedure  Usethis procedure to print the Sterling Gentran: Server report.

Step

Action

1

Select Print from the File menu to access the Print Options dialog.

System Response
The Print Options dialog is displayed.

Print Options

Repart sections

¥ PFrint branching diagram

W Frint record details Cancel

¥ PFrint mapping details
¥ Print extended rules

W Print code lists

¥ Include only active obiscts

Click OK to accept the defaults on thisdialog (all options selected), so the
report includes all sections and only the activated form components.

System Response
The Print dialog is displayed.

Do you need to change setup options (to select a specific printer, paper
orientation, or size and source of paper) ?

» Ifyes, click Properties. Set the appropriate options. Click OK to
begin the print process.

» If no, click OK to begin the print process.
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Testing the Trangation Object

Overview  Before you can use the EDIFACT ORDERS Pet Zone print transation object, you must
test the tranglation object to verify that there are no errorsinit. To test the trandation
object, you must have afile containing test data. For thistutorial, you will use the
PETTSTE2.INT test file.

Testing stages  Thistable lists the stages required for testing the print translation object you just created.

Sage

Description

1

Register the PETEORDP.TPL tranglation object with Sterling
Gentran:Server.

Reference
See the IBM® Serling Gentran: Server® for Microsoft Wi ndows User
Guide for more information on registering a translation object.

Import the PETZONE2.PAR partner relationship into Sterling
Gentran:Server.

Reference
See the IBM® Serling Gentran: Server® for Microsoft Wi ndows User
Guide for more information on importing a partner.

The default path for the partner is:
C:\GENSRVNT\TUTORIAL\PETZONE2.PAR

Verify (in Partner Editor) that the ORDERS Pet Zone print translation
object is selected for the Inbound Relationship.

Reference
See the IBM® Serling Gentran: Server® for Microsoft W ndows User
Guide for more information on selecting inbound tranglation objects.

Use the Process File option in Sterling Gentran: Server to process the data
file (PETTSTEZ2.INT) through the translation object. The datafileis
located in the TUTORIAL subfolder under the folder where Sterling
Gentran:Server isinstalled.

The default path for the datafileis:
C\GENSRVNT\TUTORIAL\PETTSTE2.INT.

After the message istrandlated, it islocated in the In Documentsin
Sterling Gentran: Server. Print the message to ensure that the message was
translated correctly and that the printout looks the way you want it to look.

Reference
See the IBM® Serling Gentran: Server® for Microsoft Windows User
Guide for more information on printing messages.
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Overview

| ntroduction

In this chapter

Purpose of this
tutorial

Form criteria

CHAPTER

3

Creating a Screen Entry Form

Thistutoria definesthe tasks necessary to create a screen entry form. A screen entry form
isapredesigned layout that, when compiled into atranslation object, enables usersin your
company to easily enter the data necessary to create a business message.

This chapter includes the following topics associated with creating a screen entry form:
» Formanalysis

» Creating, saving, and setting up anew form

» Customizing the form, including the groups, segments, and elements

» Formatting the form, including fields and field labels

» Findizing theform

Thistutorial explains how to customize and format aform beforeit is compiled into a
tranglation object. The form that you create is a sour ce form. When that source formis
compiled, the result is a compiled translation object. You must register the translation
object with Sterling Gentran:Server to be able to use the translation object (to enter EDI
datain messages of that type).

Sterling Gentran: Server generates a basic form based on the following criteria that you
specify:

» Typeof form (screen entry or print)

» Standard agency (e.g., EDIFACT, ANSI X12)

» Standard version (e.g., 92.1, 003040)

» Messagetype (e.g., INVOIC, 810 Invoice)
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Mandatory  All mandatory groups, segments, composites, and elements for the standard, version, and
components  message you specify are available for use (activated) when Sterling Gentran: Server
creates aform. Only these mandatory form components (groups, segments, composites,
and elements) are activated automatically. You must activate additional form components
that you want to be displayed in the screen entry form, and then customize and format the
form so that it is appropriate and useful for your company’s needs.

Beforeyou begin  Before you begin to customize a screen entry form, you should be familiar with the
following elements of form design:

» EDI standards (how EDI standards work and how the information your users need is
tranglated to and from the standards)

» Your users (the individuals who use the screen entry translation objects to enter EDI
data)

» Your trading partners (the organizations receiving the EDI data that your users enter
in the screen entry translation object)

You can create a different screen entry form for each combination of message, trading
partner, and standard version. The number of screen entry formsthat you create is not
limited and does not affect the number of print formsyou create.

Recommendation

We recommend that you mock up alayout of the screen entry form the way you ultimately
want it to look. Asyou are designing the layout, you should consider the people who use
the translation object. Make sure that the form makes sense to the people who useiit. By
analyzing your company’s needs before you actually create the screen entry form, you
reduce the amount of time spent later on redesigning or reformatting the form.
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Phases of Designing a Form

Design phases  Thistablelists the phases of form design.

Phase Description
1 Analyzethe EDI file.
2 Design and create the form.
3 Modify form components.
4 Customize the EDI data.
5 Format the screen entry form.
6 Finalize the form.
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Getting Sarted

Overview  Thistutorial is meant to be completed in its entirety. We strongly recommend that you
complete each task sequentially. The purpose of completing each task in this tutorial in
sequential order, asif it were your own scenario, is hot only to teach you how to perform
the individual tasks, but also to teach you alogical approach and methods that should be
used when you create your own form.

This section guides you in completing the stepsin the first phase of form design. In this
section, you will create anew screen entry form based on a scenario we have defined for
you. This section includes the basics of creating the form, such as defining the scenario
and analyzing the purpose of the form, creating and saving the form, and setting up the
form. You can find techniques for customizing the segments, elements, and groupsin the
form, aswell as for formatting the organization and appearance of the form, later in this
chapter.

Screen entry form You will create a screen entry form for the INVOIC message (invoice), using the
scenario EDIFACT 92.1 standard. The stepsinvolved in creating this form are broken down into
manageabl e pieces so that you can learn the tasks and procedures involved in creating a
screen entry form. You can apply the knowledge gained from using this tutorial to create
your screen entry forms.

In this scenario, your company is MWT Manufacturing Co., which manufactures awide
variety of pet supplies for pet stores. One of your trading partners, Pet Zone (a large pet
supply retailer), orders products from your company. Your company then invoices Pet
Zone for those products. You will create aform that your data entry users will use to enter
EDI datafor the invoice that you will send to Pet Zone. From discussions with Pet Zone,
you know the requirements for the invoices that they receive from you.
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Basic Tasks

Analyzethe EDI File

Basic Tasks

Introduction

Form analysis

To analyze the EDI file, you must first determine what data you need to send your trading
partner and what data your trading partner expectsto receive. It isimportant to analyze the
datain thisway so that the invoice contains al the information and so that your company
can hill your partner correctly for the order you shipped to them. You and your partner
must agree on which standard, version, and message you will use. In this tutorial, you are
using an EDIFACT version 92.1 INVOIC invoice. It isimportant to know the format of
the information your partner expects you to send in the invoice and what type of data will
be contained in each element.

After you discusswith your trading partner what you will send, determine which segments
and elements your partner requires, and review the EDI standard, you can list the items
that you need to use.

Thefirst step in creating aform isto analyze your form requirements. If the analysis you
perform is complete, you will have all the information you need to create the form in an
efficient and logical manner. If you omit this critical step and proceed directly to creating
the form, it islikely that creating the form will be a much longer and more arduous task
and the form may not work the way you need it to, due to oversights and omissions.

Creating a screen entry form for the EDIFACT INVOIC message requires several steps.
Some steps are performed at the message level (such as activating form components) and
others are iterative steps that are performed for each group, segment, or element in the
form. In thisanalysis phase, you must determine what EDI datayou will send Pet Zone, as
well as what information Pet Zone requires to process the invoice. The fields on the form
must account for all information that you expect to send to Pet Zone.
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Mandatory  Thistable lists the groups, segments, composites, and elements that have been defined as
components  mandatory by the standards committee for an EDIFACT invoice (INVOIC).
Group Segment Composite | Element Description
BGM Beginning of Message
DTM Date/Time/Period
C507
DTMO1 Date/Time/Period Qualifier
UNS Section Control
UNSO1 Section Identification
MOA Monetary Amount
Required Thistable lists the form components for this tutorial that are required (need to be
components  activated) and are not mandatory for the standard.
Note
When you activate aconditional group, segment, or composite, the mandatory subordinate
segments, composites, and elements are activated automatically. A conditional group,
segment, or compositeisused only if thereis EDI data available for an element contained
init.
Data Constant, Code Value, or
Element Description Type | Length Format to Be Assigned
Beginning of Message (BGM Segment) (Already Activated)
BGMO05 Document/Message String 35
Number
Date/Time/Period (DTM Segment) (Already Activated)
DTMO1 Date/Time/Period Qualifier | String 3 3 (Invoice Date/Time)
DTMO02 Date/Time/Period String 35
Reference (RFF Group)
Reference (RFF Segment in RFF Group)
RFFO1 Reference Qualifier String 3 » CT (Contract Number)
» ON (Order Number
(Purchase))
RFF02 Reference Number String 35
Date/Time/Period (DTM:2 Segment in RFF Group)
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Data Constant, Code Value, or
Element Description Type | Length Format to Be Assigned
DTM:201 | Date/Time/Period Qualifier | String 3 » 92 (Contract Effective
Date)
» 4 (Order Date/Time)
DTM:202 | Date/Time/Period String 35
Name and Address (NAD Group)
Name and Address (NAD Segment in NAD Group)
NADO1 Party Qualifier String 3 » ST (ShipTo)
» RE (Party To Receive
Commercial Invoice
Remittance)
NAD10 Party Name String 35
NAD16 Street and Number/P.O. String 35
Box
NAD17 Street and Number/P.O. String 35
Box
NAD19 City Name String 35
NAD20 Country Sub-Entity String 9
Identification
NAD21 Postcode Identification String 9
Payment Terms (PAT Group)
Payment Terms Basis (PAT Segment in PAT Group)
PATO1 Payment Terms Type String 3 Any valid code
Qualifier
Lineltem (LIN Group)
Lineltem (LIN Segment in LIN Group)
LINO1 Line Item Number Number | 6
Additional Product ID (PIA Segment in LIN Group)
PIAOL Product ID Function String 3 5 (Product Identification)
Qualifier
PIAQ2 [tem Number String 35
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Data Constant, Code Value, or
Element Description Type | Length Format to Be Assigned
PIAO3 Item Number Type, Coded | String 3 UP(UPC (Universal Product
Code))

Item Description (IMD:2 Segment in LIN Group)

IMD:201 Item Description Type, String 3 F (Free Form)
Coded
IMD:206 Item Description String 35

M easurements (MEA:2 Segment in LIN Group)

MEA:201 M easurement Application String 3 AAE (Measurement)
Qualifier
MEA:202 | Measurement Dimension, String 3
Coded
Quantity (QTY:2 Segment in LIN Group)
QTY:201 Quantity Qualifier String 3 47 (Invoiced Quantity)
QTY:202 Quantity Number | 15 Format = RO

Date/Time/Period (DTM:11 Segment in LIN Group)

DTM:1101 | Date/Time/Period Qualifier | String 3 186 (Departure Date/Time,
Actual)

DTM:1102 | Date/Time/Period String 35

Monetary Amount (MOA Group in LIN Group)

Monetary Amount (MOA:5 Segment in MOA Group in LIN Group)

MOA:501 | Monetary Amount Type String 3 146 (Unit Price)
Qualifier
MOA:502 | Monetary Amount Number | 18 Format = R2

Details of Transport (TDT Group in LIN Group)

Details of Transport (TDT:2 Segment in TDT Group in LIN Group)

TDT:201 Transport Stage Qualifier String 3 20 (Main-Carriage
Transport)
TDT:205 Type of Meansof Transport | String 8 Any valid code
Identification
TDT:207 Carrier Identification String 17
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Data Constant, Code Value, or
Element Description Type | Length Format to Be Assigned

Section Control (UNS Segment)

UNSO01 Section Identification String 1 S (Summary)

Control Total (CNT Segment)

CNTO1 Control Qualifier String 3 2 (Number of Line Items)

CNTO2 Control Value Number | 8 Format = NO

Monetary Amount (MOA Group) (Already Activated)

Monetary Amount (MOA:10 Segment in MOA Group)

MOA:1001 | Monetary Amount Type String 3 77 (Invoice Amount)
Qualifier
MOA:1002 | Monetary Amount Number | 18 Format = R2

Segment analysis  For each segment activated (either mandatory or optional), you must ask the following
questions:

»  Will the segment have a maximum use greater than one?
» What composites and elements need to be activated for the segment?

This table describes the segment components used in this tutorial.

Component Description

Group Contains related segments and/or groups that repeat in sequence
until either the group data ends or the maximum number of times
that the loop is allowed to repeat is exhausted.

Repeating segment | Consists of elements that repeat in sequence until either the
segment data ends or the maximum number of times the segment
isalowed to repeat is exhausted.

Composite Contains two or more component data elements or subelements.
Composites are defined by the EDI standards that use them
(EDIFACT, TRADACOMS, and certain ANSI X 12 standards).
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Component Description

Refers to the number of times it can be used within the structure
in which the segment isdefined. For example, if asegment can be
used only once within agroup but the group can be used multiple
times, the segment till has a maximum use of one within each
occurrence of the group. The standard defines the maximum
number of times a segment can be used. You must determine how
many times a segment is used based on what you send your
trading partner.

Maximum use

Elements Each segment contains elements. Some el ements are mandatory
and others are optional to the standard but necessary for your
needs. You must define all the elements that you send Pet Zone

for each segment.

Customization Sterling Gentran: Server generates a form based on the groups, segments, composites, and

tasks elementsyou activate. At this point, the form is compliant with the standard and it
contains all the necessary components based on the data you send Pet Zone. You need to
customize the form components to produce aform that is easy to use to enter datain a
logical manner.
Thistable lists the customization tasks described in this tutorial .
Form
Component Description Customization Task
BGMO05 Document/ You will set up the document name (which enables you
element Message to differentiate between messages in the document
Number browsersin Sterling Gentran: Server) in this element.
Also, your users will enter no longer than an eight-
character string in this element, so you will change the
maximum length for this element to eight. In addition,
you will change the field label to Invoice No., which
better describes the data your users will enter.
DTM segment | Date/Time/ You and your trading partner will use this segment only
Period once, so you will change the maximum use of this
segment to one.
DTMO1 Date/Time/ Your users will enter only the invoice date in this
element Period Qualifier | segment, so you do not need to load the entire code list
table. You will define a constant value in this element
for the invoice date. Then, you will prevent thisfield
from being displayed in the screen entry form, because
the value for thisfield will be entered automatically.
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Form
Component Description Customization Task

DTMO02 Date/Time/ Your users will enter a string no longer than eight
element Period charactersin this element, so you will change the
maximum length for this element to eight. Also, you
will change the field label to Invoice Date.

RFF group Reference You and your trading partner will use this group only
once, so you will change the maximum use of thisgroup
to one. You will promote this group so that thefieldsin
this group are placed on the main Invoice Message
frame. Also, you need two iterations of this group: one
for the contract number, and one for the purchase order
number. You will copy this segment so that you will
have the two iterations of this group you need.

RFFO1 element | Reference Your users will enter only the contract number in this
Qualifier segment, so you do not need to load the entire code list
table. You will define a constant value in thisfield for
the contract number. Then, you will prevent thisfield
from being displayed in the screen entry form, because
the value for this field will be entered automatically.
You will perform the same task (with a different
constant value) for the Reference Qualifier field in the
new RFF group that you created by copying the original
RFF group.

RFF02 element | Reference Your users will enter a string no longer than ten
Number charactersin this element, so you will change the
maximum length for this element to ten. Also, you will
change the field label to PO. No. (“Contract No.” for
the Reference Number field in the second iteration of
the RFF segment).

DTM:2 Date/Time/ You and your trading partner will use this segment only
segment Period once, so you will change the maximum use of this
segment to one.

DTM:201 Date/Time/ Your users will enter only the contract date in this
element Period Qualifier | segment, so you do not need to load the entire code list
table. You will define a constant value in thisfield for
the contract date. Then, you will prevent this field from
being displayed in the screen entry form, because the
value for thisfield will be entered automatically. You
will perform the same task (with a different constant
value) for the Date/Time/Period Quadlifier field in the
new RFF group that you created by copying the original
RFF group.
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Form
Component Description Customization Task
DTM:202 Date/Time/ Your users will enter a string no longer than eight
element Period charactersin this element, so you will change the
maximum length for this element to eight. Also, you
will changethefield label to PO. Date (“ Contract Date”
for the Date/Time/Period field in the second iteration of
the RFF segment).
NAD group Name and You and your trading partner have decided to use this
Address group only once, so you will change the maximum use
of thisgroup to one. You will promote this group so that
the fieldsin this group are placed on the main Invoice
Message frame. Also, you need two iterations of this
group: one for the Ship To name and address, and one
for the Remit To name and address. You will copy this
segment so that you will have the two iterations of this
group you need.
NADO1 Party Qualifier Your userswill enter only the Ship To name and address
element in this group, so you do not need to load the entire code
list table. You will define a constant value in this
element for the contract number. Then, you will prevent
thisfield from being displayed in the screen entry form,
because the value for thisfield will be entered
automatically. You will perform the same task (with a
different constant value) for the Party Qualifier field in
the new NAD group that you created by copying the
original NAD group.
NAD10 Party Name You will change the field label for this element to Ship
element To (“Remit To” for the Party Name field in the new
NAD group).
NAD16 Street and The datain this element will be self-explanatory, so you
element Number/P.O. will remove the label from thisfield.
Box
NAD17 Street and Thedatain this element will be self-explanatory, so you
element Number/P.O. will remove the label from thisfield.
Box
NAD19 City Name The datain this element will be self-explanatory, so you
element will remove the label from thisfield. Also, your users

will enter no longer than a thirty-character string in this
element, so you will change the maximum length for
this element to thirty.
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Form
Component Description Customization Task
NAD20 Country Sub- The datain this element will be self-explanatory, so you
element Entity will remove the label from thisfield. Also, your users
Identification will enter no longer than atwo-character string in this

element, so you will change the maximum length for
this element to two.

NAD21 Postcode The datain this element will be self-explanatory, so you

element Identification will remove the label from thisfield.

PAT group Payment Terms | You and your trading partner will use this group only
once, so you will change the maximum use of this group
to one. You will promote this group so that the fieldsin
this group are placed on the main Invoice Message
frame.

PATOL1 element | Payment Terms | Your users can enter any of the payment terms type

Type Qualifier codes that the standard designates as valid codes. You
will load the entire code list for this element, which will
create alist containing valid codes from which users can
select. Also, you will change the field label to Payment
Terms Code.

LIN group Lineltem You will add the more descriptivetitle, Line Items, to
the group description to label the fields contained on the
LIN frame.

LINO1 element | Lineltem You will use an accumulator for this element to count

Number lineitems in the invoice. This accumulator will be used
inthe Control Valuefield (CNTO2) to calculate the total
number of lineitemsintheinvoice. You will instruct the
system to display the value in thisfield in the first
column in the Line Items list on the Invoice Message
frame. Also, thelineitem number will be no longer than
five digits, so you will change the maximum length for
this element to five. In addition, you will change the
field label to Item No.

PIA segmentin | Additiona You and your trading partner will use this segment only

the LIN group | Product ID once per lineitem, so you will change the maximum use

of this segment to one.
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Form
Component

Description

Customization Task

PIAO1 element

Product ID
Function
Quialifier

Your users will enter only the item number in this
segment, so you do not need to load the entire code list
table. You will define a constant value in this element
for the item number. Then, you will prevent thisfield
from being displayed in the screen entry form, because
the value for thisfield will be entered automatically.

PIAO2 element

Item Number

Your users will enter a string no longer than ten
characters in this segment, so you will change the
maximum length for this element to ten. Also, you will
change the field name to Product Code. In addition, you
will instruct the system to display the value in thisfield
in the second column in the Line Items list on the
Invoice Message frame.

PIAO3 element

Item Number
Type, Coded

Your users will enter only the product identification in
this segment, so you do not need to load the entire code
list table. You will define a constant value in this
element for the product identification. Then, you will
prevent this field from being displayed in the screen
entry form, because the value for thisfield will be
entered automatically. Also, the constant you defined
for this element is only two characterslong, so you will
change the maximum length of this element to two.

IMD:2
segment in the
LIN group

Item Description

You and your trading partner have decided to use this
segment only once per line item, so you will change the
maximum use of this segment to one.

IMD:201
element

Item Description
Type, Coded

Your users will enter only the free-form description in
this segment, so you do not need to load the entire code
list table. You will define a constant value in thisfield
for the free-form description. Then, you will prevent
thisfield from being displayed in the screen entry form,
because the value for thisfield will be entered
automatically.

MEA:2
segment in the
LIN group

Measurements

You and your trading partner have decided to use this
segment only once per lineitem, so you will change the
maximum use of this segment to one.

MEA:201
element

M easurement
Application
Qualifier

Your users will enter only the measurement dimension
in this element, so you do not need to load the entire
code list table. You will define a constant value in this
element for the measurement dimension. Then, you will
prevent this field from being displayed in the screen
entry form, because the value for thisfield will be
entered automatically.
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Component Description Customization Task
MEA:202 Measurement Your users can enter any of the measurement dimension
element Dimension, codes that the standard designates as valid codes. You
Coded will load the entire code list for this element, which will

create alist containing valid codes from which users can
select. Also, you will change the field label to UOM
(indicating “Unit of Measure”).

QTY:2 Quantity You and your trading partner will use this segment only

segment in the once, so you will change the maximum use of this

LIN group segment to one.

QTY:201 Quantity Your users will enter only the invoiced quantity in this

element Qualifier segment, so you do not need to load the entire code list
table. You will define a constant value in this element
for the invoiced quantity. Then, you will prevent this
field from being displayed in the screen entry form,
because the value for thisfield will be entered
automatically.

QTY:202 Quantity You will use an accumulator for this element to generate

element arunning total of the invoice amount. This accumulator
will be used inthe Monetary Amount field (MOA:1002)
to identify the total dollar amount invoiced. You will
instruct the system to display the value in thisfield in
the third column in the Line Itemslist on the Invoice
Message frame. Also, your userswill enter anumber no
longer than five digits in this element, so you will
change the maximum length for this element to five. In
addition, Your users will not use decimal places for the
datain thisfield, so you will format the data with an
explicit decimal point and no decimal places.

DTM:11 Date/Time/ You and your trading partner will use this segment only

segment inthe | Period once per lineitem, so you will change the maximum use

LIN group of this segment to one.

DTM:1101 Date/Time/ Your users will enter only the actual departure datein

element Period Qualifier | thissegment, so you do not need to load the entire code
list table. You will define a constant value in this
element for the actual departure date. Then, you will
prevent this field from being displayed in the screen
entry form, because the value for thisfield will be
entered automatically.

DTM:1102 Date/Time/ Your users will enter a string no longer than eight

element Period charactersin this element, so you will change the

maximum length for this element to eight. Also, you
will change the field label to Date Shipped.
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Component

Description

Customization Task

MOA group in
the LIN group

Monetary
Amount

You and your trading partner will use this group only
once per lineitem, so you will change the maximum use
of thisgroup to one. You will promote this group so that
the fieldsin this group are placed on the main Invoice
Message frame.

MOA:501
element

Monetary
Amount Type
Qualifier

Your userswill enter only the unit price in this segment,
so you do not need to load the entire code list table. You
will define a constant value in this element for the unit
price. Then, you will prevent thisfield from being
displayed in the screen entry form, because the value for
this field will be entered automatically.

MOA:502
element

Monetary
Amount

You will use an accumulator for this element to generate
the total dollar amount of the invoice amount. This
accumul ator will be used in the Monetary Amount field
(MOA:1002) to identify the total dollar amount
invoiced. You will instruct the system to display the
valueinthisfield in the fourth column in the Line Items
list on the Invoice Message frame. Also, your users will
enter anumber no longer than eight digitsin this
element, so you will change the maximum length for
this element to eight. In addition, your users will enter
prices with two decimal pointsin this field, so you will
format the data with an explicit decimal point and two
decimal places. Finally, you will change the field label
to Price.

TDT groupin
the LIN group

Details of
Transport

You and your trading partner have decided to use this
group only once per line item, so you will change the
maximum use of this group to one. You will promote
this group so that the fieldsin this group are placed on
the main Invoice Message frame.

TDT:201
element

Transport Stage
Qualifier

Your userswill enter only the main-carriage transport in
this segment, so you do not need to load the entire code
list table. You will define a constant valuein thisfield
for the transport stage. Then, you will prevent thisfield
from being displayed in the screen entry form, because
the value for this field will be entered automatically.
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Form
Component

Description

Customization Task

TDT:205
element

Type of Means
of Transport
Identification

Your users can enter any of the type of means of
transport identification codes that the standard
designates as valid codes. You will load the entire code
list for this element, which will create alist containing
valid codes from which users can select. Also, you will
change the field label to Transport Method. In
addition, your users will enter a string no longer than
two charactersin this element, so you will change the
maximum length for this element to two.

TDT:207
element

Carrier
I dentification

Your users will enter a string no longer than twelve
charactersin this element, so you will change the
maximum length for this element to twelve. Also, you
will change the field nameto Carrier Code.

UNSO01
element

Section
Identification

The only type of section identification used in this
segment is summary, so you do not need to load the
entire code list table. You will define aconstant valuein
this element for the summary. Then, you will prevent
thisfield from being displayed in the screen entry form,
because the value for thisfield will be entered
automatically.

CNT segment

Control Total

You and your trading partner have decided to use this
segment only once, so you will change the maximum
use of this segment to one.

CNTO1
element

Control
Qualifier

The only type of control used in this segment isthe
number of line items, so you do not need to load the
entire code list table. You will define aconstant valuein
this element for the number of line items. Then, you
will prevent thisfield from being displayed in the screen
entry form, because the value for thisfield will be
entered automatically.

CNTO02
element

Control Value

You will use an accumulator for this element to generate
atotal of the number of lineitemsin the invoice. You
will make thisfield display-only, so that users cannot
changethevauein thisfield. Also, thetotal inthisfield
will be no longer than a six-character string, so you will
change the maximum length for this element to six. You
will change the field label to Number of Line Items. In
addition, the valuein thisfield always will be awhole
number, so you will format the data with an explicit
decimal point and no decimal places.
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MOA group Monetary You and your partner will use this group only once, so
Amount you will change the maximum use of this group to one.
You will promote this group so that the fieldsin this
group are placed on the main Invoice Message frame.
MOA:1001 Monetary The only type of monetary amount used in this segment
element Amount Type isthe invoice amount, so you do not need to load the
Qualifier entire codelist table. You will define aconstant valuein
thisfield for the invoice amount. Then, you will prevent
thisfield from being displayed in the screen entry form,
because the value for this field will be entered
automatically.
MOA:1002 Monetary You will use an accumulator for this element to generate
element Amount arunning total of price (the quantity invoiced for each

line item multiplied by the unit price). You will make
this field display-only, so that users cannot change the
valuein thisfield. Also, the total in thisfield will be no
longer than aten-character string, so you will change
the maximum length for this element to ten. You will
change the field label to Total Invoice Amount.
Finaly, the valuein thisfield will be a price with two
decimal places, so you will format the data with an
explicit decimal point and two decimal places.
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Design and Create the Form

Verifying the Global EDI Date Formats

Introduction Sterling Gentran: Server Forms Integration enables you to customize the global EDI date
formats for all forms. You can specify the default EDI format of dates for both six-
character dates and eight-character dates. When you customize the globa EDI date
formats, the settings are valid for all forms created in the current session of Sterling
Gentran:Server. You can override the default date formats for an individual element on the
Field Properties dialog for that element.

You must verify that you are using the correct global date formats the first time you use
Forms Integration. You can change the default date formatsif they do not match the
formats you intend to use.

Procedure  Usethis procedure to verify the global EDI date formats.

Step

Action

1

Launch the Forms I ntegration subsystem.

Reference
See How to Launch Forms Integration on page 1 - 9 for instructions.

Select Preferences from the Options menu to display the Preferences
dialog. The Preferences dialog is a property sheet that enables you to set
global defaults for Sterling Gentran: Server.

Verify that the Standard Formats tab displays the default date formats that
are used when elements are read from the standards database.

Verify that the Six-character dateslist contains YYMMDD to define the
format of the six-character EDI datesin your forms.

Verify that the Eight character dateslist containsYYYYMMDD to
define the format of the eight-character EDI datesin your forms.

Click OK to accept the default date formats for 6- and 8-character date
fields and exit the Preferences dialog.

Note

To change the order in which the date formats appear in the Six-character
dates and Eight character dates lists or to add a new date format to the
lists, select Date For mats from the Options menu.
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Defining the Type of Form

Overview  Thefirst task in creating a new form isto define the type of form and EDI standard,
version, and message. In thistutorial, you are creating a screen entry form so that your
data entry users can enter EDI datain an invoice translation object in Document Editor.
Instead of defining the INVOIC (invoice) message to the system yourself, you want
Sterling Gentran: Server to use the standards database on your system to build the invoice
according to the EDIFACT 92.1 standard.

Beforeyou begin  Before you begin this procedure, verify that you have installed the Sterling Standards
Database for EDI.

Reference
See How to Install Serling Sandards Database for EDI on page 1 - 10 for instructions.

Procedure  Usethis procedure to create the new screen entry form.

Sep Action
1 Select New from the File menu to display the New Form Wizard.
2 From the What kind of form are you creating list, select Screen Entry to

indicate that the tranglation object that your are creating is a Screen Entry
translation object.

3 In the What is the name of the form box, enter Screen Invoic Pet Zone.
This description provides a brief explanation of the compiled translation
object that enables you to differentiate it from similar tranglation objects
in Sterling Gentran: Server.

Example
Screen INVOIC Pet Zone is the description that indicates an EDIFACT
92.1 Invoice (INVOIC) for partner Pet Zone.

4 Verify that the name that is displayed in the What is your name box is
accurate.

5 Click Next to continue.

6 Select Delimited EDI asthe dataformat syntax that you want to use.

7 Click Customize.

8 Click Next to continue.

9 From the Data Source list, select Gentran Sandards as the ODBC data

source that you wish to use.

10 Click Next to continue.
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Action

11

From the Agency list, select [E] Edifact, which isthe EDI standard you
will use for thistranslation object.

12

From the Version list, select [092001] EDIFACT 1992 RELEASE 1,
which istheversion of the standard you will use for thistranslation object.
The versions that are available depend on which standard you sel ected.
The EDIFACT standard version 92.1 islisted as version 092001 in the
Sterling Gentran: Server standards files.

13

From the Transaction list, select [INVOIC] INVOICE MESSAGE,
which is the transaction set (message) you will use for this translation
object. The documents that are available depend on which standard and
version you selected.

14

Click Next to continue.

15

Click Finish to create the EDI file. This may take a few seconds.

System Response
The form is displayed.

i Gentran Forms Integration - [Screen Invoic Pet Zone]

& File Edit Functions Miew Display Options Window Help =121 x|
i 5 = = s e e o -1

EAINVOIC - M - 1 INVOICE MESSAGE &
I BGM - M - 1 BEGINMING OF ME
FCIDTH - M - 35 DATE/TIME/PERI

Faor Help, press F1 i

16

From the Edit menu, select Details.

17

Verify that Screen Entry is selected in the Translation Object Function
list.

18

In the Mgjor version box, enter 1 to designate the version number for this
translation object.
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Action

19

In the Minor version box, accept the default value O that designates the
release number for this translation object.

Recommendation

After you make amgjor change to this form, increase the version to the
next higher sequential number (e.g., 2.0). If you make a minor change to
the form, increase the release to the next higher sequential number (e.g.,
2.1).

20

The Input and Output boxes (Agency, Version, Transaction, Release, and
F Group) contain information only if the Input and/or Output sides of the
form are of EDI format. For thistutorial, do not change the information in
these boxes.

Note

The system alows you to change the information in the Input and Output
boxes, but modifying this information does not alter the content of the
form. An example of when you might want to ater these boxes is when
you want the form to reflect a standard version that is not loaded on your
system. You can change the version on this dialog, and then physically
ater the form to be compliant with that version.

21

Click OK to save the tranglation object details and access the Save As
dialog.

22

Select Save from the File menu.

System Response
The Tranglation Object Details dialog is displayed.

Note

If you have performed any function that invalidates the current format of
the trandlation object, the Save function is unavail able (dimmed) until you
regenerate the layout (click Generate Layout on the Main Toolbar).

23

Verify that the Savein list reflects the drive\folder where Sterling
Gentran:Server isinstalled.

The default is GENSRVNT\Forms.

Sterling Gentran:Server — May 2011
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(Contd)
Sep Action

24 In the File name field, enter peteinvs.stp to replace the default file name.
The file name must be unique. In our example, the name indicates an
EDIFACT invoice message (INVOIC) for partner Pet Zone.

Note
The default file extension for formsis.STP. The naming conventionsin
the Sterling Gentran: Server Forms Integration subsystem are as follows:

» Thesourceform (form created in Sterling Gentran: Server) should be
named using the file extension .STP (e.g., PETEINVS.STP).

» Thecompiled trandation object (translation object that is the result of
compiling the source form) should be named using the samefile
name that was allocated to the source form, but with thefile extension
.TPL (e.g., PETEINVS.TPL).

25 Click Save to save the form.
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Activating Groups, Segments, Composites, and Elements

Overview  When Sterling Gentran: Server generates the form, it includes all groups, segments,
composites, and elements that are defined by the standard agency (EDIFACT) for the
version (92.1) of the message (INVOIC) you selected. The system activatesall the groups,
segments, composites, and elements that are defined as mandatory (must be present) by
the standard. The system does not enable you to deactivate the mandatory groups,
segments, and elements.

Example  Inthe example below, the INVOIC fileicon, BGM and DTM segments, C507 composite,
and DTMO01 element are mandatory for the invoice. You do not need to activate these
components. The DTM02 and DTMO03 elements are not mandatory, so they are dimmed
on the form.

[ 1v0IC M- INVOICE MESSAGE
BGM -M- 1 BEGINNING OF MESSAGE
DTM -M- 1 DATE/TIME/PERIOD
52 CEO7 -
E # 01 2005 M- Sting 3 -Edit Box- DATE/TIME/FERIOD QUALIFIER
5
5

To view the segments, composites, and elementsin a group, segment, or composite on
your form, double-click the form component in the EDI File Format Window (left side of
the Forms main window). To activate an inactive form component, click Activate on the
Main Toolbar, then click the form component. The component is no longer dimmed.

When translating data, the system does not process groups, segments, composites, and
elements that are not activated. You must activate the groups, segments, composites, and
elements that are not defined as mandatory by the standard, but that you have determined
that you need to use in the form.

Groups, segments, Thistable lists the groups, segments, composites, and elements to be used in this tutorial .
composites,
elementsused in
thistutorial Group Group Segment Composite Element

BGM BGMO05
(already
activated)

DTM C507 (already activated) | DTM02
(already
activated)
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(Contd)
Group Group Segment Composite Element
RFF RFF C506 RFF02
(mandatory for RFF)
DTM:2 C507 DTM:202
(mandatory for DTM:2)
NAD NAD C080
C059 NAD17
NAD19
NAD20
NAD21
PAT PAT
LIN LIN LINO1
PIA C212 PIAO2
(mandatory for PIA) PIAG3
IMD:2 IMD:201
C273 IMD:206
MEA:2 C502 MEA:202
QTY:2
DTM:11 C507 DTM:1102
(mandatory for DTM:11)
MOA MOA:5 C516 MOA:502
(mandatory for MOA:5)
TDT TDT:2 C228 TDT:205
C040 TDT:207
CNT
MOA MOA:10 C516 MOA:1002
(already
activated) (mandatory for MOA:10)
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Procedure  Usethis procedure to activate groups, segments, composites, and elements.

CAUTION

YOU MUST ACTIVATE ALL REQUIRED GROUPS, SEGMENTS,
COMPOSITES, AND ELEMENTSLISTED ON THE FOLLOWING
TABLE. FAILURE TO DO SOWILL HINDER YOUR ABILITY TO
PERFORM STEPSLATERIN THISTUTORIAL.

Step

Action

1

Double-click the groups, segments, and composites listed in the previous
table to open them. Opening all the necessary groups, segments, and
composites before you start to activate enables you to scroll down the
form and activate the segments, composites, and elements sequentially.

Note

When you activate a conditional group, segment, or composite, the
mandatory subordinate segments, composites, and elements are activated
automatically.

Click Activate on the Main Toolbar.

Click each inactive group that you need to use. This activates the groups.

Note

If you click a group, segment, element, or composite that you did not
mean to activate, click the group with the right mouse button to access the
shortcut menu. Select Deactivate from the shortcut menu.

Click each inactive segment that you need to use. This activates the
segments.

Click each inactive composite that you need to use. This activates the
composites.

Click each inactive element that you need to use. This activates the
elements.

Note

When you activate an element in a screen entry form, either the tag Edit
Box or the tag Drop Down is displayed before that element’s description.
Edit Box indicates that the element is formatted as afield. Drop Down
indicates that the element is formatted as a list because you applied a
standard rule that allows a selection of multiple items.

Click Activate on the Main Toolbar to turn activation mode off.

Note
To hide the groups, segments, and elements that you are not using, select
Show Active Only from the View menu.

From the File menu, select Save to save your form.
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Adding Frame Help Text

Adding Frame Help Text

Overview  You need to add frame Help text so that your end users can access online Help for the
Invoice Details frame.

Procedure  Usethis procedure to add frame Help text.

Sep

Action

1

Click the INVOIC fileicon (at the top of your form) with the right mouse
button and select Properties from the shortcut menu.

System Response
The system displays the File Format Properties dialog.

Click the Display tab.

In the Frame Help Text box, enter the following text (press Enter at the
end of each line of text below):

Thisframe contains header information
pertaining to the entire invoice message
(INVOIC). For onlineHelp on an individual
field on thisframe, select the field and
pressF1.

Note

Pressing Enter creates line breaks for the online Help that the screen entry
translation object usersin Sterling Gentran: Server view when they press
F1. If you do not create line breaks, the online Help will be displayed on
one line of text in the online Help pop-up window, and text that extends
beyond the width of the user’s monitor will not be displayed.

When you generate the form (display the fieldsin the Layout Window),
thereis one frame in the Layout Window (right side of Forms main
window) for every group and repeating segment in the EDI File Format
Window (left side of Forms main window). Entering frame Help text for
the group or segment corresponding to each frame enables screen entry
translation object users to access context-sensitive Help text for the frame.

Click OK to save your changes and to exit the dial og.

Forms Integration EDIFACT Tutorial Guide
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Setting EDI Delimiters

Creating a Screen Entry Form

Overview  You areusing an EDI standard that contains composite el ements or subelements, so you
must define the EDI delimiters. Delimiters are flags that separate specific EDI
components. Delimiters are necessary for all variable field-length standards, because the
datais compressed and the leading zeroes and trailing blanks are removed. The fields vary
in length so the system needs a flag to determine where one element ends and another
begins. For example, an element delimiter marks the beginning of a new element.

EDI delimiters  Thistableliststhe valid EDI delimiters.

table
EDIFACT Default |EDIFACT Default Hex
Field Character Value
Tag Delimiter + (plus sign)
Segment Delimiter * (apostrophe) 0x27
Element Delimiter + (plus sign) 0x2B
Sub Element Delimiter : (colon) Ox3A
Decimal Separator . (period) Ox2E
Release Character ? (question mark) Ox3F
Procedure  Usethis procedure to set EDI delimiters.
Sep Action
1 Click the INVOIC fileicon with the right mouse button and select
Properties from the shortcut menu.
System Response
The system displays the File Format Properties dialog.
2 Select the Delimiter s tab to access the Delimeters dial og.
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(Contd)
Sep Action

3 Verify that the correct delimiters are being used for the EDIFACT 92.1
standard. If the delimiters differ from the default values listed in the
previous table, you can enter either the character or the hexadecimal
value.

Note
If you use the default hex value, the value must begin with “0x” (the
number zero and the letter “x”).

Note

The Stream segments check box on the Delimiters dialog currently is not
selected. For thistutorial, leaveit cleared so that the translator will
continue to insert a carriage return after every segment.

4 Click OK to save the delimiters and exit the Delimiters dialog.
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Modify Form Components

Promoting, Splitting, and Changing Segments and Groups

Introduction The Promote function extracts one iteration (instance) of a group or repeating segment.
Promote is a specialized function that preserves the integrity of the EDI structure.

The Split function enables you to split (break) a group or repeating segment into two
loops. This function is useful when you need more than one instance of the same form
component that occurs multiple times. When you split agroup, the Promote flag is not set.
If you want the split group to be displayed on the parent frame, you must set the Promote
flag after you split the group.

A segment or group with amaximum use greater than one repeats (loops) and is placed on
a separate frame than the segment or group to which it is subordinate. A segment or group
with a maximum use of one does not repeat and itsfields are displayed on the same frame
as the group or segment to which they are subordinate.

You must promote, split, and change the maximum use of the groups and segments before
you generate the form (display the fieldsin the Layout Window). By customizing the
group and segment propertiesfirst, al fields are placed on their appropriate frames the
first timeyou generate the form. If you promote, split, and change the maximum use of the
groups and segments after you generate the form, the fields will be placed on several more
frames than will be present ultimately in the form. Changing the group and segment
properties before you first generate the form enables the fields to be placed on as few
frames as necessary.

Sterling Gentran:Server — May 2011 Forms Integration EDIFACT Tutorial Guide



Creating a Screen Entry Form Modifying the DTM Segment

Modifyingthe DTM Segment

Overview

How to changethe
maximum use of
the DTM segment

This section describes how to:
» change the maximum use of the DTM segment
» change the maximum use of the DTM:2 segment

The DTM segment contains the Date/Time Reference Numbers for the invoice. The DTM
segment is used for the invoice date associated with the invoice number (in the BGM
segment). The standard allows the DTM segment to be used up to 35 timesin one invoice.
You will use the DTM segment only once (for the invoice date). You will change the
maximum use of the DTM segment to one, which will place the associated fields on the
main Invoice Message frame with the majority of the invoice fields.

Use this procedure to change the maximum use of the DTM segment.

Sep Action
1 Click the DTM segment with the right mouse button to access the shortcut
menu.
2 Select Properties from the shortcut menu.

System Response
The system displays the Segment Properties dial og.

EDI Segment Properties E

Marme |Special| Key Fieldl Displayl Lnnpingl Loop Extended Hulesl

Fleasze enter the name :
LT k4

Please enter a short deszcription
DATESTIME/PERIOD

QK. I Cancel Lpply Help

3 Select the L ooping tab.
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How to changethe
maximum use of
the DTM:2
segment

Creating a Screen Entry Form

(Contd)
Sep Action
4 In the Max Usage box, enter 1 to designate that this segment can be used
only once per invoice.
5 Click OK to exit the Segment Properties dialog.

The DTM:2 segment (in the RFF group) contains the Date/Time Reference information
for the reference. In thistutorial, the DTM:2 segment is used for the purchase order date
associated with the purchase order number (in the RFF segment). The standard allows the
DTM:2 segment to be used up to five times each time the RFF group is used. You need use
the DTM:2 segment once (for the purchase order date). You will change the maximum use
of the DTM:2 segment to one, which will place the associated fields on the main Invoice
M essage frame with the majority of the invoice fields.

Use this procedure to change the maximum use of the DTM:2 segment.

Sep Action

1 Click the DT M: 2 segment (in the RFF group) with the right mouse button
and select Properties from the shortcut menu.
System Response
The system displays the Segment Properties dialog.

2 Select the L ooping tab.

3 In the Max Usage box, enter 1.

4 Click Yes at the prompt.

5 Click OK to exit the Segment Properties dialog.
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Modifying the RFF Group

Overview

How to split the
RFF group

This section describes how to:

» split the RFF group
» promote the RFF:2 group to the parent frame, and
» change the maximum use of the RFF group

The standard allows the RFF group (Reference) to be used up to 10 timesin oneinvoice. If
the invoice were generated now, the fields associated with the RFF group would be
displayed on a separate frame than the majority of the invoice fields. You need two
iterations of the RFF group, each with a maximum use of one. You will enter the purchase
order number and date in the first RFF group and the contract number and date in the
second RFF group.

You need to split the RFF group to obtain a second iteration of the RFF group (the new
RFF group will be named RFF:2), then you need to change the maximum use of the
original group (RFF).

Use this procedure to split the RFF group.

Sep Action

1 Click the RFF group with the right mouse button and select Split from
the shortcut menu.

2 Click Yes at the prompt.

System Response
The system displays the Split dialog.

S plit

First Loop E ntries IU

Cahicel |

3 In the First Loop Entries box, enter 1 to indicate that you want the RFF
group to be split after the first iteration. The resulting split will generate
one RFF group (RFF:2) that has a maximum use of one, and will retain
the original RFF group (with a maximum use of nine).

4 Click OK to exit the Split dialog.
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Creating a Screen Entry Form

How to promote  Use this procedure to promote the RFF:2 group to the parent frame.

the RFF:2 group to

the parent frame Sep

Action

1

Click the RFF:2 group with the right mouse button and select Properties
from the shortcut menu.

System Response
The system displays the Group Properties dialog.

Group Properties E3
N ame | Displa_l,ll Lnnpingl Loop Extended Hulesl

Please enter the name :

Flzaze enter a short description :

QK. I Cancel Lpply Help

Select the Display tab.

Select the Promote group to parent frame check box to display the
fieldsin this group on the same frame as the fields in the parent group.

Note

Although this group has a maximum use of one, if you do not check the
Promote group to parent frame check box, then the fieldsin this group are
not displayed on the same frame in the Layout Window asthefieldsin the
parent group.

Click OK to exit the Group Properties dialog.
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Modifying the RFF Group

How to changethe  Use this procedure to change the maximum use of the RFF group.

maximum use of

the RFF group Sep

Action

1

Click the RFF group with the right mouse button and select Properties
from the shortcut menu.

System Response
The system displays the Group Properties dialog.

Select the L ooping tab.

In the Max Usage box, enter 1 to designate that this group can be used
only once per invoice.

Select the Display tab.

Select the Promote group to parent frame check box to display the
fieldsin this group on the same frame as the fields in the parent group.

Note

If you change the maximum usage of this group, but do not select the
Promote group to parent frame check box, then the fieldsin this group will
not be displayed on the same framein the Layout Window asthefieldsin
the parent group.

Click OK to exit the Group Properties dialog.

Forms Integration EDIFACT Tutorial Guide
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Modifying the NAD Group

Overview  This section describes how to:
» copy and change the maximum use of the NAD group
» copy and paste the NAD group

How to copy and The standard allows the NAD group (Name and Address) to be used up to 20 timesin one
changethe invoice. If theinvoice were generated now, the fields associated with the NAD group
maximum useof  would be displayed on a separate frame than the magjority of the invoice fields. You know
the NAD group  that your users complete the fieldsin thisiteration of the NAD group only once per
invoice. You need to change the maximum use of the NAD group to one, which movesthe
Name and Address fields to the parent frame (the main Invoice Message frame).

After you change the maximum use of the NAD group, you need to copy the NAD group
and paste the copy at the same level asthe original group to create a second iteration of the
NAD group. Userswill enter the Ship To name and address in the first iteration of the
NAD group, and they will enter the Remit To name and address in the second iteration of
the NAD group (NAD:2).

Use this procedure to change the maximum use of the NAD group

Sep Action

1 Click the NAD group with the right mouse button and select Properties
from the shortcut menu.

System Response
The Group Properties dialog is displayed.

2 Select the L ooping tab.

3 In the Max Usage box, enter 1.

4 Select the Display tab.

5 Select the Promote group to parent frame check box to display the
fieldsin this group on the same frame as the fields in the parent group.

6 Click OK to exit the Group Properties dialog.

Sterling Gentran:Server — May 2011 Forms Integration EDIFACT Tutorial Guide



Creating a Screen Entry Form

Modifying the NAD Group

How to copy and Use this procedure to copy and paste the NAD group.

pastethe NAD

group Sep

Action

1

Verify that the NAD group is selected.

Click Copy on the Main Toolbar.

Click Paste on the Main Toolbar to paste the NAD group after the existing
NAD group.

System Response

Sterling Gentran: Server prompts you to specify whether you want the
contents of the clipboard pasted as a child (subordinate) of the selected
group, or at the same level as the group.

Click the Paste after selected item (at the same level) option to paste the
Clipboard contents after the original NAD group. The pasted NAD group
isnamed NAD:2.

Click OK to exit the dialog.

Forms Integration EDIFACT Tutorial Guide
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Modifying the PAT Group

Overview

How to changethe
maximum use of
the PAT group

This section describes how to change the maximum use of the PAT group.

The standard allows the PAT group (Payment Terms) to be used up to 10 timesin one
invoice. If theinvoice were generated now, the fields associated with the PAT group would
be displayed on a separate frame than the majority of the invoice fields. For this tutorial,
you know that your users complete the fields in the PAT group only once per invoice. You
need to change the maximum use of the PAT group to one, which moves the Payment
Termsfieldsto the main Invoice Message frame.

Use this procedure to change the maximum use of the PAT group.

Sep Action

1 Click the PAT group with the right mouse button and select Properties
from the shortcut menu.

System Response
The Group Properties dialog is displayed.

2 Select the L ooping tab.

3 In the Max Usage box, enter 1.

4 Select the Display tab.

5 Select the Promote group to parent frame check box.

6 Click OK to exit the dialog.
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Modifying the LIN Group

Overview  This section describes how to:
» change the maximum use of the PIA segment
» change the maximum use of the IMD:2 segment
» change the maximum use of the MEA:2 segment
» change the maximum use of the QTY:2 segment
» change the maximum use of the DTM:11 segment
» change the maximum use of the MOA group
» change the maximum use of the TDT group

How to changethe  ThePIA segment (in the LIN group) contains the Additional Product ID for each line
maximum use of item. The standard allows the PIA segment to be used up to 25 times per line item. Your
the PIA segment users use the PIA segment only once per line item (for the product code). You need to

change the maximum use of the PIA segment to one, which places the associated fields on
the frame containing other line item fields.

Use this procedure to change the maximum use of the PIA segment.

Sep Action

1 Click the PI A segment (in the LIN group) with the right mouse and select
Properties from the shortcut menu.

System Response
The Segment Properties dialog is displayed.
EDI Segment Properties
Name |Special| Key FieIdI Displa_l,.ll Loopingl Loop Estended Hulesl

Pleaze enter the name
Pla)

Flease enter a short description :
ADDITIONAL PRODUCT 1D

Ok I Cancel Sl Help

2 Select the L ooping tab.
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How to changethe
maximum use of
the M D:2 segment

How to changethe
maximum use of
the MEA:2
segment

(Contd)
Sep Action
3 In the Max Usage box, enter 1.
4 Click OK to exit the Segment Properties dialog.

The IMD:2 segment (in the LIN group) contains the Item Description for each lineitem.
The standard allowsthe IMD:2 segment to be used up to 10 times per lineitem. Your users
use the IMD:2 segment only once per line item (for the free-form description). You need
to change the maximum use of the IMD:2 segment to one, which places the associated
fields on the frame containing other line item fields.

Use this procedure to change the maximum use of the IMD:2 segment.

Sep Action

1 Click the IMD:2 segment (in the LIN group) with the right mouse button
and select Properties from the shortcut menu.

System Response
The Segment Properties dialog is displayed.

2 Select the L ooping tab.
3 In the Max Usage box, enter 1.
4 Click OK to exit the Segment Properties dialog.

The MEA:2 segment (in the LIN group) contains the Measurements for each line item.
The standard allows the MEA:2 segment to be used up to five times per lineitem. Your
users use the MEA:2 segment only once per line item (for the unit of measure). You need
to change the maximum use of the MEA:2 segment to one, which places the associated
fields on the frame containing other line item fields.

Use this procedure to change the maximum use of the MEA:2 segment.

Sep Action

1 Click the MEA:2 segment (in the LIN group) with the right mouse button
and select Properties from the shortcut menu.

System Response
The Segment Properties dialog is displayed.

2 Select the L ooping tab.
3 In the Max Usage box, enter 1.
4 Click OK to exit the Segment Properties dialog.
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How to changethe
maximum use of
the QTY:2 segment

Modifying the LIN Group

The QTY:2 segment (in the LIN group) contains the Quantity for each line item. The
standard allows the QTY:2 segment to be used up to five times per line item. Your users
use the QTY:2 segment only once per line item (for the invoiced quantity). You need to
change the maximum use of the QTY:2 segment to one, which places the associated fields
on the frame containing other line item fields.

Use this procedure to change the maximum use of the QTY:2 segment.

Sep Action

1 Click the QTY:2 segment (in the LIN group) with the right mouse button
and select Properties from the shortcut menu.
System Response
The Segment Properties dialog is displayed.

2 Select the L ooping tab.

3 In the Max Usage box, enter 1.

4 Click OK to exit the Segment Properties dial og.

How to changethe
maximum use of
theDTM:11
segment

The DTM:11 segment (in the LIN group) contains the Date/Time/Period for each line
item. The standard allows the DTM:11 segment to be used up to 35 times per line item.
Your users use the DTM:11 segment only once per line item (for the date shipped). You
need to change the maximum use of the DTM:11 segment to one, which places the
associated fields on the frame containing other line item fields.

Use this procedure to change the maximum use of the DTM:11 segment.

Forms Integration EDIFACT Tutorial Guide

Sep Action

1 Click the DTM: 11 segment (in the LIN group) with the right mouse
button and select Properties from the shortcut menu.
System Response
The Segment Properties dialog is displayed.

2 Select the L ooping tab.

3 In the Max Usage box, enter 1.

4 Click OK to exit the Segment Properties dialog.

Sterling Gentran:Server — May 2011



Modifying the LIN Group Creating a Screen Entry Form

How to changethe
maximum use of
the MOA group in
theLIN group

How to changethe
maximum use of
the TDT group

The standard allows the MOA group (Monetary Amount) in the LIN group to be used up
to five times per line item. If the invoice were generated now, the fields associated with
the MOA group would be displayed on a separate frame than the magjority of the line item
fields. For thistutorial, you know that your users will complete the fields in the MOA
group only once per lineitem. You will change the maximum use of the MOA group to
one, which will place the Monetary Amount fields on the frame containing other line item
fields.

Use this procedure to change the maximum use of the MOA group.

Sep Action

1 Click the M OA group (in the LIN group) with the right mouse button and
select Properties from the shortcut menu.

System Response
The Group Properties dialog is displayed.

2 Select the L ooping tab.

3 In the Max Usage box, enter 1.

4 Select the Display tab.

5 Select the Promote group to parent frame check box.

6 Click OK to exit the Group Properties dialog.

The standard allows the TDT group (Details of Transport) in the LIN group to be used up
to five times per line item. If the invoice were generated now, the fields associated with
the TDT group would be displayed on a separate frame than the majority of the line item
fields. For thistutorial, you know that your users will completethefieldsinthe TDT
group only once per line item. You will change the maximum use of the TDT group to
one, which will place the Details of Transport fields on the frame containing other line
item fields.

Use this procedure to change the maximum use of the TDT group.

Sep Action

1 Click the TDT group (in the LIN group) with the right mouse button and
select Properties from the shortcut menu.

System Response
The Group Properties dialog is displayed.

2 Select the L ooping tab.

3 In the Max Usage box, enter 1.

4 Select the Display tab.
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How to changethe
maximum use of
the CNT segment

How to changethe
maximum use of
the MOA group

(Contd)
Sep Action
5 Select the Promote group to parent frame check box.
6 Click OK to exit the Group Properties dialog.

The CNT segment contains the Control Totals for each line item. The standard allows the
CNT segment to be used up to 10 times per line item. Your users use the CNT segment
only once per line item (for the total number of line items). You need to change the
maximum use of the CNT segment to one, which moves the Control Total fields to the
main Invoice Message frame.

Use this procedure to change the maximum use of the CNT segment.

Sep Action

1 Click the CNT segment with the right mouse button and select Properties
from the shortcut menu.

System Response
The system displays the Segment Properties dial og.

2 Select the L ooping tab.
3 In the Max Usage box, enter 1.
4 Click OK to exit the Segment Properties dialog.

The standard allows the MOA group (Monetary Amount), in the summary section, to be
used up to one hundred times per invoice. If the invoice were generated now, the fields
associated with the MOA group would be displayed on a separate frame than many of the
invoice fields.You know that your users complete the fields in the MOA group only once
per invoice. You need to change the maximum use of the MOA group to one, which places
the Monetary Amount fields on the main Invoice Message frame.

Use this procedure to change the maximum use of the MOA group.

Sep Action

1 Click the M OA group with the right mouse button and select Properties
from the shortcut menu.

System Response
The Group Properties dialog is displayed.

2 Select the L ooping tab.

3 In the Max Usage box, enter 1.
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(Contd)
Sep Action

4 Select the Display tab.

5 Select the Promote group to parent frame check box.

6 Click OK to exit the Group Properties dialog.
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Generating the Form

Generating the Form

Overview  Generating aform is different from compiling aform. When you generate aform, the
fields of the form are displayed on aframe in the Layout Window (right side of the Forms
main window) based on the groups, segments, and elements that are activated. When you
compile aform, the source form is trandated into a compiled translation object.

Note

You should regenerate your form several times to ensure that you are viewing the most
recent changes to the Layout Window.

Procedure  Usethis procedure to generate the screen entry form based on the groups, segments, and
elements you activated.

Step

Action

1

Select the INVOIC fileicon. Selecting the INVOIC file icon before you
generate the layout enables you to view the beginning of the invoice
layout in the Layout Window after the layout is generated. Thisisnot a
required prerequisite to generating the layout.

Click Generate L ayout on the Main Toolbar.

System Response
The screen entry form layout is displayed in the Layout Window.
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After generating  When you generate the form, there is one field on the right side of your screen (Layout
theform Window) for every activated element on the left side of your screen (EDI File Format
Window).

Note

Asyou customize the form, you will change some of the labels and remove others so al
the fields will not be labeled the same as their corresponding elements. Even though you
will change or remove some field labels, each field still corresponds to one element.

When the screen entry form is generated, the fields associated with each non-repeating
segment or group are displayed on aframein the Layout Window. If a segment or group is
defined as repeating, alist is displayed on the parent frame, and the fields for that
repeating segment or group are displayed on a separate frame.

All framesin ascreen entry form aretitled. The default title for each frameisits message,
group, or segment name, but you can change the default titles to better identify the
information that will be entered.
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Overview

Customize the EDI Data

Overview

Introduction

How to set up the
document name

You can customize the form, including the properties of each type of form component
(group, segment, and element).

Customizing the formis an iterative process. Thistutorial guides you through al the steps
involved in customizing the form, component by component. When you create forms, you
usually activate the form components you need to use, customize and format the form
components, then compile the form and test the translation object (and print areport, if
necessary). As you substantially customize the form, you usually compile the form and
test the translation object several times to view your changes before the form truly is
finalized.

This section explains how to customize the form components for each sequential
component in thistutorial.

We recommend that you set up a Document Name for each form. The document name
makes the identification of adocument created by the form easier in Sterling

Gentran: Server. Setting up the document name enables you to differentiate between
documentsin the document browsersin Sterling Gentran: Server. We strongly recommend
that you select an element that occurs only once in the message and has a data type of
string. For an EDIFACT 92.1 invoice, the document name is usually the Document/

M essage Number.
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Creating a Screen Entry Form

Use this procedure to set up the document name.

Sep

Action

Double-click the BGM 05 element.

Recommendation

We recommend that you select this element because it is a non-recurring
and mandatory element, and it will help identify this message
meaningfully in Sterling Gentran: Server.

System Response
The Element Properties dialog is displayed.

Element Properties E

Marme |\-"alidation| Displayl Help I Estended Hulel Standard Hulel Eonditinnsl

Fleasze enter the name :
1004

Please enter a short deszcription
DOCUMENT /MESSAGE MUUMBER

QK. I Cancel Lpply Help

Select Sandard Ruletab.

Select Update from the list.

Click Yes at the prompt.

From the Table (or group) to update list, select Document Record to
indicate that you are updating the document record in Sterling
Gentran: Server.
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(Contd)
Sep Action

6 From the Field list, select Document Name to indicate that you are
updating the Name field (in the Sterling Gentran: Server document
browsers that contain this message) with the contents of the BGM05
element.

System Response
The dialog now should look like this:

Element Properties

N ame |Va|idatinn| Displa_l,JI Help I Extended Hulel Standard Hulel Cnnditionsl

Please enter the name
1004

Fleaze enter a short dezcription :
DOCUMENT/MESSAGE MUMBER

Ok I Cancel Spply Help

7 Click OK to set up the document name.
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Customizing the BGM Segment

Overview

How to customize
the BGM 05
element

The BGM segment contains the Beginning of Message for the invoice. This mandatory
segment contains information that is pertinent to the entire invoice.

The BGMO05 element contains the Document/M essage Number. This element is defined
by the standard to be a string of 35 a phanumeric characters. You know that the invoice
number your users enter is always an eight-character al phanumeric string so you need to
change the element and field lengths to accommodate the shorter invoice number. You
also need to rename the field label and add Help text to the field.

Use this procedure to change the field and element Iengths, rename the field label, and add
Help text to the Document/M essage Number field.

Sep Action
1 Double-click the BGM 05 element.
System Response
The Element Properties dialog is displayed.
2 Select the Validation tab.
3 In the Max box, enter 8 for the maximum number of characters allowed

for this element.
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(Contd)
Sep Action

4 Select the Display tab.

System Response
The system displays the Display Properties dialog box.

Element Properties E3

Mame I Yalidation Display |He||:| I Extended Hulel Standard Hulel Eonditinnsl

How should thiz field be used on the form :
& the field should be editable
' the field should be displayed but not editable
" the field should not appear on the form

Please enter the label far thiz fisld :

Document/Mezzage Mumber

Please enter the masimum number of characters to be displayed |35

Please enter the initial value of thiz field ;

QK. I Cancel | Lpply | Help

5 In the Label box, enter Invoice No. to replace the existing text.

6 In the Maximum number of characters to be printed box, enter 8 to allow
eight charactersto be entered in thisfield.

7 Select the Help tab.

8 In the Help Text box, enter the following text:

Enter the invoice number. Theinvoice number cannot
exceed 8 alphanumeric characters.

9 Click OK to exit the dialog.
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Customizingthe DTM Segment

Overview  The DTM segment (Date/Time/Period) is used to enter the invoice date. The standard
allowsthe DTM segment to be used up to 35 times per invoice. You will usethe DTM
segment only once per invoice. You have already changed the maximum use of the DTM
segment to obtain just one instance of the DTM segment and to place the invoice date on
the same frame as the invoice number.

How to customize  The DTMO1 element contains the Date/Time/Period Qualifier, amandatory three-
theDTMO1 character code that qualifiesthe date that follows (in the DTMO02 element). You know that
dement the only type of date your users enter in the Date/Time/Period element (DTM02) isan
invoice number so you need to define a constant value for the Date/Time/Period Qualifier
field, designating that the constant 3 (Invoice Date/Time) always qualifies the date in the
Date/Time/Period field. You need to hide the qualifier field because it does not need to be
displayed in the translation object.

When a user enters the invoice date in the Date/ Time/Period field, the system
automatically assigns the code 3 to the Date/Time/Period Qualifier field.

Use this procedure to define a constant value in the Date/Time/Period Qualifier field and

hide the field.
Sep Action
1 Double-click the DTM 01 element.

System Response
The Element Properties dialog is displayed.

2 Select the Sandard Rule tab.
3 Select Use Constant from the list.
4 Click Edit to access the Map Constants dialog.
5 Click New to access the Edit Constant dial og.
I} Type
| | [ ]

Walue Cancel |

6 In the ID box, enter I nvoice Date/Time to identify the constant.

7 From the Typelist, select Sring to indicate that the literal constant will be
formatted as a string data type.
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Customizing the DTM Segment

(Contd)
Sep

Action

8

In the Value box, enter 3 to indicate that the Date/Time/Period Qualifier
field must contain the invoice date. This value is the actual value of the
literal constant.

Click OK to add the constant.

10

Click Closeto exit the Map Constants dialog.

11

From the Constants list, select 3 to identify the constant that will be used
for this element.

12

From the Qualifies list, select 2380 DATE/TIME/PERIOD, which isthe
element that the Date/Time/Period Qualifier field qualifies.

The dialog should now should look like this:

Element Properties E3
Mame I Y alidation | Drizplay | Summary List I Help
Extended Rule Standard Rule | Conditions
Flease select the standard rule bo uze ; IUse Constant j

Flease select a constant to store in this field :
E x| Edit |

If this constant iz a qualifier for another field, Gentran can automatically use the
exiztence of data in that field to determine whether to execute this standard rule. Ta
take advantage of this feature, simply select the field to be qualified :

JATE/TIME/PERIOD

QK I Cancel S Help

13

Select the Display tab.

14

Click the Thisfield should not appear on the form option to prevent the
field from being displayed in the trand ation object.

15

Click OK to exit the Display Properties dialog.
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How to customize  The DTMO2 element (Date/Time/Period) contains the invoice date. The standard allows
theDTMOQ2  thisfield to contain up to a 35 character string but your users enter shorter dates. You need
eement to change the element and field lengths to accommaodate the shorter dates and then rename
thefield label.

Use this procedure to change the element and field lengths, rename the field label, and add
Help text to the Date/Time/Period field.

Sep Action

1 Double-click the DTM 02 €l ement.

System Response
The Element Properties dialog is displayed.

2 Select the Validation tab.

3 In the Max box, enter 8 to allow the entire date, including separators
(/), to be contained in this element.

4 Select the Display tab.

5 In the Label box, enter Invoice Date.

6 In the Maximum number of charactersto be printed box, enter 8.
7 Select the Help tab.

8 In the Help Text box, enter the following text:

Enter theinvoice date. Usetheformat MM/DD/YY.

9 Click OK to exit the diaog.
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Customizing the RFF:2 Group

Overview  The RFF:2 group (Reference) is used to enter the purchase order number (RFF:11
segment) and date (DTM:22 segment). You have aready promoted the RFF:2 group to
place the purchase order number and date on the main Invoice Message frame.
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Customizing the RFF: 11 Segment

Overview  The RFF:11 segment (Reference) is used to enter the purchase order number. Your users
enter the purchase order number in the Reference Number element (RFF:1102). You need
to set aconstant in the Reference Qualifier element so that the constant value is entered
automatically when a user enters the purchase order number.

How to customize  The RFF:1101 element contains the Reference Qualifier, a mandatory three-character
the RFF:1101 code that identifies the type of reference that follows (in the RFF:1102 element). You
dement know that the only type of reference your users enter in the Reference Number element is
the purchase order number so you need to define a constant value for the Reference
Qualifier field, designating that the constant “ON” (Order Number (Purchase)) always
qualifies the reference in the Reference Number field. You must also hide the qualifier
field because it does not need to be displayed in the transl ation object.

When a user enters the purchase order number in the Reference Number field, the system
automatically assigns the code ON to the Reference Qualifier field.

Use this procedure to define a constant value in the first Reference Qualifier field and hide

thefield.
Sep Action
1 Double-click the RFF: 1101 element (in the RFF:2 group).
System Response
The Element Properties dialog is displayed.
2 Select the Sandard Rule tab.
3 Select Use Constant from the list.
4 Click Edit to access the Map Constants dialog.
5 Click New to access the Edit Constant dial og.
I} Type
| |
Walue
|
6 In the ID box, enter Order Number to identify the constant.
7 From the Type list, select String.
8 In the Value box, enter ON.
9 Click OK to add the constant.
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(Contd)
Sep Action

10 Click Close to exit the Map Constants dial og.

11 From the Constants list, select ON.

12 From the Qualifieslist, select 1154 REFERENCE NUMBER, whichis
the element that the Reference Qualifier field qualifies.

The dialog should now should look like this:

Element Properties E3

Hame I W alidation | Drizplay | Summary List I Help
Extended Rule Standard Rule | Conditions
Please select the standard rule to uze IUse Constant j

Please select a constant to store in this field ;
iy x| Edit |

f this constant iz a qualifier for anather field, Gentran can automatically use the
exiztence of data in that field to determine whether to execute thiz standard rule. To
take advantage of this feature, simply select the field to be qualified :

1154 REFEREMCE NUMBER

QK I Cancel S Help

13 Select the Display tab.

14 Click the Thisfield should not appear on the form option to prevent the
field from being displayed in the trand ation object.

15 Click OK to exit the diaog.
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How to customize  The RFF:1102 element contains the Reference Number. This element is defined by the
the RFF:1102  standardto be astring of 35 alphanumeric characters. You know that the reference number
dement (the purchase order number) is a 10-character alphanumeric string, so you need to change
the element and field lengths to accommodate the shorter reference number. In addition,
you must rename the field label and add Help text to the field.

Use this procedure to change the field and element lengths, rename the field label, and add
Help text to the first Reference Number field.

Step

Action

1

Double-click the RFF:1102 € ement.

System Response
The Element Properties dialog is displayed.

Select the Validation tab.

In the Max box, enter 10.

Select the Display tab.

In the Label box, enter P.O. No. (note the period included in the label) to
replace the existing field label.

In the Maximum number of charactersto be printed box, enter 10.

Select the Help tab.

In the Help Text box, enter the following text:

Enter the purchase order number. The purchase order
number cannot exceed 10 alphanumeric characters.

Click OK to exit the sdiaog.
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Customizingt

Overview

How to customize
the DTM:2201
element

Customizing the DTM:22 Segment

he DTM:22 Segment

The DTM:22 segment (Date/Time/Period) is used to enter the purchase order date. The
standard allows the DTM:22 segment to be used up to five times per invoice. You use the
DTM:22 segment only once per invoice. You have already changed the maximum use of
the DTM:22 segment to obtain just one instance of the segment and to place the purchase
order date on the same frame as the invoice date and number.

The DTM:2201 element contains the Date/Time/Period Qualifier, a mandatory three-
character code that identifiesthe type of datethat follows. The only type of date your users
enter in the Date/Time/Period element (DTM:2202) that followsis the purchase order date
S0 you need to define a constant value for the Date/Time/Period Qualifier field,
designating that the constant 4 (Order Date/Time) always qualifies the date in the Date/
Time/Period field. Then you need to hide the qualifier field because it does not need to be
displayed in the translation object.

When a user enters the purchase order date in the Date/Time/Period field, the system
automatically assigns the code 4 to the Date/Time/Period Qualifier field.

Use this procedure to define a constant value in the first Date/Time/Period Qualifier field
and hide the field.

Sep Action

1 Double-click the DTM:2201 e ement.

System Response
The Element Properties dialog is displayed.

2 Select the Sandard Rule tab.
3 Click Use Constant from the list.
4 Click Edit to access the Map Constants dialog.
5 Click New to access the Edit Constant dial og.

Edit Constant

I} Tupe

| |

Walue

|
6 Inthe ID box, enter Order Date/Timeto identify the constant.
7 From the Type list, select String.
8 In the Value box, enter 4 to indicate that the Date/Time/Period Qualifier

field must contain the purchase order date.
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(Contd)
Sep

Action

9

Click OK to add the constant.

10

Click Close to exit the Map Constants dial og.

11

From the Constants list, select 4 to identify the constant that will be used
for this element.

12

From the Qualifies list, select 2380 DATE/TIME/PERIOD, which isthe
element that the Date/Time/Period Qualifier field qualifies.

13

Select the Display tab.

14

Click the Thisfield should not appear on the form option.

15

Click OK to exit the dialog.

How to customize  The DTM:2202 element (Date/Time/Period) contains the purchase order date. The
theDTM:2202  standard allowsthisfield to contain up to a 35 character string but your users enter shorter
dement dates. You need to change the element and field lengths to accommodate the shorter dates,
rename the field label and add Help text.

Use this procedure to change the element and field lengths, rename the field label, and add
Help text to the first Date/Time/Period field.

Step

Action

1

Double-click the DTM:2202 element.

System Response
The Element Properties dialog is displayed.

Select the Validation tab.

In the Max box, enter 8.

Select the Display tab.

In the Label box, enter P.O. Date.

In the Maximum number of characters to be printed box, enter 8.

Select the Help tab.

In the Help Text box, enter the following text:

Enter the purchase order date. Usethe format MM/DD/YY.

Click OK to exit the dialog.
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Customizing the RFF Group

Overview  The RFF group (Reference) is used to enter the contract number (RFF segment) and date
(DTM:2 segment).
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Customizing the RFF Segment

Overview  The RFF segment (Reference) is used to enter the contract number. Your users enter the
contract number in the Reference Number element, and you will set a constant in the
Reference Qualifier element so that the constant value is entered automatically when the
users enter the contract number.

How to customize  The RFF01 element contains the Reference Qualifier, amandatory three-character code
the RFF01 element that identifies the type of reference that follows. You know that the only type of reference
your users enter in the Reference Number element (RFF02) is the contract number, so you
need to define a constant value for the Reference Qualifier field, designating that the
constant CT (Contract Number) always qualifies the reference in the Reference Number
field. You need to hide the qualifier field because it does not need to be displayed in the
tranglation object.

When a user enters the contract number in the Reference Number field, the system
automatically assigns the code CT to the Reference Qualifier field.

Use this procedure to define a constant value in the second Reference Qualifier field and
hide the field.

Sep Action

1 Double-click the RFF01 element.

System Response
The Element Properties dialog is displayed.

2 Select the Sandard Rule tab.
3 Select Use Constant from the list.
4 Click Edit to access the Map Constants dialog.
5 Click New to access the Edit Constant dial og.
[n] Type
| | [ ]

Walue Cancel |

6 In the ID box, enter Contract Number to identify the constant.
7 From the Typelist, select String.
8 In the Value box, enter CT to indicate that the Reference Qualifier field

must contain the contract number.
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Customizing the RFF Segment

(Contd)
Sep

Action

9

Click OK to add the constant.

10

Click Close to exit the Map Constants dial og.

11

From the Constants list, select CT to identify the constant that will be
used for this element.

12

From the Qualifieslist, select 1154 REFERENCE NUMBER, whichis
the element that the Reference Qualifier field qualifies.

The dialog should now should look like this:

Element Properties E2
M armne I " alidation | Dizplay | Surnrnary List I Help
Extended Rule Standard Rule | Conditions
Flease zelect the standard rule to use IUse Coriztant L]

Fleaze select a constant ta stare in this field ;

CT =] | Edt. |

f this constant iz a qualifier for anather field, Gentran can automatically use the
exiztence of data in that field to determine whether to execute thiz standard rule. To
take advantage of this feature, simply select the field to be qualified ;

154 REFERENCE MUMBER

ak Cancel Sl Help

13

Select the Display tab.

14

Select the Thisfield should not appear on the form option.

15

Click OK to exit the dialog.
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How to customize  The RFF02 element contains the Reference Number. This element is defined by the
the RFF02 element standard to be astring of 35 alphanumeric characters. You know that the reference number
(the contract number) is always an eight-character al phanumeric string, so you need to
change the element and field lengths to accommodate the shorter reference number. You
need to rename the field label and add Help text to the field.

Use this procedure to change the field and element lengths, rename the field label, and add
Help text to the second Reference Number field.

Step

Action

1

Double-click the RFF02 element.

System Response
The Element Properties dialog is displayed.

Select the Validation tab.

In the Max box, enter 8.

Select the Display tab.

In the Label box, enter Contract No. (note the period included in the
label) to replace the existing field label.

In the Maximum number of charactersto be printed box, enter 8.

Select the Help tab.

In the Help Text box, enter the following text:

Enter the contract number. The contract number cannot
exceed 8 alphanumeric characters.

Click OK to exit the diaog.
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Customizing the DTM:2 Segment

Customizing the DTM:2 Segment

Overview

How to customize
theDTM:201
element

The DTM:2 segment (Date/Time/Period) is used to enter the contract date. The standard
allowsthe DTM:2 segment to be used up to five times per invoice. You use this segment
only once per invoice. You have aready changed the maximum use of the DTM:2
segment to obtain just one instance of this segment, and to place the contract date on the
same frame as the invoice date and number.

The DTM:201 element contains the Date/ Time/Period Qualifier, a mandatory three-
character code that identifies the type of date that follows. You know that the only type of
date your users enter in the Date/Time/Period element (DTM:202) is the contract date so
you need to define a constant value for the Date/ Time/Period Qualifier field, designating
that the constant “92” (Contract Effective Date) always qualifies the date in the Date/
Time/Period field. Then, you need to hide the qualifier field because it does not need to be
displayed in the translation object.

When a user enters the contract date in the Date/Time/Period field, the system
automatically assigns the code 92 to the Date/Time/Period Qualifier field.

Use this procedure to define a constant value in the second Date/Time/Period Qualifier
field and hide the field.

Sep Action

1 Double-click the DTM:201 element.

System Response
The Element Properties dialog is displayed.

2 Select the Sandard Ruletab.
3 Select Use Constant from the list.
4 Click Edit to access the Map Constants dialog.
5 Click New to access the Edit Constant dial og.
Edit Constant E
1] Type
| | |

ralue Cancel |

6 In the ID box, enter Contract Effective Date.
7 From the Type option, select Sring.
8 In the Value box, enter 92 to indicate that the Date/Time/Period Qualifier

field must contain the contract date.
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(Contd)
Sep Action

9 Click OK to add the constant.

10 Click Close to exit the Map Constants dial og.

11 From the Constants option, select 92 to identify the constant that is used
for this element.

12 From the Qualifies option, select 2380 DATE/TIME/PERIOD, whichis
the element that the Date/Time/Period Qualifier field qualifies.

The dialog should now should look like this:

Element Properties
Mame I " alidation | Display | Summary List I Help
Extended Rule Standard Rule | Conditions
Fleasze select the standard rule to uge : IUse Constant L]

Flease select a constant to store in this field ;

52 =] | Edt. |

I thiz constant is & qualifier far another field, Gentran can automatically use the
existence of data in that field to determine whether to execute thiz standard mile. To
take advantage of this feature, zsimply select the field ta be qualified :

0 DATE/TIME/FERIOD

ak Cancel Sl Help

13 Select the Display tab.

14 Select the Thisfield should not appear on the form option.

15 Click OK to exit the dialog.
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Customizing the DTM:2 Segment

How to customize  The DTM:202 element (Date/Time/Period) contains the contract date. The standard allows
theDTM:202  thisfield to contain up to a 35 character string but your users enter shorter dates. You need
eement to change the element and field lengths to accommaodate the shorter dates. In addition, you

need to rename the field label and add Help text.

Use this procedure to change the element and field lengths, rename the field label, and add
Help text to the second Date/Time/Period field.

Step

Action

1

Double-click the DTM:202 element.

System Response
The Element Properties dialog is displayed.

Select the Validation tab.

In the Max box, enter 8.

Select the Display tab.

In the Label box, enter Contract Date

In the Maximum number of charactersto be printed box, enter 8.

Select the Help tab.

In the Help Text box, enter the following text:

Enter the contract date. Use the format MM/DD/YY.

Click OK to exit the diaog.
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Customizing the NAD Group

Overview  You have aready changed the maximum use and promoted the NAD group, then copied
the NAD group to create a second iteration of this group (NAD:2). Your users enter the
ship to name and addressin the first iteration of the NAD group, and the remit to name and
address in the second iteration of the group (NAD:2). By promoting the NAD group to the
parent frame before copying the group, you cause all the Ship To and Remit To fieldsto be
placed on the main Invoice Message frame.
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Customizing the NAD Segment

Customizing the NAD Segment

Overview

How to customize
the NADO1
element

The NAD segment (in the NAD group) identifies the Name and Address of an entity or
individual. In thisiteration of the NAD segment, users enter the Ship To name and address
for theinvoice.

The NADO1 element (in the NAD segment) contains the Party Qualifier, which is used to
identify whether the name and address information that follows pertains to the Ship To or
Remit To name. Your users enter only the Ship To name and address in the segment
associated with the first NAD group. You need to define the constant value “ ST” in the
Party Qualifier element, indicating that this group (NAD) contains only Ship To
information. You need to hide the Party Qualifier field because it does not need to be
displayed on the translation object.

Use this procedure to define a constant value for the Party Qualifier field and hide the
field.

Sep Action

1 Double-click the NADOL element (in the NAD group).

System Response
The Element Properties dialog is displayed.

2 Select the Sandard Rule tab.
3 Select Use Constant from the list.
4 Click Edit to access the Map Constants dialog.
5 Click New to access the Edit Constant dial og.
I} Type
| | [ ]

Walue Cancel |

6 In the ID box, enter Ship To to identify the constant.
7 From the Type option, select Sring.
8 In the Value box, enter ST to indicate that the Entity Identifier Code field

must contain the Ship To hame and address.

9 Click OK to add the constant.

10 Click Close to exit the Map Constants dial og.
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(Contd)
Sep Action
11 From the Constants option, select ST.

12 From the Qualifies option, select 3036 PARTY NAME, whichisthe
element that the Entity Identifier Code field qualifies.

The dialog should now should look like this:

Element Properties
Hame I W alidation | Display | Summary List I Help
Extended Rule Standard Rule | Conditions
Please select the standard rule to uge : IUse Constant L]

Please select a constant to store in this field ;

5T =] | Edt. |

If this constant iz a qualifier for another field, Gentran can automatically use the
exiztence of data in that field to determine whether to execute this standard rule. Ta
take advantage of thiz feature, simply select the field ta be qualified :

B PARTY NAME

ak Cancel Sl Help

13 Select the Display tab.

14 Select the Thisfield should not appear on the form option.

15 Click OK to exit the dialog.

How to customize  The NAD10 element (Party Name) contains the name of the entity or individual to whom
the NAD10 theorder will be shipped. Your users are familiar with the standard address format (the
dement name on the first line; the address on the next lineg(s); the city, state (or province or
country), and postal code on the last line). For this reason, you do not need to label the
fields containing the address, city, state, and postal code. You need to rename the field
label (so that your users know that the fields that follow contain the Ship To information)
and add Help text to the field.
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Customizing the NAD Segment

Use this procedure to rename the field label and add Help text to the first Party Name

field.

Sep

Action

1

Double-click the NAD10 element.

System Response
The Element Properties dialog is displayed.

Select the Display tab.

In the Label box, enter Ship To to replace the existing field label. This
label isthe heading for the Ship To name and address information.

Select the Help tab.

In the Help text box, enter the following text:

Enter the name of the person or organization to whom the
order will be shipped. The name cannot exceed 35
alphanumeric characters.

Click OK to exit the dialog.

How to customize  The addressinformation in the NAD16 element (in the NAD segment) corresponds to the
the NAD16 namein the NAD10 element so there is no need to display the label associated with the
dement address. For the NAD16 element, you need to remove the field label and add Help text.

Use this procedure to remove the field label and add Help text to the first Street and
Number/P.O. Box field of the Ship To address.

Sep

Action

1

Double-click the NAD16 element (in the NAD group).

System Response
The Element Properties dialog is displayed.

Select the Display tab.

In the Label box, delete the existing text.

Select the Help tab.

In the Help Text box, enter the following text:

Enter thefirst line of the address. This address line cannot exceed 35
alphanumeric characters.

Click OK to exit the dialog.
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How to customize  Use this procedure to remove the field label and add Help text to the second Street and
theNAD17  Number/PO. Box field of the Ship To address.

element

Step

Action

1

Double-click the NAD17 element (in the NAD group).

System Response
The Element Properties dialog is displayed.

Select the Display tab.

In the Label box, delete the existing text.

Select the Help tab.

In the Help Text box, enter the following text:

Enter the second line of the address. Thisaddress line cannot exceed
35 alphanumeric characters.

Click OK to exit the dialog.

How to customize  The NAD19 element contains the City Name of the Ship To address. You will remove the
theNAD19  field label for this element, because it will be evident to your users that they should enter
dement the city name associated with the name and street address they have entered already. Also,
you will change the element and field lengths, because the City Name field does not need
to be longer than thirty characters.

Use this procedure to remove thefield label, change the element and field lengths, and add
Help text to the City Namefield of the Ship To address.

Step

Action

1

Double-click the NAD19 element (in the NAD group).

System Response
The Element Properties dialog is displayed.

Select the Validation tab.

In the Max box, enter 30 for the maximum number of characters allowed
for this element.

Select the Display tab.

In the Label box, delete the existing text.

In the Maximum number of charactersto be printed box, enter 30.

Select the Help tab.
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Sep

Action

In the Help Text box, enter the following text:

Enter the city name. The city cannot exceed 30
alphanumeric characters.

Click OK to exit the dialog.

How to customize  The NAD20 element contains the Country Sub-Entity Identification. You need to remove
the NAD20 thefield label for thiselement, becauseit is evident to your usersthat they should enter the
dement country sub-entity identification (e.g., state) associated with the name and street address
they have entered already. Also, you need to change the field and element lengths because
this field does not need to be longer than two characters.

Use this procedure to remove thefield label, change the element and field lengths, and add
Help text to the Country Sub-Entity Identification field of the Ship To address.

Sep

Action

1

Double-click the NAD20 element (in the NAD group).

System Response
The Element Properties dialog is displayed.

Select the Validation tab.

In the Max box, enter 2.

Select the Display tab.

In the Label box, delete the existing text.

In the Maximum number of charactersto be printed box, enter 2.

Select the Help tab.

In the Help Text box, enter the following text:

Enter the country sub-entity identification. The code cannot exceed 2
alphanumeric characters.

Click OK to exit the dialog.

Forms Integration EDIFACT Tutorial Guide
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How to customize  Use this procedure to remove the field label and add Help text to the Postcode
theNAD21 Identification field.

element

Step

Action

1

Double-click the NAD21 element (in the NAD group).

System Response
The Element Properties dialog is displayed.

Select the Display tab.

In the Label box, delete the existing text.

Select the Help tab.

In the Help Text box, enter the following text:

Enter the postal code. The postal code cannot exceed 9 alphanumeric
characters. Do not enter a hyphen (-) beforethe 4-character postal
code extension (if used).

Click OK to exit the diaog.
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Customizing the NAD:2 Group

Overview  The NAD:2 group was created when you copied the NAD group to create a second
iteration of that group. Your users enter the Remit To name and addressin the NAD:2

group.
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Customizing the NAD: 3 Segment

Creating a Screen Entry Form

Overview  The NAD:3 segment (in the NAD:2 group) identifies the Name and Address of an entity
or individual. In the NAD:3 segment, your users enter the Remit To name and address for

the invoice.

How to customize  TheNAD:301 element (in the NAD:2) group contains the Party Qualifier, which isused to

the NAD: 301 identify whether the name and address information that follows pertains to the Ship To or
dement Remit To name. Your users enter only the Remit To name and address in the fields

associated with the NAD:2 group. You need to define the constant value “ RE” in the Party

Qualifier element, indicating that this group (NAD:2) contains only Remit To information.

You need to hide the Party Qualifier field, because it does not need to be displayed on the

tranglation object.

Use this procedure to define a constant value for the second Party Qualifier field and hide

thefield.

Sep

Action

1

Double-click the NAD: 301 element (in the NAD:2 group).

System Response
The Element Properties dialog is displayed.

Select the Sandard Rule tab.

Select Use Constant from the list.

Click Edit to access the Map Constants dialog.

Click New to access the Edit Constant dial og.

I} Type
| | =

Walue Cancel |

In the ID box, enter Remit To Party.

From the Typelist, select Sring.

In the Value box, enter RE to indicate that the Entity Identifier Codefield

must contain the Remit To name and address.

Click OK to add the constant.

10

Click Close to exit the Map Constants dial og.
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(Contd)
Sep Action
11 From the Constants list, select RE.

12 From the Qualifieslist, select 3036 PARTY NAME, whichisthe element
that the Entity Identifier Code field qualifies.

The dialog should now should look like this:

Element Properties
Mame I " alidation | Display | Summary List I Help
Extended Rule Standard Rule | Conditions
Fleasze select the standard rule to uge : IUse Constant L]

Flease select a constant to store in this field ;
RE i | Edi. |

f this constant iz a qualifier for anather field, Gentran can automatically use the
exiztence of data in that field to determine whether to execute thiz standard rule. To
take advantage of this feature, simply select the field to be qualified :

036 PARTY MAME

Ok Cancel Spply Help

13 Select the Display tab.

14 Select the Thisfield should not appear on the form option.

15 Click OK to exit the dialog.

How to customize  The NAD:310 element (Party Name) contains the name of the entity or individual to
the NAD:310  whom the invoice will be remitted. Your users are familiar with the standard address
dement  format (the name on thefirst line; the address on the next ling(s); the city, state (or
province or country), and postal code on the last lin€). For this reason, you do not need to
label the fields containing the address, city, state, and postal code. You need to rename the
field label (so that your users know that the fields that follow contain the remit to
information) and add Help text to the field.
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Use this procedure to rename the field and add Help text to the second Party Name field.

Sep

Action

1

Double-click the NAD: 310 element (in the NAD:2 group).

System Response
The Element Properties dialog is displayed.

Select the Display tab.

In the Label box, enter Remit To to replace the existing text. Thislabel is
the heading for the Remit To hame and address information.

Select the Help tab.

In the Help text box, enter the following text:

Enter the name of the person or organization to whom the invoice will
be remitted. The name cannot exceed 35 alphanumeric characters.

Click OK to exit the dialog.

How to customize  The addressinformation in the NAD:316 element (in the NAD:2 group) corresponds to
theNAD:316 thenameinthe NAD:310 element so there is no need to display the label associated with
dement the address. For the NAD:316 element, you will remove the field label and add Help text.

Use this procedure to remove the field label and add Help text to the first Street and
Number/P.O. Box field of the Remit To address.

Sep

Action

1

Double-click the NAD: 316 element (in the NAD:2 group).

System Response
The Element Properties dialog is displayed.

Select the Display tab.

In the Label box, delete the existing text.

Select the Help tab.

In the Help Text box, enter the following text:

Enter thefirst line of the address. This address line cannot exceed 35
alphanumeric characters.

Click OK to exit the dialog.
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How to customize  Use this procedure to remove the field label and add Help text to the second Street and
theNAD:317  Number/PO. Box field of the Remit To address.

element

Step

Action

1

Double-click the NAD:317 element (in the NAD:2 group).

System Response
The Element Properties dialog is displayed.

Select the Display tab.

In the Label box, delete the existing text.

Select the Help tab.

In the Help Text box, enter the following text:

Enter the second line of the address. Thisaddress line cannot exceed
35 alphanumeric characters.

Click OK to exit the diaog.

How to customize  The NAD:319 element contains the City Name of the Remit To address. You need to
theNAD:319  removethefield label for this element, because it is evident to your users that they should
dement enter the city name associated with the name and street address they have entered already.
Also, you need to change the element and field lengths, because the City Name field does
not need to be longer than 30 characters.

Use this procedure to remove thefield label, change the element and field lengths, and add
Help text to the City Namefield of the Remit To address.

Step

Action

1

Double-click the NAD: 319 element (in the NAD:2 group).

System Response
The Element Properties dialog is displayed.

Select the Validation tab.

In the Max box, enter 30.

Select the Display tab.

In the Label box, delete the existing text.

In the Maximum number of charactersto be printed box, enter 30.

Select the Help tab.
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(Contd)
Sep

Action

8

In the Help Text box, enter the following text:

Enter the city name. The city cannot exceed 30 alphanumeric
characters.

Click OK to exit the dialog.

How to customize  The NAD:320 element contains the Country Sub-Entity Identification. You will remove
the NAD:320 thefield label for this element, because it will be evident to your users that they should
dement enter the country sub-entity identification (e.g., state, province, or country) associated
with the name and street address they have entered aready. Also, you will change the
element and field lengths, because you do not need this field to be longer than two

characters.

Use this procedure to remove thefield label, change the element and field lengths, and add
Help text to the Country Sub-Entity Identification field of the Remit To address.

Sep

Action

1

Double-click the NAD: 320 element (in the NAD:2 group).

System Response
The Element Properties dialog is displayed.

Select the Validation tab.

In the Max box, enter 2.

Select the Display tab.

In the Label box, delete the existing text.

In the Maximum number of charactersto be printed box, enter 2.

Select the Help tab.

In the Help Text box, enter the following text:

Enter the country sub-entity identification. The code cannot exceed 2
alphanumeric characters.

Click OK to exit the dialog.
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How to customize  Use this procedure to remove the field label and add Help text to the Postcode
theNAD:321  Identification field.

element

Step

Action

1

Double-click the NAD: 321 element (in the NAD:2 group).

System Response
The Element Properties dialog is displayed.

Select the Display tab.

In the Label box, delete the existing text.

Select the Help tab.

In the Help Text box, enter the following text:

Enter the postal code. The postal code cannot exceed 9 alphanumeric
characters. Do not enter a hyphen (-) beforethe 4-character postal
code extension (if used).

Click OK to exit the dialog.
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Customizing the PAT Group

Overview  The PAT group (Payment Terms) is used to enter the payment terms code for the invoice.
The standard allows the PAT group to be used up to 10 timesin an invoice.You know that
your users need to use the PAT segment only once per invoice so you have already
changed the maximum use of this segment from five to one.
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Customizing the PAT Segment

Overview  The PAT segment is a conditional segment that specifies the Payment Terms Basis for the
invoice.

How to customize  The PATO01 element contains the Payment Terms Type Qualifier, athree-character code
the PAT01 element that identifies the payment terms under which thisinvoiceisvalid. Sterling

Gentran: Server uses alist (instead of an edit box or field) when you apply a standard rule
that allows a selection of multiple items. When users use a tranglation object that contains
alist, they select an item from the list instead of typing avaluein the field. You will
customize the PATOL element so that alist containing all valid codes in the Payment
Terms Type Qualifier code list is available to your users when they use the screen entry
trandlation object. The Payment Terms Type Qualifier list enables them to select the
appropriate EDI code from the code list.

After you specify the code list table to use for the list for the Payment Terms Type
Quadlifier field, you need to rename the field Iabel. You also need add Help text to the field.

Use this procedure to load the entire code list from the standard, rename the field |abel,
and add Help text to the Payment Terms Type Qualifier field.

Sep Action

1 Double-click the PAT01 element.

System Response
The Element Properties dialog is displayed.

2 Select the Sandard Rule tab.
3 Select Use Code from the list.
4 Click Edit to access the Edit Code List dialog.

Fulil Tanle 1wl

rlblz Dok
lade |- (427 Domz |PARENT TZRWE TYPZ ZUALIFIER

Alizwed Codes Carcel
Code wale Dezzrigtan

M.
Chamxca...
Liel=te

(NE]

Pl Bl
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(Contd)
Sep

Action

5

The Table ID box contains 4279, the name of the element for which this
code list table will be used. The Desc box contains PAYMENT TERMS
TYPE QUALIFIER, the description of the element for which this codelist
table will be used.

Click L oad to accessthe Load Code List dialog. You are prompted to
select an ODBC data source name. Select the appropriate DSN and click
OK to accessthe Load Code List diaog.

Load Code List
— Select Code Source
Standard [E/092001/0 = List [4273 =]
Cancel |
— Select Codes
Codes In Standard Codes Selected

i EECIE ﬂ

i INETANT ~

1 ELECTIVE LI

12 T0DAYS AFTER EF

13 SELLER TO ADWISI Add Al - |

14 PAID AGAINST 5T/

15 NO CHARGE .

16 NOT YET DEFINEiLl ﬂl
3

KN 2

Click Add All to select al the codes and move them to the Codes Selected
list.

Note

Adding all the codesin thetable (by using Add All) creates a much larger

form than if you use only selected codes. However, it is necessary for your
users to have all the codes available from which to select.

Click OK to load the code list and exit the Load Code List dialog.
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(Contd)
Sep

Action

9

Click Closeto exit the Edit Code List dialog.

The dialog should now should look like this:

Please zelact the code list to uze

Element Properties E
MHame I Walidation | Display | Sumrmnary List I Help
Extended Rule Standard Rule Conditions
Please zelact the standard rule bo uze IUse Code ;I

|42?9 FavMENT TERMS TYFE QUALIFIER

zelect that field below :

[" Raize a compliance emor if the code is not found in the list

I pou wwould like the description of the code to be stored in a field, please

QK. | Cancel

Eppli Help

10

Select the Display tab.

11

In the Label box, enter Payment Terms Code.

12

Select the Help tab.

13

In the Help Text box, enter the following text:

Select the payment terms code from the drop-down box.

14

Click OK to exit the dialog.
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How to generate  Usethis procedure to generate the layout.
the layout

Sep Action

1 Click Generate Layout on the Main Toolbar to refresh the screen
entry form display.

System Response
The Invoice Message frame now should look like this:

| L TR Hl::i:iilul:

Irecica Ma |

Irvuisa Dae

[

PO, C=lw

L, cd Mu

L ad L

Shp u

=]

2 Select Save from the File menu to save your form.
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Customizing the LIN Group

Overview  Thestandard allowsthe LIN group to be used up to 200000 timesin oneinvoice. The LIN
group contains the following form components that you have already activated: LIN, PIA,
IMD:2, MEA:2, QTY:2, and DTM:11 segments; MOA and TDT groups.

The fields associated with the LIN group are arranged on the 2200_Lin frame, which is
separate from the Invoice Message frame that you have been working with thus far. Your
users need to complete the fields on the 2200_Lin frame for each item in the invoice. The
list of al lineitemsin theinvoice are displayed in alist box on the Invoice Message frame.
In that list box, the invoiced items are displayed line by line, forming columns of
information.

Procedure  Usethisprocedureto renametheLIN frameand list box, provide a description for the LIN
group, and add Help text to the line items list box.

Sep Action

1 Click the LIN group with the right mouse button and select Properties
from the shortcut menu.

System Response
The Group Properties dialog is displayed.

Group Properties E3

Mame | Displa_l,JI Lonpingl Loop Extended Hulesl

Flease enter the name :

Pleaze enter a short description :

QK. Cancel Lpply Help
2 In the Desc box, enter Line Items.
3 Select the Display tab.
4 In the Frame Caption box, enter Line Items.
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(Contd)
Sep Action

5 In the List Caption box, enter Line Itemsto rename the list box that is
displayed on the Invoice Message frame (listing the line items entered on
the Line Items frame).

6 In the Frame Help Text list box, enter the following text:
Thisframe containslineitem detail information. For online Help on
an individual field on thisframe, select the field and press F1.

7 In the Listbox Help Text list box, enter the following text:
Thisbox containsthelineitem detail for theinvoice. The datain this
list box isentered or changed on the Lineltemsframe. To enter a new
lineitem, click thelist box and click New. To modify an existing line
item, click that item and click Open.

8 Click OK to exit the Group Properties dialog.
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Customizingt

Overview

How to customize
the LINO1 and
CNTO2 elements

Customizing the LIN Segment

he LIN Segment

The LIN segment contains the details of the items on the invoice. For some of the
elementsin the LIN segment, you only need to add Help text and rename the field labels
so they more accurately reflect your company’s needs. With other elements, you need to
change the maximum lengths for some of the fields, use accumulators to calculate the
number of lineitems, or define a constant value.

The LIN group is subordinate to the Invoi ce Message frame, so Sterling Gentran: Server
creates a separate frame (the Line Items frame) to contain the group data (the line item
details). The system also creates alist box (the Line Items list box) on the Invoice
Message frame to allow you to access the itemsin the list box. Each set of datais
displayed asarow in thelist box. After you customize the lineitem fields, the Line Items
list box contains these four columns of data: Item No., Product Code, Quantity, and Price.

The LINO1 element (inthe LIN group) containsthe Line Item Number for each itemin the
invoice. You use the Line Item Number field to identify sequentially each line item in the
invoice. You use the Use Accum function to obtain an incremental count of the number of
line items. This number is used in the Control Value field (CNT02 element).

You create alist box definition for the LINO1 element to include the line number in the list
box, and rename the field label to more briefly label thisfield. Also, you know that your
users will enter no more than 99,999 line items per invoice. Each lineitem is numbered
sequentialy, starting with one so you need a maximum length of only five digits for this
field. You need to change the maximum length for thisfield to five.

Use this procedure to count line itemsin the LIN segment and generate a control total in
the CNTO2 element of the number of lineitems, rename the LINO1 field label, change the
field and element lengths and create the list box definition for the Line Iltem Number field.

Sep Action

1 Double-click the LINO1 element.

System Response
The Element Properties dialog is displayed.

2 Select the Validation tab.

3 In the Max box, enter 5 to allow a five-digit number in this element.
4 Select the Sandard Rule tab.

5 Select Use Accumulator from the list.
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(Contd)
Sep

Action

6

Click New to access the Edit Accumulator Entry dialog to create a new
calculation using this element.

F rid Arsumulabng Fnlp
Prver, Aczuriu a0 | H Hanz | u, I

1 in | i I

Il H qI:ﬂ'-ne.-'q.c-:Jﬁl EI

Sann

T

kil

From the Primary Accumulator list, select 0. Before any calculations are
performed on an accumulator, its content is 0. When you use this
accumulator, the system adds a new accumulator to the bottom of thislist.

Note

Thereis only one set of accumulators for each form. This means that
accumulator 0, whether it isused in the Primary Accumulator or Alternate
Accum box, is the same accumulator with the same content. If you assign
calculations to accumulator O at the beginning of the form and then use
accumulator 0 again later in the form, the content of that accumulator will
be the result of the earlier calculation. Any additiona calculations you
assign to that accumulator will be performed on the content resulting from
an earlier calculation.

In the Name box, enter Item Number to give the accumulator a
descriptive aliasthat enablesyou to distinguish it from other accumulators
you create.

From the First list, select Increment primary to specify that the system
increments the value in this accumulator by one for each iteration of the
LIN group. This operation is the first operation that the system performs.
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(Contd)
Sep

Action

10

From the Second list, select Use primary to specify that the system loads
the current value of the accumulator into the LINO1 (Line Item Number)
element. This operation is the second operation that the system performs,
after the first operation is completed.

The Edit Accumulator Entry dialog now should look like this:

Edit Accumulator Entre ]

Minan Accumult [0 8| Hamne [Ler “urber
D zersticn:
st [Ircremert piiran [2] cremate tecm | L
Secow |Use wmay 2]
Thid | 2]
“cuth | B

11

Click OK to add the accumulator and exit the Edit Accumulator Entry
dialog.

The dialog should now should look like this:

Element Properties
Hame I W alidation | Display | Summary List I Help
Extended Rule Standard Rule Conditions
Please select the standard rule to uge : IUse Accurmulator L]
Primany Accumulator Op1 Op2 0Op3 Opd
[-ltern Mumber Inc  Use
Change... |
Delete |
ok | Cancel el Help

12

Select the Display tab.

13

Select the Thisfield should be displayed but not editable option.

14

In the Label box, enter Item No. to replace the existing field |abel.
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(Contd)
Sep Action
15 In the Maximum number of characters to be printed box, enter 5 to allow

five digitsto be displayed in thisfield.

16 Select the Summary List tab.

17 Select the Display thisfield in summary list check box. The valuein the
Item No. field is displayed in a column in the Line Items list box.

18 In the Column Width box, enter 8 to set the width of this column in the
Line Itemslist.

Note

The column width should be wider than the actual content of the column.
The extra space that is not used for the content of the column will provide
white space separating the columns. If the column width isthe exact width
of the data, then there will not be space separating the columns of data.

19 From the Sequence list, select 1 to indicate that thisfield isthe first
column in the list box.

20 Click OK to exit the dialog.

21 Double-click the CNT02 element (in the CNT segment).

System Response
The Element Properties dialog is displayed.

22 Select the Sandard Rule tab.

23 Click the Use Accumulator option.

24 Click New to access the Edit Accumulator Entry dialog to create a new
calculation for this element.

25 From the Primary Accumulator list, select 0.

26 In the Name box, enter I1tem Number.
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(Contd)
Sep

Action

27

FromtheFirst list, select Use primary to specify that the system loads the
current value of the accumulator into the CNTO02 (Control Value) element.

The Edit Accumulator Entry dialog now should look like this:

Mimaiy 2ecunulete [0 3| Hame [lew Surber

D zersticn:

st [Use ximay [%] crenate cec.m | B
Jecow | %]

Thid | L]

ath | [l

28

Click OK to add the accumulator.

The dialog should now should look like this:

Element Properties E2

MHame I W alidation | Dizplay | Surnrnary List I Help

Extended Rule Standard Rule Conditions

Please zelact the standard rule to use IUse Accurmulator L]

Prirnary Accurmulatar Op1l Op2 0Op3 Op4d
[1-ltermn Murmber

Change...

Delete

i

ak | Cancel Sl Help

29

Select the Display tab.

30

Select the Thisfield should displayed but not editable option.

31

Click OK to exit the dialog.
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Customizing the PIA Segment

Overview  ThePIA segment (in the LIN group) contains the Additional Product ID for eachitemin
the invoice. The standard allows the PIA segment to be used up to 25 times per line item.
Your users enter information in the PIA segment only once per line item so you have
already changed the maximum use of this segment to one.

How to customize  The PIAO1 element contains the Product ID Function Qualifier, amandatory three-
the PIAQ1 e ement character code that identifiesthe type of product identification that follows. You know that
the only type of product identification your users enter in the ltem Number field (PIA02)
isthe product code, so you need to define a constant value for the Product ID Function
Quadlifier field, designating that the constant “5” (Product Identification) always qualifies
the value in the Item Number field. You need to hide the qualifier field, because it does not
need to be displayed in the trandlation object.

When you enter the product code in the Item Number field, the system assigns the code
“B5” to the Product 1D Function Qualifier field.

Use this procedure to define a constant value in the Product ID Function Qualifier field
and hide the field.

Sep Action

1 Double-click the PIA01 element.

System Response
The Element Properties dialog is displayed.

2 Select the Sandard Rule tab.

3 Select the Use Constant option.

4 Click Edit to access the Map Constants dialog.

5 Click New to access the Edit Constant dial og.

6 In the ID box, enter Product Identification to identify the constant.

7 From the Typeligt, select String to indicate that the literal constant will be
formatted as a string data type.

8 In the Value box, enter 5 to indicate that the Reference Qualifier field must
contain the product identification. This value is the actual value of the
literal constant.

9 Click OK to add the constant.

10 Click Closeto exit the Map Constants dialog.

11 Select the Sandard Rule tab.
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(Contd)
Sep

Action

12

From the Constants list, select 5 to identify the constant that will be used
for this element.

13

From the Qualifieslist, select 7140:2 I TEM NUMBER, which isthe
element that the Reference Qualifier field qualifies.

The dialog should now should look like this:

Element Properties E
MHame I Walidation | Display | Sumrmnary List I Help
Extended Rule Standard Rule | Conditions
Please zelact the standard rule bo uze IUse Conztant ;I

Please zelact a constant bo store in thiz fisld ;
5 =l | Edi. |

I thiz constant is & qualifier far another field, Gentran can automatically use the
existence of data in that field to determine whether to execute thiz standard mile. To
take advantage of this feature, zsimply select the field to be qualified :

7140:2 ITEM NUMBER

QK. Cancel Lpply Help

14

Select the Display tab.

15

Select the Thisfield should not appear on the form option.

16

Click OK to exit the dialog.
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How to customize  The PIA02 element contains the Item Number for each item in the invoice. For this
the PIAQ2 element tutorial, you need to rename the field label. Also, the standard allows up to 35 characters
inthisfield. You know that your users will enter product identification numbers that are
no longer than 10 characters, so you need to change the element and field lengths. In
addition, you need to create alist box definition for the PIA02 element to include the
product code in the Line Items list box on the Invoice Message frame.

Use this procedure to rename the field label, change the field and element lengths, add
Help text, and create the list box definition for the Item Number field.

Step

Action

1

Double-click the PIA02 element.

System Response
The Element Properties dialog is displayed.

Select the Validation tab.

In the Max box, enter 10.

Select the Display tab.

In the Label box, enter Product Code.

In the Maximum number of charactersto be printed box, enter 10.

Select the Summary List tab.

In the Summary List section, select the Display thisfield in summary
list check box. The valuein the Product Code field will be displayed in a
column in the Line Items list box.

In the Column Width box, enter 13 to set the width of this column in the
Line Items list box.

10

From the Sequence list, select 2 to indicate that thisfield will be the
second column in the list box.

11

Select the Help tab.

12

In the Help Text box, enter the following text:

Enter your company's product code for thisitem in theinvoice. The
product code cannot exceed 10 alphanumeric characters.

13

Click OK to exit the dialog.
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How to customize  The PIAO3 element contains the Item Number Type, Coded, athree-character code that
the PIAQO3 element identifies the type of item number in the PIAO2 element. You know that the only type of
product code your users enter in the Item Number field (PIA02) isthe UPC code, so you
need to define a constant value for the Item Number Type, Coded field, designating that
the constant, UP (UPC (Universal Product Code)), always qualifies the value in the Item
Number field. Then, you will hide the qualifier field, because it does not need to be
displayed in the translation object.

When auser enters the product code in the Item Number field, the system automatically
assigns the code UP to the Item Number Type, Coded field.

Use this procedure to define a constant value in the Item Number Type, Coded field and

hide the field.
Sep Action
1 Double-click the PI AO3 element.
System Response
The Element Properties dialog is displayed.
2 Select the Sandard tab.
3 Select the Use Constant option.
4 Click Edit to access the Map Constants dialog.
5 Click New to access the Edit Constant dial og.
Edit Constant
I} Tupe
| |
Walue
|
6 In the ID box, enter UPC Code.
7 From the Type list, select String.
8 In the Value box, enter UP.
9 Click OK to add the constant.
10 Click Close to exit the Map Constants dia og.
11 From the Constants list, select UP.
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(Contd)
Sep Action

12 From the Qualifieslist, select 7140:2 I TEM NUMBER, which isthe
element that the Reference Qualifier field qualifies.

The dialog should now should look like this:

Element Properties
Mame I " alidation | Display | Summary List I Help
Extended Rule Standard Rule | Conditions
Fleasze select the standard rule to uge : IUse Constant L]

Flease select a constant to store in this field ;
UP =] Edit... |

f this constant iz a qualifier for anather field, Gentran can automatically use the
exiztence of data in that field to determine whether to execute thiz standard rule. To
take advantage of this feature, simply select the field to be qualified :

7140:2 [TEM MUIMBER

Ok Cancel Spply Help

13 Select the Display tab.

14 Select the Thisfield should not appear on the form option.

15 Click OK to exit the dialog.
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Customizing the IMD:2 Segment

Customizing the IMD:2 Segment

Overview

How to customize
the M D:201
element

The IMD:2 segment (in the LIN group) contains the Item Description for each itemin the
invoice. The standard allows the IMD:2 segment to be used up to ten times per line item.
Your users enter information in the IMD:2 segment only once per line item, so you have
already changed the maximum use of this segment to one.

The IMD:201 element contains the Item Description Type, Coded for the invoiced item.
You know that the only type of item description your users enter for thisinvoiceis afree-
form description. You need to define a constant value for the Item Description Type field,
to indicate that the constant “F’ (Free Form) qualifies the text in the Item Description
field. When a user enters a free-form description in the Description field, the system
automatically will assign the code “F” to the Item Description Type, Coded field.

Use this procedure to define a constant value and hide the Item Description Type, Coded
field.

Sep Action

1 Double-click the IM D:201 element.

System Response
The Element Properties dialog is displayed.

2 Select the Sandard Ruletab.
3 Select Use Constant from the list.
4 Click Edit to access the Map Constants dialog.
5 Click New to access the Edit Constant dial og.
Edit Constant E
1] Type
| | |

ralue Cancel |

6 Inthe 1D box, enter Free Form.
7 From the Typelist, select Sring.
8 In the Value box, enter F to indicate that the Item Description Type,

Coded field will be afree-form description. This value isthe actual value
of theliteral constant.

9 Click OK to add the constant.

10 Click Close to exit the Map Constants dial og.
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(Contd)
Sep Action

11 From the Constants list, select F.

12 From the Qualifieslist, select 7008 ITEM DESCRIPTION, which isthe
element that the Item Description Type, Coded field qualifies.

The dialog should now should look like this:

Element Properties
Mame I " alidation | Display | Summary List I Help
Extended Rule Standard Rule | Conditions
Fleasze select the standard rule to uge : IUse Constant L]

Flease select a constant to store in this field ;
F i | Edi. |

f this constant iz a qualifier for anather field, Gentran can automatically use the
exiztence of data in that field to determine whether to execute thiz standard rule. To
take advantage of this feature, simply select the field to be qualified :

7002 [TEM DESCRIPTIOMN

ak Cancel Sl Help

13 Select the Display tab.

14 Click the Thisfield should not appear on the form option.

15 Click OK to exit the dialog.

Sterling Gentran:Server — May 2011 Forms Integration EDIFACT Tutorial Guide



Creating a Screen Entry Form Customizing the IMD:2 Segment

How to customize  ThelMD:206 element containsthe Item Description for each invoiced item, and is defined
the IMD: 206 by the standard to be a string of up to 35 a phanumeric characters. You need to add Help
dement text to thisfield.

Use this procedure to add Help text to the Item Description field.

Sep Action

1 Double-click the |M D: 206 element.

System Response
The Element Properties dialog is displayed.

2 Select the Help tab.

3 In the Help Text box, enter the following text:

Enter the description of theinvoiced item. Theitem description
cannot exceed 35 alphanumeric characters.

4 Click OK to exit the dialog.
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Customizing the MEA:2 Segment

Overview  The MEA:2 segment (in the LIN group) contains the Measurements for each itemin the
invoice. The standard allows the MEA:2 segment to be used up to five times per line item.
Your users enter information in the MEA:2 segment only once per line item, so you have
already changed the maximum use of this segment to one.

How to customize  The MEA:201 element contains the Measurement Application Qualifier for each invoiced
the MEA:201 item. You know that the only type of measurement application your users enter for this
dement invoice is a measurement. You need to define a constant value for the Measurement
Application Qualifier field to indicate that the constant “AAE” (Measurement) qualifies
the text in the Measurement Dimension, Coded field. When a user enters a measurement
in the Measurement Dimension, Coded field, the system automatically assigns the code
“AAE” to the Measurement Application Qualifier field.

Use this procedure to define a constant value and hide the M easurement A pplication

Qualifier field.
Sep Action
1 Double-click the M EA: 201 element.

System Response
The Element Properties dialog is displayed.

2 Select the Sandard Ruletab.
3 Select Use Constant from the list.
4 Click Edit to access the Map Constants dialog.
5 Click New to access the Edit Constant dial og.
Edit Constant E
1] Type
| | |

ralue Cancel |

6 In the ID box, enter M easurement to identify the constant.
7 From the Typelist, select String.
8 In the Value box, enter AAE to indicate that the Product/Service ID

Qualifier field will be ameasurement.

9 Click OK to add the constant.

10 Click Closeto exit the Map Constants dialog.
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(Contd)
Sep

Action

11

From the Constants list, select AAE.

12

From the Qualifieslist, select 6313 MEASUREMENT DIMENSION,
CODED, which isthe element that the Item Description Type, Coded
field qualifies.

The dialog should now should look like this:

Element Properties E2
M armne I " alidation | Dizplay | Surnrnary List I Help
Extended Rule Standard Rule | Conditions
Flease zelect the standard rule to use IUse Coriztant L]

Flease select a constant to store in this field ;

AAE =] | Edt. |

f this constant iz a qualifier for anather field, Gentran can automatically use the
exiztence of data in that field to determine whether to execute thiz standard rule. To
take advantage of this feature, simply select the field to be qualified :

£.313 MEASLIREMENT DIMENSION, CODED

Ok Cancel Spply Help

13

Select the Display tab.

14

Select the Thisfield should not appear on the form option.

15

Click OK to exit the Display Properties dialog.
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How to customize  The MEA:202 element contains the M easurement Dimension, Coded for each item in the
the MEA:202 invoice. For brevity on the trandation object, you need to rename thefield label. Also, you
eement need to customize the MEA:202 element so that a drop-down list box containing all valid
codesin the code list is available to your users when they use the screen entry translation
object. The drop-down list box will enable them to select the appropriate EDI code from
the ones available

Use this procedure to rename the field label, add Help text, and load the code list table
from the standard for the Measurement Dimension, Coded field.

Step

Action

1

Double-click the MEA:202 element (in the LIN group).

System Response
The Element Properties dialog is displayed.

Select the Display tab.

In the Label box, enter UOM.

Select the Help tab.

In the Help Text box, enter the following text:

Select the unit of measurement for theinvoiced item.

Select the Sandard Rule tab.

Select the Use Code option.

Click Edit to access the Edit Code List dialog.

The Table ID box contains 6313, which is the name of the element for
which this code list table will be used. The Desc box contains
MEASUREMENT DIMENSION, CODED, which is the description of
the element for which this code list table is used.

10

Click L oad to accessthe Load Code List dialog. You are prompted to
select an ODBC data source name. Select the appropriate DSN and click
OK to accessthe Load Code List dialog.

11

Click Add All to select all the codes and move them to the Codes Selected
list.

Note
Adding all the codesin thetable (by using Add All) creates a much larger
form than if you only use selected codes.

12

Click OK to load the code list and exit the Load Code List dialog.
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(Contd)
Sep Action

13 Click Close to exit the Edit Code List dialog.

The dialog should now should look like this:

Element Properties E3

Mame I Y alidation | Dizplay | Summary List I Help
Extended Rule Standard Rule | Conditions
Flease select the standard rule bo uze ; IUse Code ;I

Flease select the code list bo uze ;
|5313 MEASUREMEMT DIMENSION, CODED

[" Raize a compliance ermar if the code is not found in the list

If pou would like the description of the code to be stored in a field, pleaze
zelact that field below :

| hd

QK. | Cancel Lpply Help

14 Click OK to exit the dia og.
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Customizing the QTY:2 Segment

Overview  TheQTY:2 segment (in the LIN group) contains the Quantity for each itemin the invoice.
The standard allows the QTY:2 segment to be used up to five times per line item. Your
users enter information in the QTY:2 segment only once per lineitem so you have already
changed the maximum use of this segment to one.

How to customize  The QTY:201 element contains the Quantity Qualifier for each invoiced item. For this
theQTY:201 tutorial, you know that the only type of quantity your users enter for thisinvoiceisthe
dement invoiced quantity. You need to define a constant value for the Quantity Qualifier field, to
indicate that the constant, 47 (Invoiced Quantity), qualifies the text in the Quantity field.
When a user enters a measurement in the Quantity field, the system automatically assigns
the code, 47, to the Quantity Qualifier field.

Use this procedure to define a constant value and hide the Quantity Qualifier field.

Sep Action

1 Double-click the QTY:201 element.

System Response
The Element Properties dialog is displayed.

2 Select the Sandard Rule tab.
3 Click the Use Constant option.
4 Click Edit to access the Map Constants dialog.
5 Click New to access the Edit Constant dial og.
Edit Constant E
D Type

ralue Cancel |

6 In the ID box, enter Invoiced Quantity to identify the constant.
7 From the Typelist, select String.
8 In the Value box, enter 47 to indicate that the Quantity Qualifier field will

be the invoiced quantity.

9 Click OK to add the constant.

10 Click Closeto exit the Map Constants dialog.
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(Contd)
Sep

Action

11

From the Constants list, select 47 to identify the constant that is used for
this element.

12

From the Qualifieslist, select 6060 QUANTITY, which isthe element
that the Quantity Qualifier field qualifies.

The dialog should now should look like this:

Element Properties E2
M armne I " alidation | Dizplay | Surnrnary List I Help
Extended Rule Standard Rule | Conditions
Flease zelect the standard rule to use IUse Coriztant L]

Fleaze select a constant ta stare in this field ;

47 =] Ed. |

If this constant iz a qualifier for anaother figld, Gentran can automatically use the
existence of data in that field to determine whether to execute this standard e, To

ak Cancel Sl Help

13

Select the Display tab.

14

Select the Thisfield should not appear on the form option.

15

Click OK to exit the dialog.
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How to customize  The QTY:202 element contains the Quantity for each item on the invoice. The quantity for
the QTY:202, eachlineitemis used to calculate the total dollar amount of the invoice. From this
MOA:502, and calculation, you need to generate arunning total of extended price and load the final total
MOA:1002 intothe MOA:1002 (Monetary Amount) element.
elements , - _ _

You need to create alist box definition for the QTY:202 element to include the quantity
invoiced in the list box. The standard allows up to 15 digitsin this field. You know that
your users do not enter a quantity of more than 99,999 (a five-digit number) for any one
item, so you need to change the maximum lengths for this field and element to five.

Also, the screen format and EDI format of the data currently use the number format R9,
indicating a number with an explicit decimal point and up to nine decimal places. Your
users do not enter any quantities with adecimal point so you need to change the screen
and EDI formatsto RO, indicating a number with an explicit decimal point and no decimal
places.

Use this procedure to use an accumulator in the QTY:202 element to generate arunning
total of extended price that is used in the MOA:1002 element, change the screen and EDI
formats, change the field and element lengths, add Help text, and create the list box
definition for the Quantity field.

Sep Action

1 Double-click the QTY:202 element (in the LIN group).

System Response
The Element Properties dialog is displayed.

2 Select the Validation tab.

3 In the Max box, enter 5 for the maximum number of digits allowed in this
element.

4 From the Form Format list, select RO to allow a number with an explicit

decimal point and no decimal places to be entered in thisfield.

5 From the File Format list, select RO to format the EDI data with an
explicit decimal point and no decimal places.

6 Select the Standard Rule tab.

7 Click the Use Accumulator option.

8 Click New to access the Edit Accumulator Entry dialog to create a new

calculation using this element.

9 From the Primary Accumulator list, select 1.

10 In the Name box, enter Extended Price to give the accumulator a
descriptive alias that enables you to differentiate the purposes of the
accumulators you create.
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(Contd)
Sep

Action

11

From the First list, select L oad primary to specify that the system will
load the content of the QTY:202 element into the Primary Accumulator
for each iteration of the LIN group. This operation is the first operation
that the system performs.

The Edit Accumulator Entry dialog now should look like this:

Frimary Accumulatar (ST ~ Marne IExtended Price oK I
— Dperations Eerea] |
First ILnad prrnarny ;] Altermate Secumm |_3

Second I L]

Thid | =

(e i I L]

12

Click OK to add the accumulator.

The dialog should now should look like this:

Element Properties E3

Hame I W alidation | Dizplay | Summary List I Help I
Extended Rule Standard Rule Conditions
Please select the standard rule to uze IUse Accurnulator ;I

Opl
Load

Op2 Op3 0Op4

Primany Accumulator
1-Extended Frice

Change...

[Eam. |
Delete |

QK. | Cancel Lpply Help

13

Select the Display tab.

14

In the Maximum number of characters to be printed box, enter 5 to allow
five digits to be displayed in thisfield.

15

Select the Summary List tab.
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(Contd)
Sep Action

16 Select the Display thisfield in summary list check box. The value in the
Quantity field isdisplayed in acolumn in the Line Items list box.

17 In the Column Width box, enter 8 to set the width of this column in the
Line Items list box.

18 From the Sequence list, select 3 to indicate that thisfield is the third
column in the list box.

19 Select the Help tab.

20 In the Help Text box, enter the following text:

Enter the quantity of thisinvoiced item. The quantity cannot exceed 5
digits.

21 Click OK to exit the dialog.

22 Double-click the MOA:502 element (in the LIN group).

System Response
The Element Properties dialog is displayed.

23 Select the Sandard Rule tab.

24 Click the Use Accumulator option.

25 Click New to access the Edit Accumulator Entry dialog to create a new
calculation using this element.

26 From the Primary Accumulator list, select 1.

27 From the First list, select Multiply with primary to specify that the
system multiply the value of the MOA:502 (Monetary Amount) element
(inthe LIN group) by the content of the primary accumulator, and store
the result in the primary accumulator for each iteration of the LIN group.
This operation is the first operation that the system performs.

The Edit Accumulator Entry dialog now should look like this:

Prirary Accurnulator |1 j I amne: IEHtended Price 0k I
i~ Operation Carel |
First ith pri - Altemate.ﬁccumlﬂ

Second | LI

Tt | =]

Feauurthy | LI
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(Contd)
Sep Action

28 Click OK to add the accumulator.

The dialog should now should look like this:

Element Properties E
MHame I Walidation | Display | Sumrmnary List I Help
Extended Rule Standard Rule | Conditions
Please zelact the standard rule bo uze IUse Accumulator ;I
Prirnary Accurmulator Op1l 0Op2 0Op3d Opéd
1-Estended Price
Change... |
Delete |
QK | Cancel | S | Help
29 Click New to access the Edit Accumulator Entry dialog to create a new
calculation for this element.
30 From the Primary Accumulator list, select 2.
31 In the Name box, enter Running Price to give the accumulator a

descriptive aias that enables you to differentiate the purposes of the
accumulators you create.

32 From the First list, select Add primary to alternate to specify that the
system add the content of the primary accumulator to the content of the
alternate accumulator, and store the result in the primary accumulator for
each iteration of the LIN group.
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(Contd)
Sep

Action

33

From the Alternate Accum list, select 1. This operation specifies that the
system add the value of accumulator 1, which contains the extended price
for alineitem, to the value of accumulator 2. The system storesthe sumin
accumulator 2, which contains a running total of the extended price with
each iteration of the LIN group.

The Edit Accumulator Entry dialog now should look like this:

Edit Accumulator Entry B3

Primary Accumulator I‘I EV! Mame IE:-:tendedF'ric:e oK I

— Operations Cerad |
First inly with primary Sl termate Seaum I 57!
Second I ;I
Third | =l
it I ;I

Click OK to add the accumul ator.

The dialog should now should look like this:

Element Properties E3

Mame I Y alidation | Dizplay | Summary List I Help
Extended Rule Standard Rule | Conditions
Flease select the standard rule bo uze ; IUse Accurnulator ;I
Frimary Accurmulator Op1 0Op2 0Op2 Opd

1-E xtended Frice Fulk

2-Hunning Price

Change...

[Eam. |
Delete |

QK. | Cancel | Lpply | Help

35

Click OK to exit the Element Properties dia og.
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(Contd)
Sep

Action

36

Double-click the MOA:1002 element (in the MOA group).

System Response
The Element Properties dialog is displayed.

37

Select the Sandard Rule tab.

38

Click the Use Accumulator option.

39

Click New to access the Edit Accumulator Entry dialog to create a new
calculation for this element.

From the Primary Accumulator list, select 2.

41

From the First list, select Use primary to specify that the system load the
content of the primary accumulator into the MOA:1002 (Monetary
Amount) element.

The Edit Accumulator Entry dialog now should look like this:

kil fuazmulalan Fuoley

Princn Aoz i |2 [#] tere |7 rnaaFie - |
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(Contd)
Sep Action

42 Click OK to add the accumulator.

The dialog should now should look like this:

Element Properties E
MHame I Walidation | Display | Sumrmnary List I Help
Extended Rule Standard Rule | Conditions

Please zelact the standard rule bo uze IUse Accumulator ;I

Prirnary Accurmulator Op1l 0Op2 0Op3d Opéd

2-Hunning Price
Change... |

Delete |
QK. | Cancel Lpply Help

43 Select the Display tab.

44 Select the Thisfield should be displayed but isnot editable option.

45 Click OK to exit the dialog.
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Customizing the DTM:11 Segment

Overview

How to customize
theDTM:1101
element

The DTM:11 segment (in the LIN group) contains the Date/Time/Period for each item in
the invoice. The standard allows the DTM:11 segment to be used up to 35 times per line
item. Your users enter information in the DTM:11 segment only once per line item so you
have already changed the maximum use of this segment to one.

The DTM:1101 element (Date/Time Qualifier) is a mandatory element for the DTM:11
segment. The DTM:1101 element contains the two-character code from your EDI datato
indicate what type of date follows (e.g., date shipped). You need to define a constant value
for the Date/Time/Period Qualifier field, designating that the constant, 186 (Departure
Date/Time, Actual), quaifies the date in the Date/Time/Period field.

When a user enters the date on which the item is shipped in the Date/Time/Period field,
the system assigns the code 186 to the Date/Time/Period Qualifier field. The qualifier
field does not need to be displayed.

Use this procedure to define a constant and hide the Date/Time/Period Qualifier field.

Sep Action

1 Double-click the DTM:1101 element.

System Response
The Element Properties dialog is displayed.

2 Select the Sandard Rule tab.
3 Select the Use Constant option.
4 Click Edit to display the Map Constants dialog.
5 Click New to display the Edit Constant dialog.
[n] Type
| | [ ]

Walue Cancel |

6 Inthe ID box, enter Date Shipped.
7 From the Typelist, select String.

8 In the Value box, enter 186.

9 Click OK to add the constant.

10 Click Closeto exit the Map Constants dial og.
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(Contd)
Sep Action
11 From the Constants list, select 186.

12 From the Qualifies list, select 2380 DATE/TIME/PERIOD.

The dialog should now should look like this:

Element Properties
Mame I " alidation | Display | Summary List I Help
Extended Rule Standard Rule | Conditions
Flease zelect the standard rule to use IUse Coriztant L]

Fleaze select a constant ta stare in this field ;

186 =] | Edt. |

f this constant iz a qualifier for anather field, Gentran can automatically use the
exiztence of data in that field to determine whether to execute thiz standard rule. To
take advantage of this feature, simply select the field to be qualified ;

0 DATE/TIME/PERIOD

ak Cancel Sl Help

13 Select the Display tab.

14 Select the Thisfield should not appear on the form option.

15 Click OK to exit the dialog.
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How to customize  The DTM:1102 element in the DTM:11 segment contains the Date/Time/Period qualified
theDTM:1102 by the Date/Time/Period Qualifier field. This element is defined by the standard to be a
eement string of 35 characters. In this tutorial, you know that the ship date alwaysis an eight-
character string, so you need to change the element and field lengths to accommodate the
new length. Also, you need to rename the field label and add Help text to the field

Use this procedure to change the element and field lengths, renamethe field label, and add
Help text to the Date field.

Sep Action

1 Double-click the DTM:1102 element.

System Response
The Element Properties dialog is displayed.

2 Select the Validation tab.

3 In the Max box, enter 8 to allow the entire date, including separators
(), in this element.

4 Select the Display tab.

5 In the Label box, enter Date Shipped.

6 In the Maximum number of charactersto be printed box, enter 8.
7 Select the Help tab.

8 In the Help Text box, enter the following text:

Enter the date on which thisinvoiced item was shipped. Usethe
format MM/DDI/YY.

9 Click OK to exit the diaog.
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Customizing the MOA Group

Overview  The MOA group (in the LIN group) contains the Monetary Amount for each line item.
The standard allows the MOA group to be used up to five times per line item. You have
already changed the maximum use of the MOA group and promoted the group to obtain
just one instance of the MOA group, and to place the price on the Line Items frame.
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Customizing the M OA:5 Segment

Overview  The MOA:5 segment (in MOA group which isin the LIN group) contains the Monetary
Amount for each item in the invoice.

How to customize  The MOA:501 element (Monetary Amount Type Qualifier) isamandatory el ement for the
the MOA:501 MOA:5 segment. The MOA:501 element contains the three-character code from your EDI
dement datato indicate what type of monetary amount follows (e.g., price). You need to define a
constant value for the Monetary Amount Type Qualifier field, designating that the
constant 146 (Unit Price) qualifies the monetary amount in the Monetary Amount field.

When a user entersthe price for an item in the Monetary Amount field, the system assigns
the code 146 to the Monetary Amount Type Qualifier field. The qualifier field does not

need to be displayed.
Use this procedure to define a constant and hide the Monetary Amount Type Qualifier
field.
Sep Action
1 Double-click the MOA:501 element.
System Response
The Element Properties dialog is displayed.
2 Select the Sandard Ruletab.
3 Select Use Constant from the list.

4 Click Edit to display the Map Constants dialog.

5 Click New to display the Edit Constant dialog.
Edit Constant E
1D Type
| |
Walue
|
6 In the ID box, enter Unit Price.
7 From the Type list, select String.
8 In the Value box, enter 146.
9 Click OK to add the constant.

10 Click Close to exit the Map Constants dial og.

11 From the Constants list, select 146.
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(Contd)
Sep Action

12 From the Qualifieslist, select 5004 MONETARY AMOUNT, whichis
the element that the Monetary Amount Type Qualifier field qualifies.

The dialog should now should look like this:

Element Properties
Hame I W alidation | Display | Summary List I Help
Extended Rule Standard Rule | Conditions
Please select the standard rule to uge : IUse Constant L]

Please select a constant to store in this field ;
145 i | Edi. |

If this constant iz a qualifier for anather field, Gentran can automatically uze the
existence of data in that field to determine whether to execute thiz standard ule. To
take advantage of this feature, simply zelect the field to be qualified :

5004 MOMETARY AMOLINT

ak Cancel Sl Help

13 Select the Display tab.

14 Select the Thisfield should not appear on the form option.

15 Click OK to exit the dialog.

How to customize  The MOA:502 element contains the Monetary Amount for each item in the invoice. You
the MOA:502 have already used an accumulator for this field so that the price for each line item is used
dement to calculate the total dollar amount of theinvoice. From this calculation, arunning total of
extended price is generated and the final total will be loaded into the MOA:1002
(Monetary Amount) element. You need to create alist box definition for the MOA:502
element to include the unit price in the Line Items list box.

You need to rename the field label. The standard designates an R9 screen format and EDI
format for thisfield, meaning that the priceisformatted with an explicit decimal point and
up to nine decimal places. Your users enter aprice in an R2 format (a number with up to
two decimal places) so you need to change the screen and EDI formats from R9 to R2.

The standard defines this element as having a maximum length of 18. The items you sell
to Pet Zone are not priced at more than $9,999.99 each, so this field needs a maximum
length of only eight (four places for the dollars; two places for the cents; one place for the
decimal point; and one place for aplus or minus sign, if present).
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Customizing the MOA:5 Segment

Use this procedure to rename the field label, change the field and element Iengths, change
the number formats, add Help text, and create the list box definition for the Monetary

Amount field.

Step

Action

1

Double-click the M OA:502 element.

System Response
The Element Properties dialog is displayed.

Select the Validation tab.

In the Max box, enter 8.

From the Screen Format list, select R2 to indicate that thisfield on the
translation object accept a number with an explicit decimal point and up to
two decimal places.

From the EDI Format list, select R2 to format the EDI datawith an
explicit decimal point and two decimal places.

Select the Display tab.

In the Label box, enter Price to replace the existing text.

In the Maximum number of characters to be printed box, enter 8 to allow
eight numeric digitsin thisfield, including aplus or minus sign and a
decimal point.

Select the Summary List tab.

10

Select the Display thisfield in summary list check box. The valuein the
Pricefield isdisplayed in acolumnin the Line Items list box.

11

In the Column Width box, enter 8 to set the width of this column in the
Line Items list box.

12

From the Sequence ligt, select 4 to indicate that thisfield is the fourth
column in the list box.

13

Select the Help tab.

14

In the Help Text box, enter the following text:

Enter the unit pricefor thisitem. The price cannot exceed 8 digits,
including a plusor minussign and a decimal point.

15

Click OK to exit the dialog.
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Customizingthe TDT Group

Overview  TheTDT group (inthe LIN group) contains the Details of Transport for each line item.
The standard allows the TDT group to be used up to 10 times per line item.You use the
TDT group only once per line item. You have already changed the maximum use of the
TDT group and promoted the group to obtain just one instance of the TDT group and to
place the transport method on the Line Items frame.
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Customizing the TDT:2 Segment

Customizingthe TDT:2 Segment

Overview

How to customize
the TDT:201
element

The TDT:2 segment (in the LIN group) contains the Details of Transport for each itemin
theinvoice.

The TDT:201 element (Transport Stage Qualifier) isa mandatory element for the TDT:2
segment. The TDT:201 element contains the three-character code from your EDI datato
indicate the type of transport (e.g., main-carriage transport). You need to define a constant
value for the Transport Stage Qualifier field, designating that the constant “20” (Main-
Carriage Transport) qualifies the transport type in the Type of Means of Transport
Identification field.

When a user selects atransport method from the Type of Means of Transport
Identification list box, the system assigns the code “20” to the Transport Stage Qualifier
field. The qualifier field does not need to be displayed.

Use this procedure to define a constant and hide the Transport Stage Qualifier field.

Sep Action

1 Double-click the TDT:201 element.

System Response
The Element Properties dialog is displayed.

2 Select the Sandard Ruletab.
3 Select Use Constant from the list.
4 Click Edit to display the Map Constants dialog.
5 Click New to display the Edit Constant dialog.
I} Type
| | [ ]

Walue Cancel |

6 In the ID box, enter Main-Carriage Transport.
7 From the Typelist, select Sring.

8 In the Value box, enter 20.

9 Click OK to add the constant.

10 Click Close to exit the Map Constants dial og.
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(Contd)
Sep Action

11 From the Constants list, select 20.

12 From the Qualifies|list, select 3127 CARRIER IDENTIFICATION,
which is the element that the Transport Stage Qualifier field qualifies.

The dialog should now should look like this:

Element Properties E2
Mame I " alidation | Display | Summary List I Help
Extended Rule Standard Rule | Conditions
Fleasze select the standard rule to uge : IUse Constant L]

Flease select a constant to store in this field ;

20 =] | Edt. |

If this constant iz a qualifier for another field, Gentran can automatically uze the
exiztence of data in that fisld to determine whether to execute this standard rule. Ta
take advantage of thiz feature, simply select the field to be gualified ;

CARRIER IDEMTIFICATION

Ok Cancel Spply Help

13 Select the Display tab.

14 Select the Thisfield should not appear on the form option.

15 Click OK to exit the dialog.
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How to customize
the TDT:205
element

Customizing the TDT:2 Segment

The TDT:205 element, the Type of Means of Transport |dentification, contains the eight-
character string that identifies the means of transportation (e.g., ship) for each invoiced
item. You need to customize the TDT:205 element so that a drop-down list box containing
all valid codes in the Transportation Method/Type Code list is available to your users
when they use the screen entry translation object.

After you specify the code list table to use for the drop-down list box for the Type of
Means of Transport Identification field, you need to rename the field label to identify this
field better.

Also, the standard allows thisfield to contain an eight-character string. You know that the
codes from which your users will select are no longer than two characters, so you need to
change the element and field lengths to two.

Use this procedure to load the code list table from the standard, change the element and
field lengths, rename the field |abel, and add Help text to the Transportation Method/Type
Codefield.

Sep Action

1 Double-click the TDT: 205 element.

System Response
The Element Properties dialog is displayed.

2 Select the Validation tab.

3 In the Max box, enter 2 for the maximum number of characters allowed in
this element.

4 Select the Sandard Rule tab.

5 Select Use Code from the list.

6 Click Edit to access the Edit Code List dialog.

The Table ID box contains 8179, the name of the element for which this
code list tableisused. The Desc box contains, TY PE OF MEANS OF
TRANSPORT IDENTIFICATION, the description of the element for
which this code list table is used.

7 Click L oad to accessthe Load Code List dialog. You are prompted to
select an ODBC data source name. Select the appropriate DSN and click
OK to accessthe Load Code List dialog.

8 Click Add All to select al the codes and move them to the Codes Sel ected
list box.
9 Click OK to load the code list and exit the Load Code List dialog.
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(Contd)
Sep Action
10 Click Closeto exit the Edit Code List dialog.
The dialog should now should look like this:
Edit Code List E2
— Table Detailz
Table|D | | Desc |TYFE OF MEANS OF TRANSFORT IDENTI &l
—Allowed Codes (erice] |
Code Value Degcription
1 BARGE CHEMICAL TAMKER - Mew. .
11 SHIP —
12 SHIP TAMKER
13 DCEANWESSELNOS2001 081792 COASTER CH ﬂl
21 R&IL TAMKER
22 RalL SILO TANKER Lkt |
23 RAIL BULK CAR :
24 CUSTOMER R&IL TANKER =
25 R&IL EXPRESS
3 DRY BULK CARRIER )
] TRUCK
2 ROAD TAMKER
! ROAD SILO TAMKER
M TRUCK/TRAILER "WITH TILT
IR TRIICETRAT FRWITHTHT ﬂ
11 Select the Display tab.
12 In the Label box, enter Transport Method.
13 In the Maximum number of characters to be printed box, enter 2.
14 Select the Help tab.
15 In the Help Text box, enter the following text:
Select the transportation method code for thisinvoiced item
from the drop-down list box.
16 Click OK to exit the dialog.
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How to customize  The TDT:207 element contains the Carrier |dentification, a 17-character string that
the TDT:207 identifiesthe carrier for each lineitem. Your users enter a carrier code no longer than 12
eement characters, so you need to change the element and field lengths. You also need to rename
the field label to more accurately describe the contents of thisfield for your users and add
Help text to thisfield.

Use this procedure to change the element and field lengths, rename the field, and add Help
text to the Carrier Identification field.

Sep Action

1 Double-click the TDT: 207 element.

System Response
The Element Properties dialog is displayed.

2 Select the Validation tab.

3 In the Max box, enter 12.

4 Select the Display tab.

5 In the Label box, enter Carrier Code.

6 In the Maximum number of charactersto be printed box, enter 12.
7 Select the Help tab.

8 In the Help Text box, enter the following text:

Enter your company’sreference number for thiscarrier. The
reference number cannot exceed 12 alphanumeric characters.

9 Click OK to exit the diaog.
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Customizing the UNS Segment

Overview  The UNS segment contains the Section Control for the invoice. The Section Control
contains EDI datato instruct the system that the data that follows pertains to the summary
section of the invoice, not the header or detail sections.

How to customize  The UNSO1 element (Section Identification) is a mandatory element for theinvoice. The
the UNSO1 element UNSO1 element contains the one-character code to indicate that the data that follows
pertains to the summary section of the invoice. You need to define a constant value for the
Section Identification field, designating that the constant S (Summary) indicates that the
summary section follows. The system assigns the code S to the Section Identification
field, which does not need to be displayed.

Use this procedure to define a constant and hide the Section Identification field.

Sep Action

1 Double-click the UNSO1 element.

System Response
The Element Properties dialog is displayed.

2 Select the Sandard Rule tab.
3 Select Use Constant from the list.
4 Click Edit to display the Map Constants dialog.
5 Click New to display the Edit Constant dialog.
Edit Constant
[n] Tupe
| | [~

Walue Cancel |

6 In the ID box, enter Summary.

7 From the Typelist, select Sring.

8 In the Value box, enter Sto indicate the Summary section of the invoice.
9 Click OK to add the constant.

10 Click Closeto exit the Map Constants dial og.
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Customizing the UNS Segment

(Contd)
Sep

Action

11

From the Constants list, select S.

The dialog should now should look like this:

Element Properties

Fleasze select the standard rule to uge :

Hame I Validationl Displa_l,JI Help I Extended Rule  Standard Rule | Cnnditionsl

IUse Constant L]
Flease select a constant to store in this field ;

[ o |

If this constant iz a qualifier for another field, Gentran can automatically uze the
exiztence of data in that fisld to determine whether to execute this standard rule. Ta
take advantage of thiz feature, simply select the field to be gualified ;

hd

Cancel

Aapll Help

12

Select the Display tab.

13

Select the Thisfield should not appear on the form option.

14

Click OK to exit the dialog.
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How to generate  Usethis procedure to generate the layout.

the layout
Sep Action
1 Click Generate L ayout on the Main Toolbar to refresh the screen entry
form display.
System Response
The Line Items frame now should look like this:
I Inr: lizmA
Bap "l ﬂ
R L |
Jo-4 : E
R 1
RO |
FiAq |
vl b ol | 3
2 Click Save from the File menu to save the form.
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Customizing the CNT Segment

Overview  The CNT segment contains the Control Total for the invoice. You have already used an
accumulator to generate the total number of lineitemsin theinvoice. The standard allows
the CNT segment to be used up to 10 times per invoice. You need to usethe CNT segment
only once per invoice so you have already changed the maximum use of this segment to
one. Changing the maximum use of this segment placed the total number of line items on
the main Invoice Message frame.

How to customize  The CNTO1 element (Control Qualifier) is a mandatory element for the CNT segment.
theCNT0O1  The CNTOL element contains the three-character code from your EDI datato indicate
dement what type of control follows (e.g., total number of line items). You need to define a
constant value for the Control Qualifier field, designating that the constant, 2 (Number of
Line Itemsin Message), qualifies the value in the Control Value field. The system assigns
the code 2 to the Control Qualifier field so thisfield does not need to be displayed.

Use this procedure to define a constant and hide the Control Qualifier field.

Sep Action

1 Double-click the CNTO1 element.

System Response
The Element Properties dialog is displayed.

2 Select the Sandard Rule tab.
3 Select Use Constant from the list.
4 Click Edit to display the Map Constants dialog.
5 Click New to display the Edit Constant dialog.

Edit Constant E

1] Type

| |

Walue

|
6 In the ID box, enter Number of Line Items.
7 From the Typelist, select Sring.
8 In the Value box, enter 2 to indicate that the Control Qualifier field will

contain the total number of lineitemsin the invoice.

9 Click OK to add the constant.

10 Click Close to exit the Map Constants dial og.
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(Contd)
Sep Action

11 From the Constants list, select 2.

12 From the Qualifieslist, select 6066 CONTROL VALUE, which isthe
element that the Monetary Amount Type Qualifier field qualifies.

The dialog should now should look like this:

Element Properties E2
M armne I " alidation | Dizplay | Surnrnary List I Help
Extended Rule Standard Rule | Conditions
Flease zelect the standard rule to use IUse Coriztant L]

Fleaze select a constant ta stare in this field ;

2 =] | Edt. |

If this constant iz a qualifier for another field, Gentran can automatically uze the
exiztence of data in that fisld to determine whether to execute this standard rule. Ta
take advantage of thiz feature, simply select the field to be gualified ;

GOGE COMTROL YWALLIE

ak Cancel Sl Help

13 Select the Display tab.

14 Select the Thisfield should not appear on the form option.

15 Click OK to exit the dialog.
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How to customize  The CNTO02 element contains the Control Value for the invoice. You have already used an
theCNT02  accumulator for thisfield to generate atotal of the number of line items and made this
eement field display-only so that users cannot change the value in this field.

You must rename the field label to more clearly identify its contents. The standard
designates an R9 screen format and EDI format for this field, meaning that the number is
formatted with an explicit decimal point and up to nine decimal places. The datais
formatted in the NO format (a number with an implicit decimal point and no decimal
places) so you need to change the screen format and EDI format from R9 to NO.

The standard defines this element as having a maximum length of eight. Your users enter
no more than 99,999 line items so this field needs a maximum length of only six.

Use this procedure to rename the field label, change the field and element lengths, and
change the screen and EDI formats for the Control Value field.

Sep Action

1 Double-click the CNT02 element.

System Response
The Element Properties dialog is displayed.

2 Select the Validation tab.
3 In the Max box, enter 6.
4 From the Screen Format list, select NO to indicate that thisfield on the

translation object will accept a number with an implicit decimal point and
no decimal places.

5 From the EDI Format list, select NO to format the EDI data with an
implicit decimal point and no decimal places.

6 Select the Display tab.

7 In the Label box, enter Number of Line Items.

8 In the Maximum number of characters to be printed box, enter 6

9 Click OK to exit the diaog.
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Customizing the MOA Group

Overview  The MOA group contains the Monetary Amount for the invoice. The standard allows this
MOA group to be used up to 100 times per invoice. You need to use this MOA group only
once per invoice. You have already changed the maximum use of the MOA group to one
and promoted the group to obtain just one instance of the MOA group and to place the
total invoice amount on the main Invoice Message frame.

Note
The MOA group that you want to customize is at the bottom of the map NOT in the LIN
group.
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Customizing the M OA:10 Segment

Overview  The MOA:10 segment containstheinvoice's Monetary Amount. You have already used an
accumulator to calculate the total dollar amount invoiced.

How to customize  The MOA:1001 element (Monetary Amount Type Qualifier) is amandatory element for
the MOA:1001  the MOA:10 segment. The MOA:1001 element contains the three-character code from
dement your EDI datato indicate what type of monetary amount follows (e.g., total invoice

amount). You need to define a constant value for the Monetary Amount Type Qualifier
field, designating that the constant “ 77" (Invoice Amount) qualifies the value in the
Monetary Amount field. The system automatically will assign the code “ 77" to the
Monetary Amount Type Qualifier field, so this field does not need to be displayed on the
tranglation object.

Use this procedure to define a constant and hide the Monetary Amount Type Qualifier
field.

Sep Action

1 Double-click the M OA:1001 element.

System Response
The Element Properties dialog is displayed.

2 Select the Sandard Rule tab.
3 Click the Use Constant option.
4 Click Edit to display the Map Constants dialog.
5 Click New to display the Edit Constant dialog.
Edit Constant
[n] Tupe
| | =l

Walue Cancel |

6 In the ID box, enter Invoice Amount.
7 From the Typelist, select String.

8 In the Value box, enter 77.

9 Click OK to add the constant.

10 Click Closeto exit the Map Constants dialog.

11 From the Constants list, select 77.
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(Contd)
Sep Action

12 From the Qualifieslist, select 5004 MONETARY AMOUNT whichis
the element that the Monetary Amount Type Qualifier field qualifies.

The dialog should now should look like this:

Element Properties E2
M armne I " alidation | Dizplay | Surnrnary List I Help
Extended Rule Standard Rule | Conditions
Fleasze select the standard rule to uge : IUse Constant L]

Flease select a constant to store in this field ;
77 i | Edi. |

f this constant iz a qualifier for anather field, Gentran can automatically use the
exiztence of data in that field to determine whether to execute thiz standard rule. To
take advantage of this feature, simply select the field to be qualified :

5004 MOMETARY AMOLINT

Ok Cancel Spply Help

13 Select the Display tab.

14 Select the Thisfield should not appear on the form option.

15 Click OK to exit the dialog.

How to customize  The MOA:1002 element contains the Monetary Amount for theinvoice. You have already
the MOA:1002 used an accumulator for thisfield to calculate the total dollar amount invoiced and made
dement this field display-only so that users cannot change the value in thisfield.

You need to rename the field label to more clearly identify its contents. Also, the standard
designates an “R9” screen format and EDI format for this field, meaning that the number
is formatted with an explicit decimal point and up to nine decimal places. The datais
formatted in the “R2” format (a number with an explicit decimal point and up to two
decimal places) so you need to change the screen format and EDI format from “R9” to
“R2.”

The standard defines this element as having a maximum length of 18. The total invoice
amount will total no more than $999,999.99 so this field needs a maximum length of only
10 (six placesfor the dollars; two places for the cents; one place for the decimal point, and
one place for aplus or minus sign, if present).
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Creating a Screen Entry Form Customizing the MOA:10 Segment

Use this procedure to rename the field label, change the field and element lengths and to
change the screen and EDI formats for the Monetary Amount field.

Sep Action

1 Double-click the M OA:1002 element.

System Response
The Element Properties dialog is displayed.

2 Select the Validation tab.

3 In the Max box, enter 10 to allow al0-digit number in this element,
including a plus or minus sign and a decimal point.

4 From the Please choose the format of the datain the form list, select R2.

5 From the Please choose the format of the datain the file, select R2.

6 Select the Display tab.

7 In the Label box, enter Total 1 nvoice Amount.

8 In the Maximum number of characters to be printed box, enter 10.

9 Click OK to exit the dialog.

How to generate  Usethis procedure to generate your layout and to save your form.

the layout
Sep Action
1 Click Generate Layout on the Main Toolbar to refresh the print form
display.
2 Click Save from the File menu to save the form.

Now that you have customized all of the elements used in thisinvoice, you are ready to
format the fields and label s to make the frames more consistent and visually attractive.
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Overview Creating a Screen Entry Form

Format the Screen Entry Form

Overview

Introduction In the previous section of thistutorial, you customized the screen entry form for an
EDIFACT 92.1 invoice (INVOIC) that your users use to enter data to invoice Pet Zone for
items that were shipped to them. After successfully customizing the fields and elements of
the screen entry form, you are ready to format the layout of the form.

This section explains how to format the form, field by field.
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Creating a Screen Entry Form Resizing the Invoice Message Frame

Resizing the I nvoice M essage Frame

Overview  When aformis compiled into atrandation object, the fields are arranged according to
how the frames and the fields contained in them were arranged when the form was
compiled. You should eliminate unnecessary space as you arrange the fields on each
frame.

Warning
Your screen resolution must be the same asthat of the end user of the completed form.

Procedure  Use this procedure to resize the Invoice Message frame.

Sep Action
1 Click the INVOIC fileicon to display the Invoice Message frame in the
Layout Window.
2 To display more of the form on your screen, click and drag the center bar

between the EDI File Format Window and the Layout Window to the left
until the Layout Window iswide enough to display as much of theform as
you want to view.
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Resizing the Invoice Message Frame Creating a Screen Entry Form

(Contd)
Sep Action
3 To resize the Invoice Message frame, click and drag the right side of the

frame approximately to the 14 cm. mark on the horizontal ruler so that the
form is wide enough to format the fields according to the instructions in
thistutorial.

Note

Use the horizonta ruler at the top of the frame to help you resize the
frame. The instructionsin thistutorial are given in centimeters. You can
toggle from inches to centimeters by double-clicking the yellow square
where the vertical and horizontal rulers meet.

The Invoice Message frame now should look like this:

IIIVI Iil:l‘! MH ENHE

Ikecica M2

Ikecicz O

PO.Lz

F.O. Gz

[F il

Crwvrit D

Shir Tn

Sterling Gentran:Server — May 2011 Forms Integration EDIFACT Tutorial Guide



Creating a Screen Entry Form Arranging the Fields on the Invoice Message Frame

Arranging the Fields on the I nvoice M essage Frame

Overview  You will begin formatting the screen entry form by arranging the fields on the Invoice
Message frame. You need to place the fields in the translation object in alogical order,
then align the fields to give the frame a consistent and orderly appearance.

Messageframe  When you have finished arranging the fields, your Invoice Message frame should look
like the one in the exampl e below.
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By default, each field and its associated label are displayed on its own line. It is common
for invoices to place two or more fieldson aline.

You prevented some of thefield 1abelsfrom being displayed by removing the field label in
the Display Properties dialog. These fields the fields are displayed on your screen entry
form, but their associated labels are not displayed.

Note

If you forget which unlabeled field contains what data, you can click thefield. Its
associated element is highlighted in the EDI File Format Window, providing you with a
description of the field.
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Arranging the Fields on the Invoice Message Frame Creating a Screen Entry Form

How to resize, Use this procedure to resize, move, and align the fields on the Invoice Message frame of
move, and align  the screen entry form.

thefields Note

If afield and its corresponding field label move together, the Lock Labelsto Fields option
isturned on. Clear the Lock Labels button on the Main Toolbar to turn off the Lock Labels

option.

Sep

Action

1

Click and drag the bottom of the frame to the bottom of the Forms
window, so that as many of the fields on the frame are displayed as
possible.

Select the following fields:

» InvoiceNo.

» InvoiceDate

» PO.No.

» PO.Date

» Contract No.

» Contract Date

» City Name (both Ship To and Remit To)

» Country Sub-Entity Identification (both Ship To and Remit To)
» Number of Line ltems

» Total Invoice Amount

Note

To select more than one field, select the first field, press CTRL and click

the second field. Repeat this process for each subsequent field you want to
select.

Note

If any of thesefieldsis not in the part of the Invoice Message frame that
currently is displayed, then use the scroll bar to scroll down the frame
until you locate the hidden field(s).

Select Sizeto Length from the Display menu. The selected fields will be
resized to the lengths specified in the Maximum number of charactersto
be printed box of the Display Properties dialog for each field.

Note
If you format aform component in away you did not intend, select Undo
from the Display menu to undo your last formatting action.
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Arranging the Fields on the Invoice Message Frame

(Contd)
Sep

Action

4

Select the following fields and drag them closer to their respective field
|abels:

» InvoiceNo.

» Invoice Date
» PO. No.

» PO.Date

» Contract No.
» Contract Date

Select the Invoice Date label and field and drag them to the upper right
corner of the Invoice Message frame.

Select the P.O. No. label and field and drag them to the | eft side of the
frame, below the Invoice No. label and field.

Select the P.O. Date label and field and drag them to the right side of the
frame, below the Invoice Date label and field.

Select the Contract No. label and field and drag them to the left side of
the frame, below the P.O. No. label and field.

Select the Contract Datelabel and field and drag them to the right side of
the frame, below the PO. Date label and field.

10

Select the Ship To field (not the field label), the two Street and Number/
P.O. Box fields, and the City Name field of the Ship To address. (The two
Street and Number/P.O. Box fields and the City Name field are located
below the Ship To field.)

11

Select Align Controls from the Display menu, then select L eft from the
Align Controls submenu. The left margins of the selected fields are
aigned.

12

Select the Country Sub-Entity I dentification field of the Ship To
address and drag it to the immediate right of the City Name field of the
Ship To address.

13

Select the Postcode | dentification field of the Ship To address and drag it
to theimmediate right of the Country Sub-Entity Identification field of the
Ship To address.

14

Click and drag al of the Ship To fields (not including the Ship To field
label) closer to the Ship To label, so that none of the fields extend beyond
the right side of the frame.

Forms Integration EDIFACT Tutorial Guide
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Arranging the Fields on the Invoice Message Frame Creating a Screen Entry Form

(Contd)
Sep

Action

15

Click and drag all of the Ship To fields (including the Ship To field label)
to the |eft side of the frame, below the Contract No. label and field.

Note

To select agroup of items, click and drag the mouse diagonally across all
thefields and field labels you want to select. When you rel ease the mouse
button, al the fields and field labels completely included within the
dragged-across areawill have handles, indicating they were selected.

16

Select the Remit To field (not the field label), the two Street and Number/
P.O. Box fields, and the City Name field of the Remit To address. (The
two Street and Number/P.O. Box fields and the City Namefield are
located below the Remit To field.)

17

Select Align Controls from the Display menu, then select Left from the
Align Controls submenu. The left margins of the selected fields are
aligned.

18

Select the Country Sub-Entity I dentification field of the Remit To
address and drag it to the immediate right of the City Name field of the
Remit To address.

19

Select the Postcode | dentification field of the Remit To address and drag
it to the immediate right of the Country Sub-Entity Identification Code
field of the Remit To address.

20

Click and drag all of the Remit To fields (not including the Remit To field
label) closer to the Remit To label, so that none of the fields extend
beyond the right side of the frame.

21

Click and drag all of the Remit To fields (including the Remit To field
label) below the Ship To address.

22

Select the Payment Terms Codelist.

23

Click and drag itsright handle so that the list box is approximately 1.5 cm.
wide (including the Down Arrow).

24

Click and drag its bottom handle to make the drop-down part of the list
box long enough to list approximately four codes (approximately 2 cm.
long on the vertical ruler).

25

Click and drag the Payment Ter ms Code drop-down list box closer toits
label.

26

Select the Payment Terms Code drop-down list box and label and drag
them to the center of the frame, below the Remit To address.

27

Select the Line Itemsist box and drag it closer to its label.
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Arranging the Fields on the Invoice Message Frame

(Contd)
Sep

Action

28

Select the Line ltemslist box and label and drag them to the center of the
frame, below the Payment Terms Code list box and label.

Note

L eave extra space between the Payment Terms Code list box and label,
and the Line Items ist box and label, to add column headings (using static
text) to label the datain the list box.

29

Select the Number of Lineltemsfield and drag it closer to itslabel.

30

Select the Number of Line ltemslabel and field and drag them to the
center of the frame, below the Line Items list box.

31

Select the Total Invoice Amount field and drag it closer to its label.

32

Select the Total Invoice Amount label and field and drag them to the
center of the frame, below the Number of Line Items label and field.
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Arranging the Fields on the Invoice Message Frame

How toresizethe
invoice message
frame

resize the frame vertically.

Creating a Screen Entry Form

You should resize the Invoice M essage frame to make the most efficient use of space. You
have already resized the frame horizontally before you began arranging the fields. Then,
you arranged the fields on the frame so the fields do not use the same amount of vertical
space as before you arranged the fields. To make better use of the frame space, you need to

Step

Action

1

To resize the Invoice Message frame, scroll to the top of the Invoice

Message frame, then click and drag the bottom of the frame to just below
the Total Invoice Amount label and field.

System Response

The Invoice Message frame now should look like this:
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Select Save from the File menu.
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Creating a Screen Entry Form

Arranging the Fields on the Invoice Message Frame

How toalignthe  Now that the fields in the Invoice Message frame are resized and moved to their proper
fieldsand field locations, you can align the fields and labels.

labels

Use this procedure to align the fields and field labels on the Invoice Message frame.

Step

Action

1

Select the following field labels:

» Invoice No.

» PO. No.

» Contract No.
» ShipTo

» RemitTo

Select Align Controls from the Display menu, then select L eft from the
Align Controls submenu. The left margins of the selected field labels are
aligned.

Select the following fields:
» InvoiceNo.

» PO.No.

» Contract No.

Select Align Controls from the Display menu, then select L eft from the
Align Controls submenu. The left margins of the selected fields are
aligned.

Select the following field |abels:
» Invoice Date

» PO.Date

» Contract Date

Select Align Controls from the Display menu, then select L eft from the
Align Controls submenu. The left margins of the selected field labels are
aligned.

Select the following fields:
» InvoiceDate

» PO.Date

» Contract Date

Select Align Controls from the Display menu, then select L eft from the
Align Controls submenu. The left margins of the selected fields are
aligned.
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Arranging the Fields on the Invoice Message Frame Creating a Screen Entry Form

(Contd)
Sep Action

9 Select the following field |abels:
» Number of Line ltems
» Total Invoice Amount

10 Select Align Controls from the Display menu, then select L eft from the
Align Controls submenu. The left margins of the selected field labels are
aligned.

11 Select the following fields:
» Number of Line Items
» Total Invoice Amount

12 Select Align Controls from the Display menu, then select L eft from the
Align Controls submenu. The left margins of the selected fields are
aigned.
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Creating a Screen Entry Form Arranging the Fields on the Invoice Message Frame

(Contd)
Sep Action

13 To align the tops of all of the field labels and fields, select each row of
fields and labels (one row at atime), select Align Controls from the
Display menu, then select Top from the Align Controls submenu. The
fields and labels for each row are listed below:

» Invoice No. label and field, Invoice Date label and field

» PO. No. label and field, PO. Date label and field

» Contract No. label and field, Contract Date label and field
» ShipTolabel andfield

» City Name, Country Sub-Entity Identification, and Postcode
Identification fields of the Ship To address

» Remit Tolabel and field

» City Name, Country Sub-Entity Identification, and Postcode
Identification fields of the Remit To address

» Payment Terms Code label and drop-down list box
» Lineltemslabel and list box

» Number of Line Itemslabel and field

» Total Invoice Amount label and field

The Invoice Message frame now should look like this:
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How to add
column headings
tothelineitemslist
box

Sterling Gentran: Server labels the fields on the Line Items frame, but does not label the
column headingsfor the Line Itemslist box on the Invoice Message frame. The Line ltems
list box displays the information entered into the fields on the Line Items frame. To label
the columnsin the Line Items list box, you must add the column headings with static text
(text that is alwaysincluded in the screen entry translation object).

You will add the following column headings to the Line Items list box on the Invoice

Message frame;
Column Heading
(Static Text) Placement Above LineltemsList
[tem First column
Product Second column
Qty. Third column
Price Fourth column

Use this procedure to add and position the column headings.

Sep Action

1 Click Add Text on the Main Toolbar. Text is added to the current frame,
displayed in the upper left corner of the frame. If the template is larger
than the frame (there is a scroll bar on the right side of the frame), the
static text is displayed in the upper |eft corner of the part of the template
that is displayed, not at the top of the template.

2 Select the new text box and enter Item. The Text Propertiesdialog is
displayed as you are typing. Click OK to add the text.

3 Click and drag it to above the Line Itemslist box, immediately to the right
of the left margin of the Line Items list box (so it looks like the example
on 3- 151).

4 Click Add Text onthe Main Toolbar to add text to the current framein the
upper left corner.

5 Select the new text box and enter Product. The Text Propertiesdialog is
displayed as you are typing. Click OK to add the text.

6 Click and drag it to above the Line Items list box, to the right of the Item
column heading (so it looks like the example on 3 - 151).

7 Click Add Text on the Main Toolbar to add text to the current framein the

upper left corner.
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Arranging the Fields on the Invoice Message Frame

(Contd)
Sep

Action

8

Select the new text box and enter Qty. (note the period in the text). The
Text Propertiesdialog is displayed as you are typing. Click OK to add the
text.

Click and drag it to above the Line Items list box, to the right of the
Product column heading (so it looks like the example on 3 - 151).

10

Click Add Text on the Main Toolbar to add text to the current framein the
upper left corner.

11

Select the new text box and enter Price. The Text Propertiesdialog is
displayed as you are typing. Click OK to add the text.

12

Click and drag it to above the Line Items list box, to the right of the Qty.
column heading (so it looks like the example on 3 - 151).

13

To ensure that the column headings (static text) you just added are aligned
properly, select al the static text you just added (Item, Qty., Product,
Price). Select Align Controlsfrom the Display menu, then select Top
from the Align Controls submenu.

14

The Invoice Message frame now should look like this:
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How to set thetab
sequence on the
invoice message

frame

The tab sequence is the order in which the cursor moves from field to field in the screen
entry translation object when a user presses TAB. When you create a screen entry form,
the system automatically positions the fields and sets the tab sequence for those fields.
However, you usually will want to modify the tab sequence of the fields to meet your
screen entry requirements and the new positions of the fields on the frame.

Use this procedure to set the tab sequence for the fields on the Invoice Message frame.

Sep Action

1 Select Set Tab Order from the Display menu.

System Response
Numbers are displayed in the fields on the frame to indicate the current
tab sequence.
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Creating a Screen Entry Form Arranging the Fields on the Invoice Message Frame

(Contd)
Sep Action
2 Click thefields listed below in the order in which they arelisted. Asyou

click each field, the tab sequence number for that field will change to the
next sequential number in the tab sequence.

Note
If you click afield out of sequence, you must begin setting the tab

sequence again. To start over, select Set Tab Order from the Display menu
so that the tab sequence numbers are no longer displayed in the fields on
the frame, and then begin these steps again.

a Invoice No.

b. Invoice Date

c. PO. No.

d. PO.Date

e. Contract No.

f.  Contract Date

g. Ship To Party Name

h.  Ship To Street and Number/P.O. Box (first line of address)

Ship To Street and Number/P.O. Box (second line of address)
j. Ship To City Name

k. Ship To Country Sub-Entity Identification

[.  Ship To Postcode I dentification

m. Remit To Party Name

n. Remit To Street and Number/PO. Box (first line of address)

0. Remit To Street and Number/P.O. Box (second line of address)
Remit To City Name

Remit To Country Sub-Entity Identification

Remit To Postcode | dentification

-

s. Payment Terms Code
t. Lineltems
u. Number of Line Iltems

v. Tota Invoice Amount
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(Contd)
Sep Action
3 The new tab sequence should look like this:
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Note

When you click the last field in the sequence (Total Invoice Amount), the
tab sequence is set, and the tab sequence numbers no longer are displayed
inthefields.
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Arranging the Fieldson theLineltems Frame

Overview  Now that thefields, labels, and static text are arranged on the Invoice Message frame, you
are ready to arrange the fields on the Line Items frame. You will place the fieldsin a
logical order, then align the fields (as you did with the fields on the Invoice Message
frame) to give the frame a consistent and orderly appearance.

How toresizethe  Beforeyou begin arranging thefields on the Line Items frame, you should resize the frame
lineitemsframe  sothat it isthe same width asthe Invoice Message frame. When thisform is compiled into
atrandation object, the fields will be arranged according to how the frames and the fields
contained on them were arranged when the form was compiled. You should eliminate
unnecessary space as you arrange the fields on each frame.

Use this procedure to resize the line items frame.

Sep

Action

1

Click the LIN group to display the Line Items frame in the Layout
Window.

Toresizethe Line Items frame, click and drag the right side of the frame
to the 14 cm. mark on the horizontal ruler so that the form iswide enough
to format the fields according to the instructions in this tutorial.

To display more of the form on your screen, click and drag the center bar
between the EDI File Format Window and the Layout Window to the left
until the Layout Window iswide enough to display as much of theform as
you want.

The Line Items frame now should look like this:
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How toresizethe  Usethis procedure to resize the fields on the Line Items frame of the screen entry form.

fields Note

If any of the fields are not in the part of the Invoice Message frame that currently is
displayed, then use the scroll bar to scroll down the frame until you locate the hidden

field(s).

Sep

Action

1

Select the following fields:

» ItemNo.

» Product Code
» Quantity

» Date Shipped
» Price

» Transport Method
» Carrier Code

Note
To select more than onefield, select thefirst field, press CTRL and select
the second field. Repeat this process for each subsequent field you want to
select.

Select Size to Length from the Display menu.

System Response

The selected fields are resized to the lengths specified in the Maximum
number of charactersto be printed box of the Display Propertiesdialog for
each field.

How to move and Use this procedure to move and align the fields on the Line Items frame of the screen entry

align thefields  form.

Step

Action

1

Select the UOM field and drag its right handle so that the field is
approximately 2 cm. wide (including the Down Arrow).

Drag its bottom handle so that thefield islong enough for four codesto be
displayed in it when the drop-down part of the drop-down list is open
(approximately 2 cm. on the vertical ruler).

Select the Transport Method and UOM fields (in that order).
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(Contd)
Sep

Action

4

Select Size Equally from the Display menu. The Transport Method field
isthe same size asthe UOM field. The UOM field is the reference,
meaning that it isthe field relative to which all other selected itemsin the
form are formatted. The referenceis indicated by an outline of diagonal
lines, whereas all other selected items are outlined by asolid line. The last
item (field, field label, or static text) selected in a group of selected items
isthe reference.

Select each field on the frame individually and moveit closer to its
respective field label.

Select the Product Code label and field and drag them to the right of the
Item No. label and field (use the example on 3 - 160 for reference).

Note
Theltem No. label and field have already been positioned where you want
them to be (in the upper |eft corner of the frame). You do not need to move
them.

Select the Quantity label and field and drag them to the right of the
Product Code label and field (use the example on 3 - 160 for reference).

Select the UOM label and field and drag them below the Item No. label
and field. The left side of the UOM field label should be aligned with the
left side of the Item No. field label. (Use the example on 3 - 160 for
reference.)

Select the Price label and field and drag them below the Product Code
label and field. Theleft side of the Pricefield label should be aligned with
the left side of the Product Code field label. (Use the example on 3 - 160
for reference.)

10

Select the Item Description label and field and drag them below the
UOM and Price labels and fields. The left side of the Description field
label should be aligned with the | eft side of the Item No. and UOM field
labels. (Use the example on 3 - 160 for reference.)

11

Select the Date Shipped label and field and drag them to the left side of
the frame, below the Item Description label and field. The left side of the
Date Shipped field label should be aligned with the left side of the Item
No., UOM, and Item Description field labels. (Use the example on 3 - 160
for reference.)

12

Select the Transport M ethod label and field and drag them to the right of
the Date Shipped label and field (use the example on 3 - 160 for
reference).

13

Select the Carrier Code label and field and drag them to the right of the
Transport Method label and field (use the example on 3 - 160 for
reference).
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How toresizethe  Usethis procedure to resize the line items frame.
lineitemsframe

Sep Action

1 Toresize the Line Items frame, click and drag the bottom of the frame to
below the last row of fields and labels (Date Shipped, Transport Method,
and Carrier Code).

Note
Allow enough space between the last row of fields/labels and the bottom
of the frame for the Transport Method drop-down list box to be opened.

The Line Items frame now should look like this;
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How toalignthe  Usethis procedure to align the fields and field labels on the Line Items frame.
fieldsand field

labels
Sep Action

1 Select the following labels and fields:
» ItemNo.
» Product Code
» Quantity

2 Select Align Controls from the Display menu, then select Top from the
Align Controls submenu. The tops of the selected items are aligned.

3 Select the following labels and fields:
» UOM
» Price

4 Select Align Controls from the Display menu, then select Top from the
Align Controls submenu. The tops of the selected items are aligned.

5 Select the Item Description label and field.

6 Select Align Controls from the Display menu, then select Top from the

Align Controls submenu. The tops of the label and field are aligned.
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Creating a Screen Entry Form

Arranging the Fields on the Line Items Frame

(Contd)
Sep

Action

7

Select the following labels and fields:
» Date Shipped

» Transport Method

» Carrier Code

Select Align Controls from the Display menu, then select Top from the
Align Controls submenu. The tops of the selected items are aligned.

Select the following field labels:

» ItemNo.

» UOM

» Item Description
» Date Shipped

10

Select Align Controls from the Display menu, then select L eft from the
Align Controls submenu. The tops of the selected field labels are aligned.

11

Select the following fields (in this order):
» UOM
» ItemNo.

12

Select Align Controls from the Display menu, then select L eft from the
Align Controls submenu. The left margins of the selected fields are
aigned.

13

Select the following field labels:
» Product Code
» Price

14

Select Align Controls from the Display menu, and select L eft from the
Align Controls submenu. The left margins of the selected field labels are
aligned.

15

Select the following fields (in this order):
» Price
» Product Code

Forms Integration EDIFACT Tutorial Guide
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Arranging the Fields on the Line Items Frame Creating a Screen Entry Form

(Contd)
Sep Action

16 Select Align Controls from the Display menu, then select L eft from the
Align Controls submenu. The left margins of the selected fields are
aligned.

The Line Items frame now should look like this:

Linc Mocma

l:zm o | Pecouc: Coca |:| [ _zmile |:
| I —

1= desrtivion | |

Dl 3o :l T cipauil b all wl |: E Caie Saug I:

How to set thetab Use this procedure to set the tab sequence of the fields on the Line Items frame.
sequence on the
lineitemsframe

Sep Action

1 Select Set Tab Order from the Display menu.

System Response
Numbers are displayed in the fields on the frame to indicate the current
tab sequence.

Lime: Hunna

1 Pl L Fiok A ke E Wir . M i'
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Creating a Screen Entry Form

Arranging the Fields on the Line Items Frame

(Contd)
Sep

Action

2

Click thefields listed below in the order in which they arelisted. Asyou
click each field, the tab sequence number for that field changesto the next
sequential number in the tab sequence you are now setting.

a  Product Code

b. Quantity
c. UOM
d. Price

e. Item Description
f. Date Shipped

g. Transport Method
h. Carrier Code

i. Iltem No.

Note

The Item No. field isthe last field in the tab sequence, although it isthe
first field in the layout of the Line Items frame. Thisfield is display-only,
displaying the next consecutive item number for the invoice (theitem
number is generated by an accumulator in the Item No. field). By placing
the Item No. field last in the tab sequence, this field can be skipped easily
by users entering data. Thefirst field in the sequence is the Product Code
field, which isthefirst field into which users can enter avalue.

The new tab sequence should look like this:

Line e =
-
la 'l 3 | =l ﬂ | -l g | j
N iR —

la Mawin H
[ime ) p:-e:IE Timrsoct ke -oz E [ ] :x:-a
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Changing the Invoice Message Frame Title Creating a Screen Entry Form

Changing the Invoice Message Frame Title

Overview  The system titles the framesin a screen entry form when the form is created, based on the
name of the file, segment(s), or group(s). You can modify the frame titles (for example, at
the file or message level) to distinguish one form from the others. The parent frame of the
invoice currently istitled Invoice Message. You need to give thisframe amore descriptive
title to distinguish it from other invoices that your company uses.

Procedure  Usethis procedure to change the frametitle.

Sep Action

1 Click the INVOIC fileicon with the right mouse button and select
Properties from the shortcut menu.

System Response
The File Format Properties dialog is displayed.

File Format Properties E
Marme | Displayl Drelimiters I Loop Extended Hulesl
Fleasze enter the name ;
IM
Please enter a short description
INWOICE MESSAGE

QK. Cancel Lpply Help

2 Click the Display tab.

3 In the Frame Caption box, enter EDIFACT Invoice (INVOIC) - Pet
Zone.

4 Click OK.

System Response
The new framet title is displayed in the frametitle in the Layout Window.
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Creating a Screen Entry Form Changing the Invoice Message Frame Title

How to generate  Usethis procedure to generate your layout and to save your form.
the layout

Sep Action

1 Click Generate Layout on the Main Toolbar to refresh the display of the
screen entry form.

2 Select Save from the File menu to save the form.

You have completed your Invoice form. Now, you are ready to finalize the form.
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Overview Creating a Screen Entry Form

Finalize the Form

Overview

Introduction Now that you have created and customized a screen entry form, you are ready to compile
the form to generate the translation object (*.TPL) that Sterling Gentran; Server uses
before you print the report and test the compiled trandlation object.
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Creating a Screen Entry Form Compiling the Form

Compiling the Form

Overview  The Compile function generates the form. The form that you create is a source form.
When that source form is compiled, the result is a compiled translation object.

After you save the tranglation object, you must register it with Sterling Gentran: Server

system before you can use it. You will use the Compile function after the formis
completed and saved.

Procedure  Usethis procedure to compile the form.

Sep Action
1 Select Compile from the File menu to display the Run-Time Trandlation
Object Name dialog.
Run-Time Translation Object Name EE
Save jm: I 3 TransObj j gl IH
Pet_&10s.tpl
peteordp. TPL
File name: Ipeteinvs.TF‘L
Save as bype: | Translation Obiects [~ TFL) =l Cancel |
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Compiling the Form Creating a Screen Entry Form

(Contd)
Sep Action

2 Click Save to accept the trandation object name (peteinvs.tpl) in the File
name box.

This name for the compiled translation object (.TPL file) isthe samefile
name as the source form (.STP fil€). Preserving the same file name (with
different file extensions) ensures that the relationship between the source
form and the compiled translation object remains evident.

CAUTION

DO NOT TO OVERLAY THE SOURCE FORM WITH THE
COMPILED TRANSLATION OBJECT. USE THE .TPL
FILE EXTENSION TO DISTINGUISH THE COMPILED
TRANSLATION OBJECT.

The system compiles the form and generate an error report. The error
report is displayed in the Compile Errors dialog.

Comgile Crioes - pebsins. sip

Loz sep IHUL i I
Comzlig acp 2220 LI

Gt np e § e, Tears g

3 Click OK to exit the Compile Errors dial og.

Note

If the Compile Errors dialog contains errors, you must fix the problem(s)
by redoing the appropriate section of the tutorial. Recompile the form
after you correct the error(s) and save the form.

4 Select Save from the File menu to save the form. The date on which you
compiled the form is automatically loaded into the Compiled on box on
the Trandlation Object Details dialog.

Sterling Gentran:Server — May 2011 Forms Integration EDIFACT Tutorial Guide



Creating a Screen Entry Form Compiling the Form

(Contd)
Sep Action
5 Select Edit/Details to access the Translation Object Details dialog. The
date on which you compiled the form is loaded automatically into the
Compiled on box.
6 Click Cancel to exit the dialog.
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Printing the Report

Printing the Report

Creating a Screen Entry Form

Overview  The Sterling Gentran: Server report enables you to validate and review the translation
object, and make modifications as needed. If you review the report and determine that the
tranglation object is incorrect, you need to make modifications, save the form, recompile
the form, and print the report again.

Procedure  Usethis procedure to print the Sterling Gentran: Server report.

Sep

Action

1

Select Print from the File menu to access the Print Options dialog.

— Report sectionz

¥ Fiint branching diagram
¥ Fiint record details ﬂl
¥ Frint mapping detailz
¥ Print extended rules

¥ Frint code lists

v Include only active objscts

Click OK to accept the defaults on thisdialog (all options selected), so the
report includes all sections and only the activated form components.

System Response
The Print dialog is displayed.

Do you need to change setup options (to select a specific printer, paper
orientation, or size and source of paper) ?

» If yes, click Properties. Set the appropriate options. Click OK to
begin the print process.

» If no, click OK to begin the print process.

Sterling Gentran:Server — May 2011

Forms Integration EDIFACT Tutorial Guide



Creating a Screen Entry Form

Testing the Trandation Object

Testing the Trangation Object

Overview  After you compilethe form, print and verify the report, and register the translation object
with Sterling Gentran: Server, you should test the translation object to verify that the data
istrandated correctly. To test the compiled trandlation object, you should use the
trand ation object to create a new document. You also should verify acknowledgement
processing (if applicable) and verify communications with your network.

Procedure  Following isan overview of the procedure for testing the screen entry translation object

you just created.
Sep Action
1 Register the PETEINVS.TPL translation object with Sterling

Gentran:Server.

Reference
See the IBM® Serling Gentran: Server® for Microsoft Windows User
Guide for more information on registering a translation object.

If you have not done so aready, import the PETZONE2.PAR partner
relationship into Sterling Gentran: Server.

Reference
See the IBM® Serling Gentran: Server® for Microsoft Windows User
Guide for more information on importing a partner.

Verify (in Partner Editor) that the Screen INVOIC Pet Zone screen entry
translation object is selected for the Outbound Relationship.

Reference
See the IBM® Serling Gentran: Server® for Microsoft Windows User
Guide for more information on selecting outbound translation objects.

Create a new document (partner PETZONEZ2 and relationship
PETZONE2 _EDIFACT_INVOIC) to enter the datain the screen entry
translation object you created.

Reference
See the IBM® Serling Gentran: Server® for Microsoft Windows User
Guide for more information on creating a document.
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Notices

Thisinformation was devel oped for products and services offered in the U.S.A.

IBM may not offer the products, services, or features discussed in this document in other
countries. Consult your local IBM representative for information on the products and
services currently available in your area. Any reference to an IBM product, program, or
service is not intended to state or imply that only that IBM product, program, or service
may be used. Any functionally equivalent product, program, or service that does not
infringe any IBM intellectual property right may be used instead. However, it isthe user's
responsibility to evaluate and verify the operation of any non-IBM product, program, or
service.

IBM may have patents or pending patent applications covering subject matter described in
this document. The furnishing of this document does not grant you any license to these
patents. You can send license inquiries, in writing, to:

IBM Director of Licensing

IBM Corporation

North Castle Drive

Armonk, NY 10504-1785

U.SA.

For license inquiries regarding double-byte character set (DBCS) information, contact the
IBM Intellectual

Property Department in your country or send inquiries, in writing, to:
Intellectual Property Licensing
Legal and Intellectual Property Law

IBM Japan Ltd.
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1623-14, Shimotsuruma, Yamato-shi
Kanagawa 242-8502 Japan

Thefollowing paragraph doesnot apply to the United Kingdom or any other country
wheresuch provisionsareinconsistent with local law: INTERNATIONAL BUSINESS
MACHINES CORPORATION PROVIDES THIS PUBLICATION "ASIS' WITHOUT
WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED, INCLUDING, BUT
NOT LIMITED TO, THE IMPLIED WARRANTIES OF NON-INFRINGEMENT,
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. Some states do
not allow disclaimer of express or implied warranties in certain transactions, therefore,
this statement may not apply to you.

Thisinformation could include technical inaccuracies or typographical errors. Changes
are periodically made to theinformation herein; these changes will be incorporated in new
editions of the publication. IBM may make improvements and/or changes in the
product(s) and/or the program(s) described in this publication at any time without notice.

Any references in thisinformation to non-IBM Web sites are provided for convenience
only and do not in any manner serve as an endorsement of those Web sites. The materials
at those Web sites are not part of the materials for thisIBM product and use of those Web
sitesisat your own risk.

IBM may use or distribute any of the information you supply in any way it believes
appropriate without incurring any obligation to you.

Licensees of this program who wish to have information about it for the purpose of
enabling: (i) the exchange of information between independently created programs and
other programs (including this one) and (ii) the mutual use of the information which has
been exchanged, should contact:

IBM Corporation

JBAIGA

555 Bailey Avenue

San Jose, CA__95141-1003

U.SA.

Such information may be available, subject to appropriate terms and conditions, including
in some cases, payment of afee.

The licensed program described in this document and al licensed material available for it
are provided by IBM under terms of the IBM Customer Agreement, IBM International
Program License Agreement or any equivalent agreement between us.

Any performance data contained herein was determined in a controlled environment.
Therefore, the results obtained in other operating environments may vary significantly.
Some measurements may have been made on devel opment-level systems and thereis no
guarantee that these measurements will be the same on generally available systems.
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Furthermore, some measurements may have been estimated through extrapolation. Actual
results may vary. Users of this document should verify the applicable data for their
specific environment.

Information concerning non-IBM products was obtained from the suppliers of those
products, their published announcements or other publicly available sources. IBM has not
tested those products and cannot confirm the accuracy of performance, compatibility or
any other claimsrelated to non-IBM products. Questions on the capabilities of non-IBM
products should be addressed to the suppliers of those products.

All statements regarding IBM's future direction or intent are subject to change or
withdrawal without notice, and represent goals and objectives only.

Thisinformation is for planning purposes only. The information herein is subject to
change before the products described become available. This information contains
examples of data and reports used in daily business operations. To illustrate them as
completely as possible, the examplesinclude the names of individuals, companies, brands,
and products. All of these names are ficticious and any similarity to the names and
addresses used by an actual business enterpriseis entirely coincidental.

COPYRIGHT LICENSE:

Thisinformation contains sample application programs in source language, which
illustrate programming techniques on various operating platforms. You may copy, modify,
and distribute these sample programs in any form without payment to IBM, for the
purposes of developing, using, marketing or distributing application programs conforming
to the application programming interface for the operating platform for which the sample
programs are written. These examples have not been thoroughly tested under all
conditions. IBM, therefore, cannot guarantee or imply reliability, serviceability, or
function of these programs. The sample programs are provided "ASIS", without warranty
of any kind. IBM shall not be liable for any damages arising out of your use of the sample
programs.

Each copy or any portion of these sample programs or any derivative work, must include a
copyright notice as follows:

© IBM 2011. Portions of this code are derived from IBM Corp. Sample Programs.
© Copyright IBM Corp. 2011.

If you are viewing this information softcopy, the photographs and color illustrations may
not appear.

Trademarks I1BM,thelBM logo, and ibm.com are trademarks or registered trademarks of International
Business Machines Corp., registered in many jurisdictions worldwide. Other product and
service names might be trademarks of IBM or other companies. A current list of IBM
trademarks is available on the Web at “ Copyright and trademark information” at
www.ibm.com/legal/copytrade.shtml.

Adobe, the Adobe logo, PostScript, and the PostScript logo are either registered
trademarks or trademarks of Adobe Systems Incorporated in the United States, and/or
other countries.
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IT Infrastructure Library is aregistered trademark of the Central Computer and
Telecommunications Agency which is now part of the Office of Government Commerce.

Intel, Intel logo, Intel Inside, Intel Inside logo, Intel Centrino, Intel Centrino logo,
Celeron, Intel Xeon, Intel SpeedStep, Itanium, and Pentium are trademarks or registered
trademarks of Intel Corporation or its subsidiariesin the United States and other countries.

Linux is aregistered trademark of Linus Torvaldsin the United States, other countries, or
both.

Microsoft, Windows, Windows NT, and the Windows logo are trademarks of Microsoft
Corporation in the United States, other countries, or both.

ITIL isaregistered trademark, and a registered community trademark of the Office of
Government Commerce, and isregistered in the U.S. Patent and Trademark Office.

UNIX isaregistered trademark of The Open Group in the United States and other
countries.

Java and all Java-based trademarks and logos are trademarks or registered trademarks of
Oracle and/or its affiliates.

Cell Broadband Engine is atrademark of Sony Computer Entertainment, Inc. in the
United States, other countries, or both and is used under license therefrom.

Linear Tape-Open, LTO, the LTO Logo, Ultrium and the Ultrium Logo are trademarks of
HP, IBM Corp. and Quantum in the U.S. and other countries.

Connect Control Center®, Connect:Direct®, Connect:Enterprise, Gentran®,
Gentran:Basic®, Gentran:Control®, Gentran:Director®, Gentran:Plus®,
Gentran:Rea time®, Gentran: Server®, Gentran:Viewpoint®, Sterling Commerce™,
Sterling Information Broker®, and Sterling Integrator® are trademarks or registered
trademarks of Sterling Commerce, Inc., an IBM Company.

Other company, product, and service names may be trademarks or service marks of others.
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GLOSSARY

Glossary

?In Documents  This Sterling Gentran: Server browser contains alist of documents that were received by
the system but failed compliance checking or that do not have an identifiable partner or
transaction set.

?0ut Documents  This Sterling Gentran: Server browser contains alist of documents that were imported into
the system via unattended processing but are invalid.

acknowledgement  Thisterm is used to indicate the ANSI 997 functional acknowledgement, the EDIA 999
acceptance/rejection advice, and the EDIFACT CNTRL document.

activation This function enables you to make map components available for use. The system
activates all the groups, segments, composites, and elements that are defined as
“mandatory” (must be present) by the standard. The system does not enable you to
deactivate the mandatory groups, segments, composites, and elements. When trandlating
data, the system does not process groups, segments, composites, and elements (or records
and fields) that are not activated. Therefore, you must activate the groups, segments,
composites, and elements that are not defined as mandatory by the standard, but that you
have determined that you need to use in mapping.

AIAG  The Automotive Industry Action Group (AIAG) is the standards-setting group for the
automotive industry. The standards form a subset of the ANSI X12 standard.

ANA  Article Numbering Association.

ANSI American National Standards Institute. ANSI sets standards for many products and
services, such as safety glasses and battery capacities. The ANSI X12 committeeisthe
chief EDI standards-setting organization for the United States.

application file  If you are creating an import or export map, you must define your application file to the
Application Integration subsystem. In Sterling Gentran: Server terminology, your
application fileis also referred to as a fixed-format file or a positional file. Your
application file must contain all the information that you either need to extract from your
partner’s document (if the map isinbound) or need to send to your partner (if themapis
outbound), so that your system can accurately process the data.
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application system

application system

browser

check box

codelist tables

colours

communications
session

compile

compliant

component data
element

composite data
element

conditions

Glossary

Computer systems, outside of EDI, designed to fulfill specific business functions. These
include accounting, purchasing, materials control, human resources, shipping, and other
systems.

A browser isawindow that displaysalist of items, such as documents (transaction sets),
interchanges, trandation objects, etc. A document browser displays only documents.

A check box enables you to select or clear options from alist. You can select as many
options from the list as you need. A selected check box contains a checkmark. The labels
of unavailable options are dimmed.

These are used by EDI standards as repositories for lists of codes. Each EDI standard
provides a code list for each element that can be further defined with a code.

This feature enables you to select foreground and background colorsto visually define the
various map components. The use of color is optional.

Everything sent and received to/from one tel ephone number in one continuous period of
connection. This could include sending two or three interchange envel opes to a network,
each for adifferent trading partner.

Thisfunction creates atranglation object. The form that you createis a source form. When
that source form is compiled, the result is a compiled trandation object. Thistrandation
object will need to be registered with the Sterling Gentran: Server system before you can
useit.

This means that the document conformsto the EDI standards as defined by the translation
object.

A simple data element that belongs to a composite data element. Component data
elements are also called subelements.

A composite data element contains two or more component data elements or subelements.
Composites are defined by the EDI standards that use them (EDIFACT, TRADACOMS,
and certain ANSI X 12 standards).

Seerelational conditions.
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constant

cross-reference
table

date/time

deactivation

default

document

EANA

EDI

EDI File For mat
Window

EDI standard

Forms Integration EDIFACT Tutorial Guide

constant

This standard rule enables you to move aliteral constant value to the specified element or
field, indicate a qualifying relationship with another element or field, and map the current
date or time to the specified element or field.

Thistable is created in Partner Editor and is used to convert your values to your trading
partner's values during outbound processing, or your partner's values to your values during
inbound processing.

Thistype of field or element contains a date or time. If you specify that afield or element
will be a date/time type, you must specify exactly how the date or time must be formatted.

This function enables you to make map components unavailable for use by the system.
The system does not enable you to deactivate the mandatory groups, segments,
composites, and elements.

A predefined value — programs use these built-in values unless you specifically override
them.

One transaction set containing actual data and treated as a single entity. The amount of
data does not affect whether something is a document or not, only the fact that it is treated
asasingle entity. For example, regardless of whether a purchase order contains one item
or ten thousand, if it is one purchase order, it is one document.

If atrading partner sends you a communication containing 10 purchase orders, you have
received 10 documents. If the communication contained 15 invoices, you have received
15 documents.

International Article Numbering Association, Brussels, Belgium.

Electronic Data Interchange (EDI) is the process by which companies can exchange
business documents directly from application to application by computer without paper
documents being produced.

The EDI File Format Window contains the EDI file format. When you click a segment or
group in the EDI file format, the corresponding frameis displayed in the Layout Window.
When you click an element in the EDI file format, the corresponding layout component is
highlighted in the Layout Window.

Thisisthe rules for turning a business document into an EDI document.

Sterling Gentran:Server — May 2011



EDIA Glossary

EDIA  The Electronic Data Interchange Association, formerly known as the Transportation Data
Coordinating Committee (TDCC).

EDIFACT  Thisisthe standards organization of the United Nations Economic and Social Council.
The acronym is short for the Electronic Data Interchange for Administration, Commerce,
and Transport.

element The smallest piece of usable information defined by the standards. Examplesinclude a
guantity, unit price, or description. An individual element can have somewhat different
meanings depending on context. Therefore, elements are normally not considered to have
useful meaning until they are combined into segments. An element isthe EDI map
component that is mapped (linked) to a corresponding application field to move data to
and from the EDI file.

There are three types of data elements, asillustrated in the table below:

Data Element Definition
Simple data element A single piece of information defined by the
standards.
Composite data element A data element that is made up of multiple

component elements.

Component data element A simple data element that belongs to a composite
data element. Component data elements are also
called subelements.

envelope A way of separating information in transmissions for ease of processing. Each envelope
contains a header segment and a trailer segment, which separate the envel ope from other
envel opes and provide information about the contents of the envelope. There are three
levels of envelopes, asfollows:

Transaction Set
Each transaction set (business document) is contained within a transaction set envelope.

Functional Group
An envelope containing related business documents. The standards define which
transaction sets should be placed together into a functional group envelope.

Interchange Envelope

All material being sent to onetrading partner in one communication. The term Interchange
Envelopeisthe term used by ANSI. EDIA uses the term Transmission Envelope to refer
to thislevel of envelope. Since we use the term transmission for other uses, we will refer
to Interchange Envelope only.

Note

A communications session could easily include a number of interchange envel opes. For
this reason, the standards-setting bodies are considering afourth level of envelopeto cover
an entire communications session.
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equalize

export map

export trandation
object

extended rules

field

fixed-format file

form

frame

functional group

group

import
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equalize

This function enables you to reinstate the two sides of the map with focusin equal
dimensions. The use of the Equalize function is optional.

This map defines how to move data from the EDI standard-formatted documents that your
partners send you to your application file (flat file definition). An export map is necessary
for inbound processing.

See export map.

These rules enable you to use a Sterling Gentran: Server proprietary programming
language to perform virtually any mapping operation you require.

The smallest piece of information defined in the application file. A field is the application
map component that is mapped (linked) to a corresponding EDI element to move data to
and from your application file.

See application file.

A formisaset of instructions you define in the Forms Integration subsystem that indicates
how the system should format data

A frame contains the groups, repeating segments, and elements at that level (single
segments are not represented on the frame). Sterling Gentran: Server uses framesto format
the EDI file for the translation object.

A group of transaction sets that the standards-setting body (such as ANSI) has defined as
fitting together with other related transaction sets. An example might be a Functional
Group defined as containing all purchasing transaction sets.

A looping structure that contains related records/segments and/or groups that repeat in
sequence until either the group data ends or the maximum number of timesthat theloopis
allowed to repeat is exhausted. If you create agroup that is subordinate to another group (a
subgroup), this corresponds to a nested looping structure (aloop within aloop). The
application (positional) file and the EDI file are both groups and therefore, they isvisually
represented the same way as other groups and subgroups in Sterling Gentran: Server.

This command enables you to import datafrom an external application file. Depending on
the content of the file, the system may prompt you for partner, transaction, or translation
object information.
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import map

import map

import trandation
object

inbound mapping

In Documents

In Drawer

interchange

Layout Window

literal constant

location table

lookup table

Glossary

This map defines how to move data from your application file (flat file definition), which
may contain multiple documents, to the EDI standard-formatted documents that your
partners expect to receive from you. An import map is necessary for outbound processing.

See import map.

The system translates your trading partner’s EDI standard formatted business document to
your application file format, so you can receive documents from you partners. To trandate
inbound data, you need to create an export map.

This Sterling Gentran: Server browser contains alist of documentsthat the system received
but that have not yet been processed by the user. Once the documents are processed
(printed or exported) the documents will be transferred to the In Drawer.

This Sterling Gentran: Server browser contains alist of documents that were received and
processed.

Theinterchange contains al the functional groups of documents (transaction sets) sent
from one sender to one receiver in the same transmission.

The Layout Window contains the actual format of the translation object. Each group (with
amaximum usage greater than one) and repeating segment has a corresponding frame in
the Layout Window. When you click a segment or group in the EDI file format, the
corresponding frame is displayed in the Layout Window. When you click an element in
the EDI file format, the corresponding layout component is highlighted in the Layout
Window.

These are used by the system as a repository to store information that will be used at a
later point in the map. Typically, constants are used in an outbound map to generate a
qualifier.

Thisisatable created in Partner Editor that is used to contain address-rel ated information
about the partner.

Thisisatable created in Partner Editor that is used to select information related to avalue
in inbound or outbound data.
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loop count

loop start/loop end

map

networ k

number

ODETTE

outbound mapping

Out Documents

Out Drawer

partner

loop count

This standard rule enables you to count the number of times aloop isrepeated, if the
element or field ispart of aloop. If theloop isanested |oop, you can track the current loop
or the outer loop. For example, if the Y loop is nested within the X loop, and the Y loop
has cycled through 15 iterations and the X loop has cycled through 3 iterations, you can
choose to count either the “15” (Y loop) or the“3” (X loop).

Certain EDI standards use Loop Start (LS) and Loop End (LE) segments. LS and LE
segments differentiate between two or more loops of the same type. If the transaction
contains LS and L E segments and depending on whether your map is inbound or
outbound, you will need to define the LS and LE segments for the loops you will be using
in the map in one of two different ways.

A set of instructions you define in the Application I ntegration subsystem that indicates the
corresponding relationship between your application file and the EDI standards, and
defines how the system should translate data.

Also known as athird party network or value-added network (VAN) that accepts and holds
transmissions from companies until it is convenient for atrading partner to accept them.

Thistype of field or element contains either an integer or real number. If you specify that a
field or element will be a number type, you must designate the format by specifying a
format of either “N” (integer) or “R” (real) and the number of decimal places.

The Organization for Data Exchange by Tele-Transmission in Europe.

The system trandlates your application file format to EDI standard formats, so you can
send documents to your partners. To translate outbound data, you need to create an import
map and a system import map in the Application Integration subsystem.

This Sterling Gentran: Server browser contains alist of documents that are ready to be
sent. After the documents are successfully sent, they are automatically transferred to the
Out Drawer.

This Sterling Gentran: Server browser contains alist of documents that were successfully
sent out by the system.

Another firm with which your company trades documents. Also referred to as atrading
partner.
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Partner Editor

Partner Editor

positional file

post

predefined

printout

print trandation

object

promote

qualifier

radio buttons

receive

record

Glossary

This Sterling Gentran: Server function enables you to define, edit, and delete all partner
information for your company and all of your trading partners.

See application file.

This Sterling Gentran: Server function enables you to move compliant documents from the
Workspace to the Out Documents.

On adataentry trandlation object, adefault value for aparticular element. You can change
the value as necessary.

Thisis produced when data received from atrading partner passes through a print
tranglation object. You do not have to actually print the data. The printout could beto afile
on your hard disk.

A print tranglation object organizes and formats the printout of EDI documentsthat are
received from or sent to the trading partner(s) for which you have established a trading
relationship (inbound or outbound) that utilizes that print translation object. The print
trangl ation object enables you to view the EDI document in an easily readable format.

This function extracts one iteration (instance) of a group or repeating segment. This
enables you to map unique data from your application file, and/or enter a specialized
definition. Sterling Gentran: Server specifies that only one-to-one (no loops) or many-to-
many (loop) mapping relationships are valid.

Thisisan element that has a value expressed as a code that gives a specific meaning to the
function of another element. A qualifying relationship is the interaction between an
element and its qualifier. The function of the element changes depending on which code
the qualifier contains.

Radio buttons indicate a group of mutually exclusive options. You can only select one
option at atime. Select an option by clicking the radio button or pressing the SPACE BAR

until the option you want is selected. The selected option contains a black dot. The labels
of unavailable choices are dimmed.

This Sterling Gentran: Server function enables you to manually initiate a communications
session to receive data from a network through an invocation of the Connection Manager.

Contains agroup of related fields. A record can occur once or can repeat multiple times.
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relational
condition

respond

responsible agency

screen entry
translation object

segment

select

set

simple mapping

relational condition

This function enables to connect fields together for syntax or compliance reasons. For
example, Field A isinvalid unless Field B is present. Therefore, if you set up a condition
that pairs Fields A and B, the system will generate acompliance error if one of those fields
is not present.

This Sterling Gentran: Server function enables you to create a turnaround document (using
the Turn Around translation object in the partner relationship) in response to one or more
selected document(s) in the In Drawer.

An organization that develops and updates standards for EDI communications. These
organizationsinclude ANSI, EDIA, AIAG, UCS, EDIFACT, ODETTE, and VICS.

A screen entry trandation object provides a standardized format for keying an EDI
document into the Document Editor, for translation and transmission to your trading
partner(s), for which you have established an outbound trading relationship that utilizes
that screen entry trandlation object. The screen entry translation object ensures that your
users key all the data necessary to create the required EDI document.

A group of related elements or composite data elements that combine to communicate
useful data. Segments are defined by the EDI standards. A segment can occur once or can
repeat multiple times. For example, a catalog price segment might consist of elements for
item description, volume, price, lead time, etc. By themselves, none of these elements
would communicate useful information. Together, they provide the information necessary
for someoneto tell if theitem iswhat is desired, whether the priceis reasonable, etc. A
number of segments together form a transaction set.

This standard rule enables you to select entries from alocation table, cross-referencetable,
partner table, or lookup table (all tables created in the Sterling Gentran:Server Partner
Editor). You can then map the fields in those tables to one or more fields in the data. The
Select function uses the vaue of the current field to perform the selection.

This Sterling Gentran: Server function enables you to manually start a communications
session to send data to a network through an invocation of Connection Manager. Only
selected documents are enveloped and sent. If no documents are selected, ALL documents
will be sent. Successfully sent documents are moved to the Out Drawer.

See Transaction Set.

Seelink.
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split

split

standard rules

static text

status bar

string

syntax token

system import map

system import
tranglation object

system trandation
object

TDCC

Glossary

This function enables you to split (break) a group or repeating segment into two loops.
You will typically use this function when you need more than one instance of the same
map component that still occurs multiple times.

Theserules give you access to functions that are necessary for mapping operationsthat are
more complex than simple linking, but less involved than extended rules. Each of the
standard rules are mutually exclusive (you can use only one on a particular field).

Static text istext that is always included in the screen entry or print translation object.
Examples of static text include legends and column headings. Field labels, which usually
accompany fields to identify the contents of the fields, are not considered static text.

The status bar of an application window defines information about a selection, command,
or process, defines Menu Bar items as the user highlights each item, and indicates any
current keyboard-initiated modes for typing (e.g., CAP for the “Caps Lock” key).

Thistype of field or element contains one or more printable characters. If you specify that
afield or element will be a string type, you must designate the format by specifying a
syntax token.

This function enables you to designate a “token” that defines ranges of characters and/or
numbers that are allowed to be used for a string-type element or field. You can then use
the syntax tokensin the Format field of the Field Properties dialog. This enables you to
define what type of characters should be used while compliance checking each element/
field (e.g., dphanumeric within a certain range).

The translator uses this map to determine which trading relationship (established in
Partner Editor) corresponds to each document in the application file, so the system will
know which import map to use to process the document. You need a system import map
that is defined in EDIMGR.INI to trandlate outbound data.

See system import map.

These trangl ation objects control the creation and separation of interchanges, functional
groups, and transaction sets. They also used to generate and reconcile functional
acknowledgements. All the required system translation objects are automatically installed
with the Sterling Gentran:Server system.

See EDIA.
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TDF

third-party
networ k

title bar

toolbar

TRADACOMS

trading partner

transaction set
(document)

tranglation object

TDF

TDF isthe Transaction Data File. Thisfile serves as afilter between your document files
and the Sterling Gentran: Server trand ator. For outbound processing, dataisimported from
aTDF file and trandated to EDI format using a TDF Import translation object. The datais
then ready to be posted and sent to your trading partner. For inbound processing, EDI
documents that are received by Sterling Gentran: Server can be exported to a TDF-
formatted file using a TDF Export translation object. This datafile is then ready to be
processed or converted to your internal application files.

See Network.

The title bar of an application window contains the name of the application and enables
you to move the window to another position on your desktop.

This contains buttons that graphically represent commands available in the Menu Bar.

The U.K. standards for EDI that are published by the Article Numbering Association
(UK) LTD.

Another firm with which you company trades documents. Also referred to as a partner.

A business form as defined by the standards. Examples include an ANSI 850 purchase
order or an UCS 880 invoice. The standards define each transaction set in terms of the
segments and elements that make up the form, the order in which they appear, and the
relationships among them. Thisis aso known as “message” in Europe.

A predesigned layout set up to ensure that input or output for a particular transaction set
existsand is presented in a usable fashion. You must specify which translation object(s)
will be used by each partner relationship.

Inbound Translation Objects:

Turn Around: Thistranslation object is used when a document is received, to create the
natural response document that contains as many elements from the received document as
possible.

Export File: Thistrandation object indicates that when a document is received, it will be
exported to a specified file format.

Print: Thistrandation object is used to print documents.

Outbound Translation Objects:
Import: Thistranglation object is used to import data from an application file.

Print: Thistrandation object is used to print documents.
Data Entry: Thistranslation object is used to enter datainto the Document Editor facility.
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trandator

trandsator

transmission

transmission chain

turnaround
document

turnaround map

UcCs

update

use accum

use code

user trandation
object

Glossary

Thisisthe engine that processes data for the Sterling Gentran: Server, Application
Integration subsystem and Forms I ntegration subsystem.

See Communications Session.

A path an EDI communication could follow, including one company, one trading partner,
and one or more network services.

A document into which data elements from the source document have been automatically
transferred using a turnaround map.

A series of instructions that the system uses to create a turnaround document (alogical
response document to the source) from an inbound (source) document, by transferring
data from the source document to elements in the target document (translation object).

The Uniform Communications Standard is the standard used by the grocery industry.

This standard rule enables you to update a specific field in a document record, envelope
segment, interchange, group, current partner, or document (if the map side format typeis
EDI), with the contents of the element or field.

This standard rule gives you access to a set of numeric variables that you can manipulate
via numeric operations, and then transfer to and from fields. This function enables you to
add, change, or delete calculations for the element/field, including hash totals (used to
accumulate numeric field values, i.e., quantity, price, etc.). Thisfunction aso enables you
to map the accumulated total into a control total field, and use accumulators.
Accumulators are used generally for counting the occurrences of a specific element or
generating increasing or sequential record or line item numbers.

This standard rule enables you to match an element or field against a predefined code
table, specify whether or not a compliance error will be generated if the element or field
does not contain one of the valuesin the code table, and store a code’s description in
another element or field.

These trandlation objects control data entry, importing, exporting, document turnaround,
and creating printed reports. These translation objects are created using the Application
Integration or Forms Integration subsystems. The Application Integration subsystem
enables you to generate import, export, and document turnaround translation objects. The
Forms Integration subsystem enables you to generate data entry and print translation
objects.
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version

VICS

Workspace

X12

version

Each standards-setting body updatesits standards on aregular basis. Each formal updateis
referred to asaversion.

The Voluntary Inter-industry Communication Standards is the standards-setting body for
the retail industry, a subset of ANSI X12.

This Sterling Gentran: Server browser contains alist of outbound “Work in Progress”
documents. It also contains recently imported or data entry documents.

The ANSI committee that sets and publishes standards for EDI.
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